## Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Revision</th>
</tr>
</thead>
</table>
| 05/26/2015 | 2015.1  | Updates to document for Vivado® Design Suite, 2015.1 release. Changes include:  
• Added Report Clock Domain Crossings, page 64  
• Added Report Design Analysis, page 110  
• Added Chapter 7, Design Analysis Techniques |
# Table of Contents

## Chapter 1: Logic Analysis Within the IDE
- Design Analysis Within the IDE .................................................. 5
- Logic Analysis Features .............................................................. 5
- Using the Netlist Window ............................................................. 6
- Using the Hierarchy Window ......................................................... 8
- Using the Schematic Window ....................................................... 9
- Searching for Objects Using Find ................................................. 13
- Analyzing Device Utilization Statistics ....................................... 16
- Using Report DRC ....................................................................... 17
- Validating Design Methodology Logic DRCs ................................ 17

## Chapter 2: Timing Analysis Features
- Report Timing Summary .............................................................. 20
- Report Clock Networks ............................................................... 37
- Report Clock Interaction .............................................................. 38
- Report Pulse Width .................................................................... 46
- Report Timing ............................................................................ 47
- Report Datasheet ......................................................................... 53
- Report Exceptions ....................................................................... 58
- Report Clock Domain Crossings .................................................. 64

## Chapter 3: Implementation Results Analysis Features
- Using the Design Runs Window .................................................... 82
- Placement Analysis ..................................................................... 84
- Routing Analysis ........................................................................ 90

## Chapter 4: Viewing Reports and Messages
- Introduction to Reports and Messages ......................................... 94
- Viewing and Managing Messages in the IDE ............................... 95
- Vivado Generated Reports and Messages .................................... 98
- Creating Design Related Reports ............................................... 99
- Report Design Analysis ............................................................... 110
Chapter 5: Performing Timing Analysis

Introduction to Timing Analysis .......................................................... 129
Understanding the Basics of Timing Analysis ........................................... 133
Verifying Timing Signoff .................................................................. 141
Reading a Timing Path Report ............................................................. 145

Chapter 6: Design Closure Techniques

Introduction to Design Closure Techniques ........................................... 154
Checking Constraints and Sources ......................................................... 154
Increasing Tool Effort .................................................................. 157
Floorplanning ................................................................................. 158
Modifying Routing ...................................................................... 172

Chapter 7: Design Analysis Techniques

Using the report_design_analysis Command .......................................... 173
Using the Elaborated View to Optimize the RTL ...................................... 177
Identifying the Longest Logic Delay Paths in the Design .......................... 180
Identifying High Fanout Net Drivers ...................................................... 181
Determining if Hold-Fixing is Negatively Impacting the Design ............. 183
Quickly Analyzing All Failing Paths ....................................................... 185

Appendix A: Additional Resources and Legal Notices

Xilinx Resources ........................................................................ 186
Solution Centers ........................................................................ 186
References .................................................................................. 186
Training Resources ........................................................................ 187
Please Read: Important Legal Notices ............................................... 187
Chapter 1

Logic Analysis Within the IDE

Design Analysis Within the IDE

The following chapters provide an introduction to design analysis in the Xilinx® Vivado® Design Suite Integrated Design Environment (IDE):

- Logic Analysis Within the IDE (this chapter)
- Chapter 2, Timing Analysis Features
- Chapter 3, Implementation Results Analysis Features

Logic Analysis Features

This chapter discusses Logic Analysis Features, and includes:

- Using the Netlist Window
- Using the Hierarchy Window
- Using the Schematic Window
- Searching for Objects Using Find
- Analyzing Device Utilization Statistics
- Using Report DRC
- Validating Design Methodology Logic DRCs
Using the Netlist Window

The Netlist Window shows the design hierarchy as it is in the netlist, processed by the synthesis tools.

Depending on synthesis settings, the netlist hierarchy may be a one hundred percent match for the original RTL, or there may be no hierarchy. Generally, the synthesis tools default to preserving most of the user hierarchy while optimizing the logic. This results in a smaller, faster netlist.

With the synthesis tool defaults, the netlist hierarchy is recognizable, but the interfaces to the hierarchies may be modified. Some pins and levels of hierarchy may be missing.
Chapter 1: Logic Analysis Within the IDE

Each level of hierarchy shows its hierarchy tree. At each level, the tool shows:

- A nets folder for any nets at that level
- A Leaf Cells folder if there are hardware primitive instances at that level
- Any hierarchies instantiated at that level

Traversing the tree shows the whole branch. The icons next to the cells display information about the state of the design.

For more information, see this link in the Vivado Design Suite User Guide: Using the Vivado IDE (UG893) [Ref 1].

The Properties Window for each level of hierarchy shows utilization statistics including:

- Primitive usage for the whole hierarchical branch, grouped in higher level buckets
- The number of nets crossing the hierarchy boundary
- Clocks used in the hierarchy

If you floorplan the design, similar properties are displayed for the Pblock.

---

**Figure 1-2: Instance Properties Window**

---
Using the Hierarchy Window

Explore the hierarchy to understand resource usage. To open the Hierarchy Window, select **Tools > Show Hierarchy**, or from the Netlist window, click **F6**.

The Hierarchy Window displays the hierarchy tree for the netlist. Each horizontal row displays a level of hierarchy inside the netlist. As you move down the rows, you move into deeper netlist hierarchy. Across the row, each level of hierarchy is sized relative to the other hierarchy at that level.

*Figure 1-3, Hierarchy Window*, shows that `cpuEngine`, `usbEngine0`, and `usbEngine1` have most of the logic in the design, and all use about the same number of resources.

The Utilization Report breaks apart the design based on resource type. It displays each resource type independently with consumption per level of hierarchy.

To view the Utilization Report, select **Tools > Report > Report Utilization**. *Figure 1-4, page 9* shows the Utilization Report.
In this design, the two `usbEngine` blocks are the two biggest consumers of the RAMB36 and FIFO36 blocks. Click the + (plus) icon to view the consumption at sub-hierarchies.

**Using the Schematic Window**

The schematic is a graphical representation of the netlist. View the schematic to:

- View a graphical representation for the netlist.
- Review the gates, hierarchies, and connectivity.
- Trace and expand cones of logic.
- Analyze the design.
- Better understand what is happening inside the design.

At the RTL level in Elaborated Design, you see how the tool has interpreted your code. In Synthesize Design and Implemented Design, you see the gates generated by the synthesis tool.
To open the schematic, select **Tools > Schematic**. If nothing is selected, the gates, hierarchy, and connectivity appear at the top level of the design, as shown in Figure 1-5.

![Figure 1-5: Top Level Schematic](image)

*Figure 1-5: Top Level Schematic*

For information about zooming and moving around the schematic, see [this link](#) in the *Vivado Design Suite User Guide: Using the Vivado IDE* (UG893) [Ref 1].

**TIP:** The schematic is simpler if you use a single level of hierarchy only. The schematic populates with the selected element emphasized (blue). The ports for the single hierarchy display.
Chapter 1: Logic Analysis Within the IDE

You can trace the schematic in multiple ways:

- Click the + (plus) icon in the upper left to display the gates in the hierarchy.
- Double-click a port or element to expand it.
- Use the schematic popup.

For more information about schematics, see this link in the Vivado Design Suite User Guide: Using the Vivado IDE (UG893) [Ref 1].

- Click the <-> arrows to switch between the previous and next schematic views.
- Select Expand All to display more logic and connectivity.
- Select Collapse All to simplify the schematic.
After implementation, the schematic is the easiest way to visualize the gates in a timing path. Select the path, then open the schematic with the gates and nets from that path.

**Figure 1-7:** Schematic With Timing Path

To identify the relevant levels of hierarchy in the schematic, choose Select Leaf Cell Parents from the popup menu.

**Figure 1-8:** Timing Path with Select Primitive Parents
As you review the schematic, select the **Highlight** and **Mark** commands to track gates of interest. Color coding primitives (using either a mark or a highlight) makes it easier to track which logic was in the original path, and which logic was added.

![Schematic With Timing Path Marked](image)

**Figure 1-9:** Schematic With Timing Path Marked

---

**Searching for Objects Using Find**

The Vivado IDE includes powerful find and search capabilities. To open the Find dialog box, select **Edit > Find**.

**Note:** You can also open the Find window by pressing **Ctrl+F**.

![Find Dialog Box](image)

**Figure 1-10:** Find Dialog Box
Find Criteria

Select Edit > Find to search the netlist for:

- Instances
- Nets
- I/O Ports
- Instance Pins
- Pblocks
- RPMs

Find Sub Criteria

There are multiple sub criteria for each of the Find criteria. For example, instance has the following sub criteria:

- Type
- Cell types
- Black boxes
- Primitives, including
  - I/O Buffer
  - Block Arithmetic
  - Block Memory
  - LUT
- Name
- Status
- Parent Pblock
- Module
- Primitive count
- Attribute

Review the other Find criteria for their sub fields.
Device-Specific Find Criteria

Device-specific Find criteria are:

- Arcs
- Nodes
- BEL Pins
- BELs
- Site Pins
- Sites
- Tiles
- I/O Banks
- Clock Regions

Find Examples

Select Edit > Find to find, for example:

- All unplaced I/Os
- Only the tool-placed Global Clocks
- All nets with a fanout over 10,000
- All DSPs using the PREG embedded register

Complex Finds

To run a complex find:

1. Set the first search criterion.
2. Click +(plus).
3. Add additional criteria.
4. Join the additional criteria with logical operators (and, or).
Chapter 1: Logic Analysis Within the IDE

Tcl Finds

From the script or Tcl console, use the equivalent Tcl `get_*` command (such as `get_cells`) to query Vivado objects.

**TIP:** The Tcl Console at the bottom of the Vivado IDE shows the Vivado Design Suite Tcl commands run for each action executed in the GUI. From the Tcl Console, you can also enter Vivado Design Suite Tcl commands.

For more information on Tcl scripting, see the Vivado Design Suite User Guide: Using Tcl Scripting (UG894) [Ref 2].

For more information on Tcl commands, see the Vivado Design Suite Tcl Command Reference Guide (UG835) [Ref 3], or type `<command> -help`.

Analyzing Device Utilization Statistics

A common cause of implementation issues comes from not considering the logic and device layout implied by the pinout. Slice logic is uniform in most devices. However, specialized resources such as the following impact logic placement:

- I/O
- High Performance Banks
- High Range Banks
- MGT
- DSP48
- Block RAM
- MMCM
- BUFG
- BUFR

Blocks that are large consumers of a certain specialized resource may have to spread around the device. Take this into account when designing the interface with the rest of the design. Use a combination of the following to find block resources:

- `report_utilization`
- `netlist properties`
- `Pblock properties`
Chapter 1: Logic Analysis Within the IDE

Using Report DRC

Design Rule Checks (DRCs) check the design and report on common issues. Run DRCs using the `report_drc` command. During implementation, the tools also run DRCs. The DRCs become more complete and comprehensive with placement and routing.

**RECOMMENDED:** Review the DRC messages, Critical Warnings, and Warnings early in the flow to prevent issues later.

At Synthesized Design, the optional Report DRC step reports a Critical Warning for the unconstrained I/Os. The routed design DRC report reports the Critical Warnings. You must review the report. At `write_bitstream`, the DRC has been elevated to an Error. Review the DRC reports early to identify areas of the design that need modification.

Validating Design Methodology Logic DRCs

Due to the importance of methodology, the Vivado tools provide a set of Design Rule Checks (DRCs) that specifically check for compliance with methodology. There are different types of DRCs depending on the stage of the design process. RTL lint-style checks are run on the elaborated RTL design; netlist-based logic and constraint checks are run on the synthesized design; and implementation and timing checks are run on the implemented design.

To run these checks at the Tcl prompt, open the design to be validated and enter following Tcl command:

```
report_drc -ruledeck methodology_checks
```
To run these checks from the IDE, open the design to be validated and run the Report DRC command. Once the dialog box appears, select the methodology checks Rule deck, as shown in Figure 1-12.

![Report DRC Dialog Box](image)

**Figure 1-12:** Report DRC Dialog Box
Violations (if there are any) are listed in the DRC window, as shown in Figure 1-13.

![DRC Window]

**Figure 1-13: DRC Violations**

For more information on running design methodology DRCs, refer to this link in the Vivado Design Suite User Guide: System-Level Design Entry (UG895) [Ref 4] and this link in the Design Methodology Handbook for Xilinx FPGAs (UG949) [Ref 5].
Chapter 2

Timing Analysis Features

This chapter discusses Timing Analysis Features and includes:

- Report Timing Summary
- Report Clock Networks
- Report Clock Interaction
- Report Exceptions

Report Timing Summary

Timing analysis is available anywhere in the flow after synthesis. You can review the Timing Summary report files automatically created by the Synthesis and Implementation runs.

If your synthesized or implemented design is loaded in memory, you can also generate an interactive Timing Summary report from:

- Flow Navigator > Synthesis
- Flow Navigator > Implementation
- Tools > Timing > Report Timing Summary

Equivalent Tcl command: `report_timing_summary`

For more information on the `report_timing_summary` options, see this link in the Vivado Design Suite Tcl Command Reference Guide (UG835) [Ref 3].

In a synthesized design, the Vivado IDE timing engine estimates the net delays based on connectivity and fanout. The accuracy of the delays is greater for nets between cells that are already placed by the user.

In an Implemented Design, the net delays are based on the actual routing information. You must use the Timing Summary report for timing signoff if the design is completely routed. To verify that the design is completely routed, view the Route Status report.
Report Timing Summary Dialog Box

In the Vivado IDE, the Report Timing Summary dialog box includes the following tabs:

- Options Tab
- Advanced Tab
- Timer Settings Tab

The Results name field at the top of the Report Timing Summary dialog box specifies the name of the graphical report that opens in the Results window. The graphical version of the report includes hyperlinks that allow you to cross-reference nets and cells from the report to Device and Schematic windows, and design source files.

If this field is left empty, the report is returned to the Tcl Console, and a graphical version of the report is not opened in the Results window.

Equivalent Tcl option: –name

Options Tab

![Report Timing Summary Dialog Box: Options Tab](image)

**Figure 2-1:** Report Timing Summary Dialog Box: Options Tab
The Options tab of the Report Timing Summary dialog box includes:

- **Options Tab - Report Section**
- **Options Tab - Path Limits Section**
- **Options Tab - Path Display**
- **Options Tab - Common Section**

**Options Tab - Report Section**

The Report section of the Options tab of the Report Timing Summary dialog box includes:

- **Path delay type**: Sets the type of analysis to be run. For synthesized designs, only max delay analysis (setup/recovery) is performed by default. For implemented design, both min and max delay analysis (setup/hold, recover/removal) are performed by default. To run min delay analysis only (hold and removal), select delay type `min`.

  Equivalent Tcl option: `-delay_type`

- **Report unconstrained paths**: Generates information on paths that do not have timing requirements. This option is checked by default in the Vivado IDE, but is not turned on by default in the equivalent Tcl command `report_timing_summary`.

  Equivalent Tcl option: `-report_unconstrained`

- **Report datasheet**: Generates the design datasheet as defined in *Report Datasheet, page 53*, in this chapter.

  Equivalent Tcl option: `-datasheet`

**Options Tab - Path Limits Section**

The Path Limits section of the Options tab of the Report Timing Summary dialog box includes:

- **Maximum number of paths per clock or path group**: Controls the maximum number of paths reported per clock pair or path group.

  Equivalent Tcl option: `-max_paths`

- **Maximum number of worst paths per endpoint**: Controls the maximum number of paths potentially reported per path endpoint. This limit is bounded by the maximum number of paths per clock pair or path group.

  Equivalent Tcl option: `-nworst`
Options Tab - Path Display

The Path Display section of the Options tab of the Report Timing Summary dialog box includes:

- **Display paths with slack less than**: Filters the reported paths based on their slack value. This option does not affect the content of the summary tables.
  
  Equivalent Tcl option: `-slack_less_than`

- **Number of significant digits**: Controls the accuracy of the numbers displayed in the report.

  Equivalent Tcl option: `-significant_digits`

Options Tab - Common Section

The following controls common to all three tabs are located at the bottom of the Report Timing Summary dialog box:

- **Command**: Displays the Tcl command line equivalent of the various options specified in the Report Timing Summary dialog box.

- **Open in a New Tab**: Opens the results in a new tab, or to replace the last tab opened by the Results window.

- **Open in Timing Analysis Layout**: Resets the current view layout to the Timing Analysis view layout.

For more information on view layouts, see this link in the *Vivado Design Suite User Guide: Using the Vivado IDE* (UG893) [Ref 1].
Chapter 2: Timing Analysis Features

Advanced Tab

The Advanced tab contains the following sections:

Pins

• **Show input pins in path**: Displays which input pin of the cell is used for the path.

  Equivalent Tcl option: `-input_pins`

  **RECOMMENDED**: Keep this option selected to provide more information about all pins used in the path.

File Output

• **Write results to file**: Writes the result to the specified file name. By default the report is written to the Timing window in the Vivado IDE.

  Equivalent Tcl option: `-file`

• **Overwrite / Append**: When the report is written to a file, determines whether (1) the specified file is overwritten, or (2) new information is appended to an existing report.

  Equivalent Tcl option: `-append`
Miscellaneous

- **Ignore command errors**: Executes the command quietly, ignoring any command line errors and returning no messages. The command also returns TCL_OK regardless of any errors encountered during execution.

  Equivalent Tcl option: `-quiet`

- **Suspend message limits**: Temporarily overrides any message limits and return all messages.

  Equivalent Tcl option: `-verbose`

**Timer Settings Tab**

To set the timer settings, use either: (1) one of the Vivado IDE timing analysis dialog boxes; or, (2) one of the Tcl commands listed in this section. These settings affect other timing-related commands run in the same Vivado IDE session, except the synthesis and implementation commands.

The timer settings are not saved as a tool preference. The default values are restored for each new session. Do not change the default values. Keeping the default values provides maximum timing analysis coverage with the most accurate delay values.

![Report Timing Summary Dialog Box: Timer Settings Tab](image)
Chapter 2: Timing Analysis Features

- **Interconnect**

  Controls whether net delays are calculated based on the estimated route distance between leaf cell pins, by the actual routed net, or excludes net delay from timing analysis.

  This option is automatically set to **Estimated** for post-synthesis designs, and to **Actual** for post-implementation designs.

  - **Estimated:** For unplaced cells, the net delay value corresponds to the delay of the best possible placement, based on the nature of the driver and loads as well as the fanout. A net between unplaced leaf cell pins is labeled unplaced in the timing path report.

    For placed cells, the net delay depends on the distance between the driver and the load as well as the fanout. This net is labeled **estimated** in the timing path report.

  - **Actual:** For routed nets, the net delay corresponds to the actual hardware delay of the routed interconnect. This net is labeled **routed** in the timing path report.

  - **None:** Interconnect delays are not considered in the timing report and net delays are forced to zero.

  Equivalent Tcl command: `set_delay_model`

- **Speed Grade**

  Sets the device speed grade. By default, this option is set based on the part selected when creating a project or opening a design checkpoint.

  You can change this option to report timing on the same design database against another speed grade without rerunning the complete implementation flow.

  Equivalent Tcl command: `set_speed_grade`

- **Multi-Corner Configuration**

  Specifies the type of path delays to be analyzed for the specified timing corner. Valid values are **none**, **max**, **min**, and **min_max**. Select **none** to disable timing analysis for the specified corner.

  **RECOMMENDED:** Keep both setup (max) and hold (min) analysis selected for both corners.

  Equivalent Tcl command: `config_timing_corners`

- **Disable flight delays**

  Do not add package delays to I/O delay calculations.

  Equivalent Tcl command: `config_timing_analysis`
Details of the Timing Summary Report

The Timing Summary Report contains the following sections:

• General Information Section
• Timer Settings Section
• Design Timing Summary Section
• Clock Summary Section
• Check Timing Section
• Intra-Clock Paths Section
• Inter-Clock Paths Section
• Path Groups Section
• User-Ignored Paths Section
• Unconstrained Paths Section
• Reviewing Timing Path Details
• Filtering Paths With Violations

The comprehensive information contained in the Timing Summary Report is similar to the information provided by several reports available from the Vivado IDE (Report Clock Interaction, Report Pulse Width, Report Timing, Check Timing) and to some of the reports available in Tcl only (report_clocks).

However, the Report Timing Summary also includes information that is unique to this report, such as Unconstrained Paths.

General Information Section

The General Information section of the Timing Summary Report provides information about the following:

• Design name
• Selected device, package, and speed grade (with the speed file version)
• Vivado Design Suite release
• Current date
• Equivalent Tcl commands executed to generate the report
Timer Settings Section

The Timer Settings section of the Timing Summary Report contains details on the Vivado IDE timing analysis engine settings used to generate the timing information in the report. Figure 2-3, page 25 shows an example of the Timer Settings section, which includes:

- **Enable Multi-Corner Analysis**: This analysis is enabled for each corner (Multi-Corner Configuration).
- **Enable Pessimism Removal (and Pessimism Removal Resolution)**: Ensures that the source and destination clocks of each path are reported with no skew at their common node.
  
  **Note**: This setting must always be enabled.
- **Enable Input Delay Default Clock**: Creates a default null input delay constraint on input ports with no user constraint. It is disabled by default.
- **Enable Preset / Clear Arcs**: Enables timing path propagation through asynchronous pins. It does not affect recovery/removal checks and is disabled by default.
- **Disable Flight Delays**: Disables package delays for I/O delay calculations.

![Figure 2-4: Timing Summary Report: Timer Settings](image)

Design Timing Summary Section

The Design Timing Summary section of the Timing Summary Report provides a summary of the timing for the design, and combines the results of all other sections in one view.

**RECOMMENDED**: Review the Design Timing Summary section to verify that all timing constraints are met after route, or to understand the status of the design at any point in the flow.

![Figure 2-5: Design Timing Summary](image)
Chapter 2: Timing Analysis Features

The Design Timing Summary section includes the following areas:

- **Setup Area (Max Delay Analysis)**
- **Hold Area (Min Delay Analysis)**
- **Pulse Width Area (Pin Switching Limits)**

**Setup Area (Max Delay Analysis)**

The Setup area of the Design Timing Summary section displays all checks related to max delay analysis: setup, recovery, and data check.

- **Worst Negative Slack (WNS):** This value corresponds to the worst slack of all the timing paths for max delay analysis. It can be positive or negative.
- **Total Negative Slack (TNS):** The sum of all WNS violations, when considering only the worst violation of each timing path endpoint. Its value is:
  - 0\(\text{ns}\) when all timing constraints are met for max delay analysis.
  - Negative when there are some violations.
- **Number of Failing Endpoints:** The total number of endpoints with a violation (WNS<0\(\text{ns}\)).
- **Total Number of Endpoints:** The total number of endpoints analyzed.

**Hold Area (Min Delay Analysis)**

The Hold area of the Design Timing Summary section displays all checks related to min delay analysis: hold, removal, and data check.

- **Worst Hold Slack (WHS):** Corresponds to the worst slack of all the timing paths for min delay analysis. It can be positive or negative.
- **Total Hold Slack (THS):** The sum of all WHS violations, when considering only the worst violation of each timing path endpoint. Its value is:
  - 0\(\text{ns}\) when all timing constraints are met for min delay analysis.
  - Negative when there are some violations.
- **Number of Failing Endpoints:** The total number of endpoints with a violation (WHS<0\(\text{ns}\)).
- **Total Number of Endpoints:** The total number of endpoints analyzed.
Pulse Width Area (Pin Switching Limits)

The Pulse Width area of the Design Timing Summary section displays all checks related to pin switching limits:

- Min low pulse width
- Min high pulse width
- Min period
- Max period
- Max skew (between two clock pins of a same leaf cell).

The reported values are:

- **Worst Pulse Width Slack (WPWS):** Corresponds to the worst slack of all the timing checks listed above when using both min and max delays.

- **Total Pulse Width Slack (TPWS):** The sum of all WPWS violations, when considering only the worst violation of each pin in the design. Its value is:
  - 0 ns when all related constraints are met.
  - Negative when there are some violations.

- **Number of Failing Endpoints:** The total number of pins with a violation (WPWS < 0 ns).
- **Total Number of Endpoints:** The total number of endpoints analyzed.
**Clock Summary Section**

The Clock Summary section of the Timing Summary Report includes information similar to that produced by `report_clocks`:

- All the clocks in the design (whether created by `create_clock`, `create_generated_clock`, or automatically by the tool).
- The properties for each clock, such as name, period, waveform, type, and target frequency.

*TIP:* The indentation of names reflects the relationship between master and generated clocks.

![Clock Summary](image)

**Check Timing Section**

The Check Timing section of the Timing Summary Report contains information about missing timing constraints or paths with constraints issues that need to be reviewed. For complete timing signoff, all path endpoints must be constrained.

![Check Timing](image)
To generate Check Timing as a standalone report, do one of the following:

- Run the **Tools > Timing > Check Timing** menu command
- Run the Tcl `check_timing` command

The list of checks reported by default, as shown in Figure 2-7, is:

- **no_input_delay**: Number of input ports without at least one input delay constraint.
- **no_output_delay**: Number of output ports without at least one output delay constraint.
- **unconstrained_internal_endpoints**: Number of path endpoints excluding output ports without a timing requirement. This number is directly related to missing clock definitions, which is also reported by the no_clock check.
- **no_clock**: Number of clock pins not reached by a defined timing clock. Constant clock pins are also reported.
- **multiple_clock**: Number of clock pins reached by more than one timing clock. This usually happens when there is a clock multiplexer in one of the clock trees.
- **generated_clocks**: Number of generated clocks that refer to a master clock source which is not part of the same clock tree.
- **loops**: Number of combinational loops found in the design. The loops are automatically broken by the Vivado IDE timing engine to report timing.
- **partial_input_delay**: Number of input ports with only a min input delay or max input delay constraint. These ports are not reported by both setup and hold analysis.
- **partial_output_delay**: Number of output ports with only a min output delay or max output delay constraint. These ports are not reported by both setup and hold analysis.
- **latch_loops**: Checks for and warns of sequential feedback loops in the design.

For more information on constraints definition, see the *Vivado Design Suite User Guide: Using Constraints* (UG903) [Ref 6].

**Intra-Clock Paths Section**

This section describes the Timing values for the same source and destination clocks. The Intra-Clock Paths section of the Timing Summary Report summarizes the worst slack and
total violations of the timing paths. See Figure 2-8.

![Timing Summary Report: Intra-Clock Paths Section](image)

To view detailed information, click the names under Intra-Clock Paths in the left index pane. For example, you can view the slack and violations summary for each clock and details about the N-worst paths for SETUP/HOLD/Pulse Width checks.

The worst slack value and the number of reported paths are displayed next to the label for each analysis type. See Figure 2-9.

![Timing Summary Report: Intra-Clock Paths Details](image)
Inter-Clock Paths Section

Similar to the Intra-Clock Paths section, this section describes the Timing values for the different source and destination clocks. The Inter-Clock Paths section of the Timing Summary Report summarizes the worst slack and total violations of the timing paths with different source and destination clocks. See Figure 2-10.

To view detailed information, click the names under Inter-Clock Paths in the left index pane. For example, you can view the slack and violations summary for each clock and details about the N-worst paths for SETUP/HOLD/Pulse Width checks.

Path Groups Section

The Path Groups section of the Timing Summary Report displays default path groups and user-defined path groups.

Figure 2-11 shows an example of the Path Groups summary table. To access this table, select Path Groups in the left pane.

TIP: **async_default** is a path group automatically created by the Vivado IDE timing engine. It includes all paths ending with an asynchronous timing check, such as recovery and removal. These two checks are respectively reported under SETUP and HOLD categories, which corresponds to max delay analysis and min delay analysis. Any groups you create using group_paths appear in this section as well. Any combination of source and destination clocks can be present in a path group.
**User-Ignored Paths Section**

The User-Ignored Paths Section of the Timing Summary Report displays the paths that are ignored during timing analysis due to the set_clock_groups and set_false_path constraints. The reported slack is infinite.

---

**Unconstrained Paths Section**

The Unconstrained Paths section of the Timing Summary Report displays the logical paths that are not timed due to missing timing constraints. These paths are grouped by source and destination clock pairs. The clock name information displays as empty (or NONE) when no clock can be associated with the path startpoint or endpoint.

---

**Figure 2-12:** Timing Summary Report: User-Ignored Paths Section

**Figure 2-13:** Timing Summary Report: Unconstrained Paths Section
**Reviewing Timing Path Details**

You can expand most of the sections to show paths organized by clock pairs. For each SETUP, HOLD and Pulse Width sub-section, you can view the N-worst reported paths. Select any of these paths to view more details in the Path Properties window (Report tab).

To view the same details in a new window, double click the path.

For more information on timing path details, see Chapter 5, Performing Timing Analysis.

To access more analysis views for each path:

1. Right click the path in the right pane.
2. Select one of the following options from the popup menu:
   - Open a Schematic of the path.
   - Rerun timing analysis on this same path.
   - Highlight the path in the Device and Schematic windows.

**Filtering Paths With Violations**

The report displays the slack value of failing paths in red. To focus on these violations, click the **Show only failing paths** button 🐞.

Figure 2-14 shows the Timing Summary window with only failing paths displayed.

![Timing Summary Report Violating Paths Filter](image)

**Figure 2-14**: Timing Summary Report Violating Paths Filter
Report Clock Networks

The Report Clock Network command can be run from:

- The Flow Navigator in the Vivado IDE, or
- The Tcl command:

  ```
  report_clock_networks -name {network_1}
  ```

Report Clock Networks provides a tree view of the clock trees in the design. See Figure 2-15. Each clock tree shows the clock network from source to endpoint with the endpoints sorted by type.

![Clock Networks](image)

**Figure 2-15:** Clock Networks
The clock trees:

- Show clocks defined by the user or generated automatically by the tool.
- Report clocks from I/O port to load.

**Note:** The full clock tree is only detailed in the GUI form of the report. The text version of this report shows only the name of the clock roots.
- Can be used to find BUFGs driving other BUFGs.
- Shows clocks driving non-clock loads.

There is a folder containing each primary clock and any generated clocks defined in the design. A separate folder displays each unconstrained clock root.

Use the Filter Ports, Nets, Instances, and related buttons to reduce the amount of data displayed in the clock tree.

To view a schematic of the clock path:

1. Select an object in the tree.
2. Run the **Trace to Source** popup command.

---

**Report Clock Interaction**

To view the Clock Interaction Report, select one of the following:

- **Main Menu > Tools > Timing > Report Clock Interaction**
- **Flow Navigator > Synthesis > Report Clock Interaction**
- **Flow Navigator > Implementation > Report Clock Interaction**

Equivalent Tcl command: `report_clock_interaction -name clocks_1`
Report Clock Interaction Dialog Box

In the Vivado IDE, the Report Clock Interaction dialog box includes the following:

- **Results Name Field**
- **Command Field**
- **Open in a New Tab Check Box**
- **Options Tab**
- **Timer Settings Tab**

**Results Name Field**

The Results name field at the top of the Report Clock Interaction dialog box specifies the name of the graphical report that opens.

Equivalent Tcl option: `-name`

**Command Field**

Use the Command field to display the Tcl command line equivalent of the various options specified in the Report Datasheet dialog box.

**Open in a New Tab Check Box**

Use the Open in a New Tab check box to either: (1) open the results in a new tab; or (2) replace the last tab opened by the Results window.
Options Tab

The Options tab of the Report Clock Interaction dialog box contains the following:

- **Delay Type Field**
- **Significant Digits Field**
- **File Output Section**
- **Command Field**
- **Open in a New Tab Check Box**

**Delay Type Field**

Use the Delay Type field to set the type of analysis to be run.

- For *synthesized* designs, only max delay analysis (setup/recovery) is performed by default.
- For *implemented* designs, both min delay and max delay analysis (setup/hold, recover/removal) are performed by default.

To run min delay analysis only (hold and removal), select delay type **min**.

Equivalent Tcl option: `-delay_type`
**Significant Digits Field**

Use the Significant Digits field to specify the number of significant digits in the reported values. The default is three.

Equivalent Tcl option: `-significant_digits`

**File Output Section**

The File Output section includes:

- **Write Results to File Field**: Use the Write Results to File field to write the result to a specified file. In the Vivado IDE, the report is displayed in the Clock Interaction window.

  Equivalent Tcl option: `-file`

- **Overwrite / Append Option Buttons**: Select the Overwrite / Append option buttons to determine whether, when the report is written to a file: (1) the specified file is overwritten, or (2) new information is appended to an existing report.

  Equivalent Tcl option: `-append`

**Timer Settings Tab**

For details on this tab, see Timer Settings Tab, page 25.

**Details of the Clock Interaction Report**

The Clock Interaction report analyzes timing paths that cross from one clock domain (the source clock) into another clock domain (the destination clock). The Clock Interaction report helps to identify cases in which there may be data loss or metastability issues.

After you run the Report Clock Interaction command, the results open in the Clock Interaction window. The Clock Interaction Report displays as a matrix of clock domains with the source clocks in the vertical axis and the destination clocks in the horizontal axis. See
Matrix Color Coding

The tiles of the matrix are color coded. The colors of the matrix are determined by the background color of the Graphical Editors as defined under Tools > Options. For more information, see this link in the Vivado Design Suite User Guide: Using the Vivado IDE (UG893) [Ref 1]. To hide the legend, click the ? button on the toolbar on the left of the matrix.

- **No Path - Black**: There are no timing paths that cross from the source clock to the destination clock. In this case, there is no clock interaction and nothing to report.
- **Timed - Green**: The source clock and destination clock have a synchronous relationship, and are safely timed together. This state is determined by the timing engine when the two clocks have a common primary clock and a simple period ratio.
Chapter 2: Timing Analysis Features

• **User Ignored Paths - Dark Blue**: User-defined `false_path` or clock group constraints cover all paths crossing from the source clock to the destination clock.

• **Partial False Path - Light Blue**: User-defined `false_path` constraints cover some of the timing paths crossing from the source clock to the destination clock where the source clock and destination clock have a synchronous relationship.

• **Timed (Unsafe) - Red**: The source clock and destination clock have an asynchronous relationship. In this case, there is no common primary clock or no expandable period. For more information on asynchronous and unexpandable clocks, see [this link](https://www.xilinx.com) in the Vivado Design Suite User Guide: Using Constraints (UG903) [Ref 6].

• **Partial False Path (Unsafe) - Orange**: This category is identical to **Timed (Unsafe)**, except that at least one path from the source clock to the destination clock is ignored due to a false path exception.

• **Max Delay Datapath Only - Gray**: A `set_max_delay -datapath_only` constraint covers all paths crossing from the source clock to the destination clock.

**IMPORTANT**: The color of a cell in the matrix reflects the state of the constraints between clock domains, not the state of the timing paths worst slack between the domains. A green cell does not indicate that the timing is met, only that all timing paths that cross clock domains are properly timed, and that their clocks have a known phase relationship.

**Filtering the Clocks**

To filter the clocks displayed in the Clock Interaction report:

1. Select the **Clock Interaction View Layers** command in the toolbar.
2. Select the clocks to display.

This command reduces the matrix complexity by limiting the number of clocks, but does not reduce the number of clock interactions reported in the table below the matrix. See Figure 2-18, page 44. You can also show and hide the clocks that do not directly time a logical path in the design by clicking the **Hide Unused Clocks** button in the toolbar. Because these clocks do not contribute to WNS/TNS/WHS/THS computation, they are hidden by default.
Chapter 2: Timing Analysis Features

**Clock Pairs Slack Table**

The table below the matrix provides a comprehensive overview of the timing slack for setup/recovery and/or for hold/removal for source/destination clock pair. It also shows useful information about path requirement of the worst paths, common primary clock and constraints status. See Figure 2-17, page 42. This provides details not displayed in the matrix above.

**Sorting the Data**

To sort the data in the table in increasing or decreasing values, single click multiple times on a column header.

**Selecting Cells and Rows**

Selecting a cell in the matrix cross-selects a specific row of the table below.

Selecting a row from the table highlights a cell in the matrix above.

**Table Columns**

The table columns are:

- **ID**: A numeric ID for the source/destination clock pair being displayed.
- **Source Clock**: The clock domain from which the path originates.
- **Destination Clock**: The clock domain within which the path terminates.
Chapter 2: Timing Analysis Features

- **Edges (WNS):** The clock edges used to calculate the worst negative slack for max delay analysis (setup/recovery).
- **WNS (Worst Negative Slack):** The worst slack calculated for various paths crossing the specified clock domains. A negative slack indicates a problem in which the path violates a required setup (or recovery) time.
- **TNS (Total Negative Slack):** The sum of the worst slack violation for all the endpoints that belong to paths across the specified clock domains.
- **Failing Endpoints (TNS):** The number of endpoints in the crossing paths that fail to meet timing. The sum of the violations corresponds to TNS.
- **Total Endpoints (TNS):** The total number of endpoints in the crossing paths.
- **Path Requirements (WNS):** The timing path requirement corresponding to the path reported in the WNS column. There can be several path requirements between any clock pairs if both rising and falling edges are active for at least one of the two clocks, or some timing exceptions have been applied on paths between the two clocks. The value reported in this column is not always the most challenging requirement.

For more information, see this link in the Vivado Design Suite User Guide: Using Constraints (UG903) [Ref 6].

- **Common Primary Clock:** Whether the source clocks and destination clocks of the timing path are defined by a common primary clock. If either the source clock or the destination clock of the timing paths is with respect to a virtual clock, Virtual is displayed in the Common Primary Clock field.
- **Inter-Clock Constraints:** Shows the constraints summary for all paths between the source clock and destination clock. The possible values are listed in the Matrix Color Coding, page 42. Following are example definitions of these constraints:
  
  ```
  set_clock_groups -async -group wbClk -group usbClk
  set_false_path -from [get_clocks wbClk] -to [get_clocks cpuClk]
  ```

When the min delay analysis is also selected (hold/removal), the following columns also appear in the table:

- **Edges (WHS):** The clock edges used to calculate the worst hold slack.
- **WHS (Worst Hold Slack):** The worst slack calculated for various paths crossing the specified clock domains. A negative slack indicates a problem in which the path violates a required hold (or removal) time.
- **THS (Total negative Hold Slack):** The sum of the worst slack violation for all the endpoints that belong to paths crossing the specified clock domains for min delay analysis (hold/removal).
- **Failing Endpoints (THS):** The number of endpoints in the crossing paths that fail to meet timing. The sum of the violations corresponds to THS.
• **Total Endpoints (THS):** The total number of endpoints in the crossing paths for min delay analysis (hold/removal).

• **Path Requirements (WHS):** The timing path requirement corresponding to the path reported in the WHS column. Like with WNS, there can be several possible path requirements for min delay analysis between two clocks, and the value reported in this column does not always correspond to the most challenging ones.

For more information, see [this link](#) in the *Vivado Design Suite User Guide: Using Constraints* (UG903) [Ref 6].

One or multiple clock pairs can be selected from the table. **Report Timing** between a selected source/destination clock pair can be run from the popup menu.

### Exporting the Table

Run the **Export to Spreadsheet** command to export the table to an XLS file for use in a spreadsheet.

---

### Report Pulse Width

The Pulse Width Report checks that the design meets min period, max period, high pulse time, and low pulse time requirements for each instance clock pin. It also checks that the maximum skew requirement is met between two clock pins of a same instance in the implemented design (for example, PCIe clocks).

Equivalent Tcl command: `report_pulse_width`

**Note:** Xilinx Integrated Software Environment (ISE®) Design Suite implementation calls this check Component Switching Limits.

---

**Figure 2-19:** Report Pulse Width
Report Timing

Read Report Timing to view specific timing paths at any point of the flow after synthesis when: (1) you need to further investigate timing problems reported by Report Timing Summary; or (2) you want to report the validity and the coverage of particular timing constraints. Report Timing does not cover Pulse Width reports.

Running Report Timing

If a design is already loaded in memory, you can run Report Timing from the menu, the Clock Iteration Report, or the Timing Report and Timing Report Summary Paths List.

**Running Report Timing from the Menu**

To run Report Timing from the Menu, select **Tools > Timing > Report Timing**.

**Running Report Timing from the Clock Iteration Report**

To run Report Timing from the Clock Iteration Report:

1. Select a **from/to** clock pair.
2. Right-click and select **Report Timing** to run a report from or to the selected clocks.

**Running Report Timing from a Paths List**

To run Report Timing from a Paths List:

1. Select a path.
2. Right-click and select **Report Timing** to run a report between the selected path startpoint endpoint.

Equivalent Tcl command: `report_timing`

When setting specific Report Timing options, you can view the equivalent `report_timing` command syntax in:

- The Command field at the bottom of the dialog box, and
- The Tcl Console after execution

The `report_timing` options are listed along with the dialog box description in the following section.

Overall, the Report Timing options are identical to the Report Timing Summary options, plus a few additional filtering options.
Report Timing Dialog Box

Targets Tab

Figure 2-20: Report Timing Dialog Box: Targets Tab
Report Timing provides several filtering options that you must use in order to report a particular path or group of paths. The filters are based on the structure of a timing path.

- **Startpoints (From):** List of startpoints, such as sequential cell clock pins, sequential cells, input ports, bidirectional ports or source clock.

  If you combine several startpoints in a list, the reported paths will start from any of these netlist objects.

  The Rise/Fall filter selects a particular source clock edge.

  Equivalent Tcl option: `-from`, `-rise_from`, `-fall_from`

- **Through Point Groups (Through):** List of pins, ports, combinational cells or nets.

  You can combine several netlist objects in one list if you want to filter on paths that traverse any of them.

  You can also specify several Through options to refine your filters and report paths that traverse all groups of through points in the same order as they are listed in the command options.

  The Rise/Fall filter applies to the data edge.

  **RECOMMENDED:** Use the default value (Rise/Fall).

  Equivalent Tcl option: `-through`, `-rise_through`, `-fall_through`

- **Endpoints (To):** List of endpoints, such as input data pins of sequential cells, sequential cells, output ports, bidirectional ports or destination clock.

  If you combine several endpoints in a list, the reported paths will end with any of these netlist objects.

  In general, the Rise/Fall option selects a particular data edge. But if you specified a destination clock, it selects a particular clock edge.

  Equivalent Tcl option: `-to`, `-rise_to`, `-fall_to`

**Figure 2-20, page 48,** defines the paths from the rising clock edge of `usbClk`, through any of the `u4cpuEngine/or1200_cpu/sprs_dataout[*]` nets, to either edge of `cpuClk` or `sysClk`.
Chapter 2: Timing Analysis Features

Options Tab

The Options tab contains the following options:

- **Reports**
- **Path Limits**
- **Path Display**

Reports

- **Do not report unconstrained paths**: By default, Report Timing reports paths that are not constrained if no path that matches the filters (from/through/to), is constrained. Check this box if you do not want to display unconstrained paths in your report.

  Equivalent Tcl option: `-no_report_unconstrained`

Path Limits

- **Number of paths per group**: See Report Timing Summary, page 20.
- **Number of paths per endpoint**: See Report Timing Summary, page 20.
- **Limit paths to group**: Filters on one or more timing path groups. Each clock is associated to a group. The Vivado IDE timing engine also creates default groups such as **async_default** which groups all the paths ending with a recovery or removal timing check.

  Equivalent Tcl option: `-group`

Path Display

- **Display paths with slack greater than**: Displays the reported paths based on their slack value.

  Equivalent Tcl option: `-slack_greater_than`

- **Display paths with slack less than**: See Report Timing Summary, page 20.
- **Number of significant digits**: See Report Timing Summary, page 20.
- **Sort paths by**: Displays the reported paths by group (default) or by slack. When sorted by group, the N worst paths for each group and for each type of analysis (`-delay_type min/max/min_max`) are reported.

  The groups are sorted based on their individual worst path. The group with the worst violation appears at the top of the list. When sorted by slack, the N worst paths per type of analysis are reported (all groups combined) and are sorted by increasing slack.

  Equivalent Tcl option: `-sort_by`
**Advanced Tab**

The Advanced tab has the same options as Report Timing Summary, page 20.

**Timer Settings Tab**

The Timer Settings tab has the same options as Report Timing Summary, page 20.

**Reviewing Timing Path Details**

After you click **OK** to run the report command, a new window opens. You can now review its content. You can view the N-worst paths reported for each type of selected analysis (min/max/min_max).

*Figure 2-21* shows the Report Timing window in which both min and max analysis (SETUP and HOLD) were selected, and N=4.

![Report Timing Paths List](image)}
Select any of these paths to view more details in the Path Properties window (Report tab).

![Path Properties Window]

**Figure 2-22: Timing Path Properties Window**

To view the same details in a new window, double-click the path.

For more information on timing path details, see Chapter 5, Performing Timing Analysis.

To access more analysis views for each path, right-click the path in the right pane and select one of the following actions:

- View the timing path Schematic.
- Rerun timing analysis on the same startpoint and endpoint of the selected path.
- Highlight the path in the Device and Schematic windows.

**Filtering Paths with Violation**

The report displays the slack value of failing paths in red. To focus on these violations, click **Show only failing checks mode**.
Report Datasheet

The Report Datasheet command reports the operating parameters of the FPGA device for use in system-level integration.

Report Datasheet Dialog Box

In the Vivado IDE, select Tool > Timing > Report Datasheet to open the Report Datasheet dialog box. See Figure 2-23.

Report Datasheet Dialog Box: Options Tab

Figure 2-23: Report Datasheet Dialog Box: Options Tab
Chapter 2: Timing Analysis Features

The Report Datasheet Dialog Box Options tab includes the following:

- **Results name**: Specifies the name for the returned results of the Report Datasheet command. The report opens in the Timing window of the Vivado IDE with the specified name.
  
  Equivalent Tcl option: `-name`

- **Sort by**: Sorts the results by port name or by clock name.
  
  Equivalent Tcl option: `-sort_by`

- **Report all process corners separately**: Reports the data for all defined process corners in the current design.
  
  Equivalent Tcl option: `-show_all_corners`

- **Significant digits**: Specifies the number of significant digits in the reported values. The default is three.
  
  Equivalent Tcl option: `-significant_digits`

- **Write results to file**: Write the result to the specified file name. By default the report is written to the Timing window in the Vivado IDE.
  
  Equivalent Tcl option: `-file`

- **Overwrite / Append**: When the report is written to a file, determines whether the specified file is overwritten, or new information is appended to an existing report.
  
  Equivalent Tcl option: `-append`

- **Ignore command errors**: Executes the command quietly, ignoring any command line errors and returning no messages. Returns TCL_OK regardless of any errors encountered during execution.
  
  Equivalent Tcl option: `-quiet`

- **Suspend message limits**: Temporarily overrides any message limits. Returns all messages from this command.
  
  Equivalent Tcl option: `-verbose`

- **Command**: Displays the Tcl command line equivalent of the various options specified in the Report Datasheet dialog box.

- **Open in a new tab**: Opens the results in a new tab, or replaces the last tab opened by the Results window.

- **Open in Timing Analysis layout**: Resets the current view layout to the Timing Analysis view layout.
Chapter 2: Timing Analysis Features

Report Datasheet Dialog Box: Groups Tab

The Report Datasheet dialog box Groups tab allows you to define your own custom group of ports for analysis by specifying the reference port and additional ports to report. When Groups are not specified, the timer automatically finds the group of output ports based on the launching clock, and reports skew based on that clock.

The Report Datasheet dialog box Groups tab includes:

- **Reference**: Specifies the reference port for skew calculation. In most cases, this will be a clock port of a source synchronous output interface.
- **Equivalent Tcl option**: -group
- **Ports**: Defines additional ports to report.
- **More**: Specifies multiple groups, each with its own reference clock port. This field allows you to define a new group of ports, including a new reference port.
- **Fewer**: Removes additional groups of ports as needed.
Chapter 2: Timing Analysis Features

Details of the Datasheet Report

General Information

This section provides details of the design and Xilinx device, and the tool environment at the time of the report.

- **Design Name**: The name of the design
- **Xilinx Part**: The target Xilinx part
- **Speed File**: Information about the speed file. This is displayed in the header of the report.
- **Vivado Version**: The version of the Vivado tools used when the report was generated
- **Time generated**: The date and timestamp of the report
- **Command line**: The command line used to generate the report

Setup/Hold for Input Ports

The report displays worst-case setup and hold requirements for every input port with regard to the reference clock. The internal clock used to capture the input data is also reported.

Max/Min Delays for Output Ports

Shows worst-case maximum and minimum delays for every output port with regard to the reference clock. The internal clock used to launch the output data for is also reported.

Setup Between Clocks

For every clock pair, the worst-case setup requirements are reported for all clock edge combinations.

Setup/Hold for Input Buses

Input buses are automatically inferred and their worst-case setup and hold requirements are displayed. Worst case data window for the entire bus is the sum of the largest setup and hold values. If the input ports are constrained, the slack is also reported.

An optimal tap point is reported for input clocks with IDELAY defined. The optimal tap point can be used to configure IDELAY for balanced setup and hold slack.

The source offset is the delta between two windows. The first window is defined by the setup and hold time of the input port with regard to the clock. The second window is derived from the input delay and the clock period. If the input clock is offset with this value, then it will be in the center of the window.
Figure 2-25 reports a design in which a DDR input bus, dq[0–7], has a worst case data window of 8.150 ns. The ideal clock offset is 0.179 ns. The optimal tap point for IDELAY is 13. The optimal tap point can be specified by using the Tcl command:

```
set_property IDELAY_VALUE 13 [get_cells idelay_clk]
```

**Max/Min Delays for Output Buses**

Output buses are automatically inferred and their worst case maximum and minimum delays are displayed. The bus skew is also reported. For bus skew calculation, one bit is considered as the reference and the offset of every other bit is calculated with respect to this reference bit. The worst offset is the skew for the entire bus.

**Max/Min Delays for Groups**

For Source Synchronous Output Interfaces, the output skew is desired with regard to the forwarded clock. A custom group report can be generated by specifying the reference port as the forwarded clock port. This table looks similar to “max/min delays for output buses” except the reference port is used as the reference bit for calculating source offset and bus skew.
As an example, for a DDR output skew calculation, if multiple bits (for example, rldiii_a[0-19], rldiii_ba[0-3], rldiii_ref_n, rldiii_we_n) should be grouped together with regard to the forwarded clock port (rldiii_ck_n[0]), the following command can be used:

```tcl
report_datasheet -group [get_ports {rldiii_ck_n[0] rldiii_a[*] rldiii_ba[*] rldiii_ref_n rldiii_we_n}]
```

The first port in the group list is considered the reference pin.

For all these sections, the worst case data is calculated from multi-corner analysis. If `-show_all_corners` is used, the worst case data is reported for each corner separately.

---

**Report Exceptions**

You can use the Report Exceptions command anywhere in the flow after the synthesis. The Report Exception command reports the following information:

- All the timing exceptions that have been set in the design and that are affecting timing analysis
- All the timing exceptions that have been set in the design but that are being ignored as they are overridden by other timing exception

The timing exceptions analyzed by the Report Exception command are (in the order of precedence):

- false paths
- max/min delays
- multicycle paths

The Report Exception is a powerful command to help debugging issues related to timing exceptions. Some designs have timing constraints with complex timing exceptions. Because the timing exceptions have different priorities, it can quickly become difficult to understand which timing exceptions might be partially or fully ignored by other exception(s). The Report Exception reports timing exceptions that are partially overridden, as well as those that are totally overridden. It also provides a hint to the overriding constraint(s).

Since Clock Groups constraints (`set_clock_groups`) are not exactly a timing exception, they are not covered in the summary table of all the timing exceptions affecting the design. However, when a timing exception is overridden by a clock group constraint, the clock group overriding the constraint is reported in the Status column of the table.

The Report Exception command is only available through the Tcl command line, using Tcl command `report_exceptions`.
For more information about the `report_exceptions` command line options, refer to this link in the Vivado Design Suite Tcl Command Reference Guide (UG835). For more information about the timing exception priority order, refer to this link in the Vivado Design Suite User Guide: Using Constraints (UG903) [Ref 6].

The `report_exception` command has three modes of operation:

- Reporting the timing exceptions affecting the timing analysis
- Reporting the timing exceptions being ignored
- Reporting the timing exceptions coverage

**Example: Reporting the Timing Exceptions Affecting the Timing Analysis**

This example describes how to take the design shown in Figure 2-26 through some timing exceptions. The design is fully constrained (clock `clk` and input/output delays defined relative to `clk`).

![Figure 2-26: Fully Constrained Design for Timing Exception Example](image)

The first mode of operation of the Report Exception command is `report_exception`.

1. Select **Window > Timing Constraints**.
2. In the Timing Constraints window, add the following timing exceptions to the design:

   ```
   set_multicycle_path 3 -from [get_cell int10_reg] -to [get_cell int20_reg]
   set_multicycle_path 4 -to [get_cell int20_reg]
   set_false_path -from [get_ports in6] -to [get_cell int20_reg]
   set_false_path -to [get_ports out5]
   set_false_path -to [get_cell int21_reg]
   set_max_delay 5 -to [get_ports out6]
   set_min_delay 3 -from [get_cells int10_reg] -to [get_cell int20_reg]
   ```
Chapter 2: Timing Analysis Features

The Timing Constraints window displays the timing constraints applied to the design, as shown in Figure 2-27.

![Figure 2-27: Constraints Window Displaying Timing Constraint Changes](image_url)

The actual Exception Report (report_exception) is shown in Figure 2-28.

![Figure 2-28: Report Exception](image_url)

The Exceptions Report contains the following information:

- The **Position** column indicates the constraint position number. This is the same position number reported by the Timing Constraint Window, shown in Figure 2-27.

- The **From/Through/To** columns indicate the patterns or objects specified with -*from/-*through/-*to command line options (including all the rise/fall versions of those options). An asterisk is displayed when the associated option was not specified.

- The **Setup/Hold** columns indicate whether the constraint applies to setup check, hold check, or both. The naming convention for the **Setup/Hold** columns is:

<table>
<thead>
<tr>
<th>Short Name</th>
<th>Timing Exception</th>
</tr>
</thead>
<tbody>
<tr>
<td>cycles=</td>
<td>set_multicycle_path</td>
</tr>
<tr>
<td>false</td>
<td>set_false_path</td>
</tr>
<tr>
<td>max=</td>
<td>set_max_delay</td>
</tr>
<tr>
<td>max_dpo=</td>
<td>set_max_delay-datapath_only</td>
</tr>
<tr>
<td>min=</td>
<td>set_min_delay</td>
</tr>
</tbody>
</table>
• The Status column reports a message when a constraint is partially overridden by another timing exception. The naming convention for the Status column is:

<table>
<thead>
<tr>
<th>Short Name</th>
<th>Timing Exception</th>
</tr>
</thead>
<tbody>
<tr>
<td>MCP</td>
<td>multicycle path</td>
</tr>
<tr>
<td>FP</td>
<td>false path</td>
</tr>
<tr>
<td>MXD</td>
<td>max delay</td>
</tr>
<tr>
<td>MND</td>
<td>min delay</td>
</tr>
<tr>
<td>CG</td>
<td>clock group</td>
</tr>
</tbody>
</table>

*Note:* The clock group is only reported in the Status column of the report_timing_ignored command when a clock group constraint overrides another timing exception.

In this example, there are two messages regarding partially overridden constraints:

• The timing constraint position 5 (set_multicycle_path 4 -to [get_cell int20_reg] based on the Timing Constraints Window) is partially overridden by the multicycle constraint position 4 (set_multicycle_path 3 -from [get_cell int10_reg] -to [get_cell int20_reg]) and by the false path constraint position 6 (set_false_path -from [get_ports in6] -to [get_cell int20_reg]).

• The timing constraint position 10 (set_max_delay 5 -to [get_ports out6]) is partially overridden by the false path position 9 (set_false_path -from [get_ports in6] -to [get_ports out6]).

**Reporting the Timing Exceptions Being Ignored**

The second mode of operation of the Report Exception command is report_exception_ignored

To illustrate, add the following timing exceptions on the top of the previous ones:

```
set_max_delay 5 -to [get_ports out5]
set_multicycle_path 1 -hold -to [get_cell int21_reg]
set_multicycle_path 2 -setup -to [get_ports out6]
set_false_path -from [get_cell int11_reg] -to [get_cell int20_reg]
```

All those exceptions are either already covered by a timing exception from the previous section (*Reporting the timing exceptions affecting the timing analysis*) or target a non-existing path (there is no physical connection between the registers int11_reg and int20_reg).
After adding these four constraints, the Timing Constraints Window looks like Figure 2-29.

![Timing Constraints Window](image)

**Figure 2-29: Timing Constraints Window**

The Exceptions Report (report_exception - ignored) is as shown here:

```plaintext
<table>
<thead>
<tr>
<th>Position</th>
<th>From</th>
<th>Through</th>
<th>To</th>
<th>Setup</th>
<th>Hold</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>*</td>
<td>*</td>
<td>[get_ports out2]</td>
<td>awx=5</td>
<td>-</td>
<td>Totally overridden path by FP 7</td>
</tr>
<tr>
<td>13</td>
<td>*</td>
<td>*</td>
<td>[get_cells int20_reg]</td>
<td>cycles=1</td>
<td>-</td>
<td>Totally overridden path by FP 9 - HD 30</td>
</tr>
<tr>
<td>14</td>
<td>*</td>
<td>*</td>
<td>[get_cells int20_reg]</td>
<td>false</td>
<td>false</td>
<td>Non-existent path</td>
</tr>
<tr>
<td>15</td>
<td>[get_cells int11_reg]</td>
<td>*</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

**Figure 2-30: Exceptions Report**

*Note: The Status column provides some explanations why the timing exceptions are being ignored.*

### Reporting the Timing Exceptions Coverage

Vivado can generate a detailed coverage of each valid timing exception applied to the design. All the timing exceptions are reported, including those that are fully overridden or that do not have path between startpoints and endpoints. The coverage report can be large, depending on the number of timing exceptions and complexity of the design.

The coverage report is generated using the `-coverage` command line option:

```
report_exceptions -coverage
```

The report includes, for each valid timing exception, the following information:

- Constraint position number
- Number of objects selected by the `-from/-through/-to` command line options
- All the clock domains involved in the timing exception, as well as the number of endpoints for each endpoint clock domain
- A summary list of cells involved in the startpoints and endpoints
Chapter 2: Timing Analysis Features

Below is an abstract from a coverage report from a different design:

Exception: set_false_path -from [get_pins {SW_FPGA_CORE/U_RST/st_asrst[0]/C}] -to [get_pins {SW_FPGA_CORE/U_RST/st_asrst[0]/C}]
+ Position: 74
+ Objects:
  -from: 1 pins
+ Clock Domains Details:
  +Domain: CLK_OUT2_PLL3 -> CLK_OUT1_PLL3
    -Source Clock: CLK_OUT2_PLL3
    -Destination Clock: CLK_OUT1_PLL3
    -Endpoints: 154277
  +Domain: CLK_OUT2_PLL3 -> CLK_OUT2_PLL3
    -Source Clock: CLK_OUT2_PLL3
    -Destination Clock: CLK_OUT2_PLL3
    -Endpoints: 9933
  +Domain: CLK_OUT2_PLL3 -> CLK_OUT4_PLL3
    -Source Clock: CLK_OUT2_PLL3
    -Destination Clock: CLK_OUT4_PLL3
    -Endpoints: 434
  +Domain: CLK_OUT2_PLL3 -> clk_pll_i
    -Source Clock: CLK_OUT2_PLL3
    -Destination Clock: clk_pll_i
    -Endpoints: 7193
+ Startpoint Details: FDPE/C=1
+ Endpoint Details: FDCE/CLR=169792 FDCE/D=7 FDPE/PRE=2038

When a timing exception does not have any path between the startpoints and endpoints, the coverage report has empty fields. For example:

Exception: set_false_path -from [get_cells int11_reg] -to [get_cells int20_reg]
+ Position: 15
+ Objects:
  -from: 1 cells
  -to: 1 cells
+ Clock Domains Details:
+ Startpoint Details:
+ Endpoint Details:

The coverage reports can be used to improve the effectiveness of how the timing exceptions are written.

Below is another example of coverage report for a set_multi_cycle path constraint:

Exception: set_multicycle_path -start -from [get_pins {sr_b*_rd_dat[*]/C}] -to [get_pins {ar_b*_rd_dat[*]/D}] 4
+ Position: 75
+ Objects:
  -from: 486 pins
  -to: 486 pins
+ Clock Domains Details:
  +Domain: CLK_OUT1_PLL3 -> CLK_OUT2_PLL3
    -Source Clock: CLK_OUT1_PLL3
    -Destination Clock: CLK_OUT2_PLL3
    -Endpoints: 24
+ Startpoint Details: FDCE/C=4
+ Endpoint Details: FDCE/D=24
In the above example, the get_pins commands used to build the -from/-to command line options return each 486 pins. However, paths between 4 startpoints and 24 endpoints are covered. This means that other combinations of startpoints and endpoints do not have physical paths.

---

### Report Clock Domain Crossings

The Clock Domain Crossings (CDC) report performs a structural analysis of the clock domain crossings in your design. You can use this information to identify potentially unsafe CDCs, which will lead to metastability or data coherency issues. While the CDC report is similar to the Clock Interaction Report, the CDC report focuses on structures and their timing constraints, but does not provide information related to timing slack.

#### Overview

Before generating the CDC report, you must ensure that the design has been properly constrained and there are no missing clock definitions. Report CDC only analyzes and reports paths where both source and destination clocks have been defined. Report CDC performs structural analysis:

- On all paths between asynchronous clocks.
- Only on paths between synchronous clocks that have the following timing exceptions:
  - Clock groups
  - False Path
  - Max Delay Datapath Only

Synchronous clock paths with no such timing exception are assumed to be safely timed and are not analyzed by the CDC engine. The Report CDC operates without taking into consideration any net or cell delays.

#### Running Report Clock Domain Crossings

When you run Report CDC from the Vivado IDE dialog box, it provides all the details for the CDC paths between the specified clocks by default. When you run Report CDC from the Tcl Console, however, it only prints the Summary by Clock Pairs table. You must specify the -details option in order to report all the details as in the GUI mode. Reporting the details can create very long files or log files.

To run the Report Clock Domain Crossings in the Vivado IDE, select **Tools > Timing > Report CDC**.

Equivalent Tcl command: `report_cdc -name cdc_1`
Chapter 2: Timing Analysis Features

In the Vivado IDE, the Report CDC dialog box includes the following fields, as shown in Figure 2-31:

- Results Name Field
- Clocks Field (From/To)
- File Output Field
- Options Field

Results Name Field

In the Results Name field at the top of the Report Clock Domain Crossings dialog box, specify the name of the graphical window for the report.

Equivalent Tcl option: -name <windowName>
Chapter 2: Timing Analysis Features

**Clocks Field (From/To)**

The Clocks To and From fields allow you to optionally specify the source and/or destination clocks on which to run the CDC analysis. You can use the From/To options to control the scope of Report CDC to specific clocks and result in more readable reports.

Click the Browse button to the right to open a search dialog box to aid in finding clock objects.

Equivalent Tcl option: `-from <clockNames> -to <clockNames>`

**File Output Field**

The File Output field allows you to optionally specify a file into which to write the results. You can overwrite the file or append to it.

Equivalent Tcl option: `-file <fileName> -append`

**Options Field**

The Options field allows you to:

- Suspend message limits
  
  Equivalent Tcl option: `-verbose`

- Ignore command errors
  
  Equivalent Tcl option: `-quiet`

**Understanding the Clock Domain Crossings Report Rules**

Report CDC tries to match each CDC path to a known CDC topology. Each CDC topology is associated with one or several CDC rules, as presented in Table 2-1. Note that you cannot modify the severity of the rules as with DRCs and Messages. Simplified schematics and descriptions of the CDC Topologies being detected are included in Simplified Schematics of the CDC Topologies, page 72.

**Table 2-1: CDC Rules and Description**

<table>
<thead>
<tr>
<th>CDC Topology</th>
<th>CDC Rule</th>
<th>Severity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single-bit CDC</td>
<td>CDCH-1</td>
<td>Critical</td>
<td>A single-bit CDC path is not synchronized or has unknown CDC circuitry.</td>
</tr>
<tr>
<td></td>
<td>CDCH-2</td>
<td>Warning</td>
<td>A single-bit CDC path is synchronized with a 2+ stage synchronizer but the ASYNC_REG property is missing on all or some of the synchronizer flip-flops.</td>
</tr>
<tr>
<td></td>
<td>CDCH-3</td>
<td>Info</td>
<td>A single-bit CDC path is synchronized with a 2+ stage synchronizer and the ASYNC_REG property is present.</td>
</tr>
</tbody>
</table>
Table 2-1: CDC Rules and Description (Cont’d)

<table>
<thead>
<tr>
<th>CDC Topology</th>
<th>CDC Rule</th>
<th>Severity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multi-bit CDC</td>
<td>CDCH-4</td>
<td>Critical</td>
<td>A multi-bit bus CDC path is not synchronized or has unknown CDC circuitry.</td>
</tr>
<tr>
<td></td>
<td>CDCH-5</td>
<td>Warning</td>
<td>A multi-bit bus CDC path is synchronized with a 2+ stage synchronizer but the ASYNC_REG property is missing on all or some of the synchronizer flip-flops.</td>
</tr>
<tr>
<td></td>
<td>CDCH-6</td>
<td>Info</td>
<td>A multi-bit bus CDC path is synchronized with a 2+ stage synchronizer and the ASYNC_REG property is present.</td>
</tr>
<tr>
<td>Asynchronous Reset</td>
<td>CDCH-7</td>
<td>Warning*</td>
<td>An asynchronous signal (clear or preset) is not synchronized or has unknown CDC circuitry.</td>
</tr>
<tr>
<td></td>
<td>CDCH-8</td>
<td>Warning</td>
<td>An asynchronous signal (clear or preset) is synchronized but the ASYNC_REG property is missing on all or some of the synchronizer flip-flops.</td>
</tr>
<tr>
<td></td>
<td>CDCH-9</td>
<td>Info</td>
<td>An asynchronous reset is synchronized and the ASYNC_REG property is present.</td>
</tr>
<tr>
<td>Combinatorial Logic</td>
<td>CDCH-10</td>
<td>Warning*</td>
<td>Combinatorial logic has been detected in the fanin of a synchronization circuit.</td>
</tr>
<tr>
<td>Fanout</td>
<td>CDCH-11</td>
<td>Warning*</td>
<td>A fanout has been detected before a synchronization circuit.</td>
</tr>
<tr>
<td>Multi-Clock Fanin</td>
<td>CDCH-12</td>
<td>Warning*</td>
<td>Data from multiple clocks are found in the fanin of a synchronization circuit.</td>
</tr>
<tr>
<td>non-FD primitive</td>
<td>CDCH-13</td>
<td>Critical</td>
<td>CDC detected on a non-FD primitive.</td>
</tr>
<tr>
<td>CE-controlled CDC</td>
<td>CDCM-1</td>
<td>Warning</td>
<td>Clock Enable controlled CDC.</td>
</tr>
<tr>
<td>Mux-controlled CDC</td>
<td>CDCM-2</td>
<td>Warning</td>
<td>Multiplexer controlled CDC.</td>
</tr>
<tr>
<td>Mux Data Hold CDC</td>
<td>CDCM-3</td>
<td>Warning</td>
<td>Multiplexer data holding CDC.</td>
</tr>
</tbody>
</table>

* Denotes CDC Rules with Warning Severity that can potentially change to Critical Severity in future releases.

Reviewing the Clock Domain Crossings Report Sections

In the GUI mode, three sections are generated by default:

- **Summary by Clock Pair**
- **Summary by Type**
- **Detailed Report**

The summary sections provide a convenient overview of the issues that need review and possibly a change in the design. These sections can be used to navigate to the violations of highest Severity where additional information is contained within the Detailed Report section.

**Note:** By default, only the Summary by clock pair section is generated when running the report in text mode.
**Summary by Clock Pair**

In the Summary (by clock pair) section, useful information about the number of CDC paths between two clocks are presented, along with the severity of the most critical issue found among these paths. The table includes the following columns:

- **Severity**: Reports the worst severity of all CDC paths from/to the listed clocks. Values are *Info*, *Warning*, or *Critical*.
- **Source Clock**: Shows the name of the CDC Source Clock.
- **Destination Clock**: Shows the name of the CDC Destination Clock.
- **CDC Type**: Reflects the relationship between two clocks and their dominant timing exception, if any. Possible types are:
  - **Safely Timed**: All CDC paths are safely timed because the clocks are synchronous and accurate timing is not prevented by a timing exception.
  - **User Ignored**: All CDC paths are covered by `set_false_path` or `set_clock_groups`.
  - **No Common Primary Clock**: The CDC clocks are asynchronous and at least 1 CDC path is normally timed.
  - **No Common Period**: The CDC clocks are asynchronous and at least 1 CDC path is normally timed. For the definition of clocks with no common period, refer to *Understanding the Basics of Timing Analysis*, page 133.
- **Exceptions**: The timing exceptions applied to the CDC (if any) are:
  - **None**: No timing exceptions exist on the CDC paths.
  - **Asynch Clock Groups**: The `set_clock_groups -asynchronous` exception was applied to the CDC clocks.
  - **Exclusive Clock Groups**: The `set_clock_groups -exclusive` exception was applied to the CDC clocks.
  - **False Path**: The `set_false_path` exception was applied to from/to the CDC clocks or to all CDC paths.
  - **Max Delay Datapath Only**: The `set_max_delay -datapath_only` exception was applied to all CDC paths. Note that “Max Delay Datapath Only” is reported when at least one CDC path is only covered by `set_max_delay -datapath_only`, while all other CDC paths are ignored due to `set_false_path` constraints.
  - **Partial Exceptions**: A mix of `set_false_path` and `set_max_delay -datapath_only` constraints are applied to some of the CDC paths, and at least one CDC path is normally timed.
• **Endpoints**: The total number of CDC path endpoints. This is the sum of Safe and Unknown endpoints. In this context, an endpoint is a sequential cell input data pin. An FD cell can be counted several times depending on the D, CE, and SET/RESET/CLEAR/PRESET connectivity. For some CDC topologies, only one endpoint is counted while there are effectively several paths crossing the clock domain boundary to reach the CDC structure. For example, in an asynchronous reset synchronizer, several CLEAR pins are connected to the crossing net, but only the first pin of the synchronizer chain is counted.

• **Safe**: The number of safe CDC path endpoints. Safe endpoints are endpoints on CDC paths identified as:
  - Asynchronous Clocks with known Safe CDC structures
  - Synchronous Clocks with exceptions and known Safe CDC structures
  - Synchronous Clocks without exceptions that are safely timed regardless of the CDC structure

• **Unknown**: The number of unknown CDC path endpoints. No safe CDC structure can be matched on these endpoints.

• **No ASYNC_REG**: The number of identified synchronizers that are missing the ASYNC_REG property on at least one of the two first FD cells of the chain.

The figure below shows an example of a Summary by clock pair section.

*Figure 2-32: Summary by Clock Pair Section*
Summary by Type

The Summary by Type table is convenient for quickly reviewing the nature of CDC structures found in the current report. An example is shown in Figure 2-33.

The Summary by Type table includes the following columns:

- **Severity**: Reports the severity of the CDC Rule as Info, Warning, or Critical.
- **ID**: Unique identification number of the CDC Rule, as listed in Table 2-1.
- **Count**: Number of occurrences of the CDC Rule in the entire report.
- **Description**: Short description of the CDC Rule.

When analyzing the summary tables, it is important to start with the highest severity. Severity levels are:

- **Critical**: This severity is for CDC paths with unknown CDC Structures. You must review each individual path to either fix the structure by modifying the RTL, or waive the issue. The path details are generated by default when using the Vivado IDE, and only when -details is used in other modes.
- **Warning**: This severity is for CDC paths with known CDC Structures that are safe but non-ideal due to one of the following reasons:
  - At least one of the two first synchronizer flip-flops does not have the ASYNC_REG property set to 1 (or true)
  - There is some combinatorial logic on the crossing net or several source clocks are found in the fanin of the crossing net. This can degrade the Mean Time Before Failure (MTBF) characteristics. This rule will become Critical in future Vivado releases.
  - There is a fanout on the crossing net to the same destination clock domain. This can lead to data coherency problems. This rule will become Critical in future Vivado releases.
The CDC structure identified requires functional correctness that the CDC engine cannot verify. These structures are Clock Enable Controlled, MUX Controlled, and MUX Data-Hold controlled CDC topologies.

- **Info**: This severity indicates that CDC structures are all safe and properly constrained.

**Detailed Report**

The Report CDC details can be viewed by looking at the Clock to Clock Details section in the report. You can use the detailed report to view the schematic of the selected path (by pressing the F4 key), view the timing report, or generate a new timing report by right-clicking on the individual entry.

You can use the timing reports and schematics to review unexpected CDC paths in the design, identify incorrect or missing timing exceptions, and also finding missing ASYNC_REG properties. An example of the CDC Detailed Report is shown in Figure 2-34.

![Figure 2-34: CDC Detailed Report](image)

The CDC Detailed Report table includes the following columns:

- **Severity**: Reports the severity of the CDC Rule as Info, Warning, or Critical.
- **ID**: The unique identification number of the CDC Rule, as listed in Table 2-1, page 66.
- **Description**: A short description of the CDC Rule.
- **Depth**: The number of synchronizer stages found (only applies to synchronizer topologies).
- **Exception**: The timing exception applied to the CDC path.
- **Source (From)**: The CDC timing path startpoint.
- **Destination (To)**: The CDC timing path endpoint.

**IMPORTANT**: The CDC report can flag issues in some of the Xilinx IPs because the CDC engine does not recognize all possible CDC topologies and does not provide a built-in waiver mechanism. More information can be found in each Xilinx IP Product Guide.
Simplified Schematics of the CDC Topologies

Simplified schematics of the CDC Topologies along with brief descriptions are shown in the following sections. In all schematics, the Source Clock net (typically `clk_a`) is highlighted in blue and the Destination Clock net (typically `clk_b`) is highlighted in orange.

**Single-Bit Synchronizer**

The simplified topology of a Single-bit synchronizer is shown in Figure 2-35. The `ASYNC_REG` property must be set on at least the first two flip flops of the synchronization chain. The synchronizer depth is defined by the number of chained flip-flops that share the same control signals.

![Simplified Topology of a Single-Bit Synchronizer](image)

*Figure 2-35: Simplified Topology of a Single-Bit Synchronizer*

If the `CLEAR` or `PRESET` pins of the flip-flops are also connected to an asynchronous source, the synchronizer is only reported as a single-bit synchronizer and not as an asynchronous reset synchronizer.

**Multi-Bit Synchronizer**

A multi-bit synchronizer is equivalent to multiple single-bit synchronizers grouped together based on the startpoint-endpoint names and matching CDC rules. In this context, a bus is defined by the startpoint and endpoint cell names and not by the net names. The expected bus name format is `baseName[index]`. Also the startpoint and endpoint indexes must match. Figure 2-36, page 73 shows an example of a multi-bit synchronizer that is 2-bit wide.
If all bits of a CDC bus do not match the same CDC rule, the bus is reported as single bits or bus segments with continuous indexes that match a same CDC rule.

**Asynchronous Reset Synchronizer**

The synchronization of an asynchronous reset is shown in Figure 2-37, page 74 for CLEAR-based synchronization, and Figure 2-38, page 74 for PRESET-based synchronization. The FF1 cell is respectively connected to the synchronized clear or preset signals and their deassertion can safely be timed against \( \text{clk}_a \).
Note that flip-flops with CLEAR and PRESET cannot be mixed within an asynchronous reset synchronizer.

*Figure 2-37:* CLEAR-Based Asynchronous Reset Synchronizer

*Figure 2-38:* PRESET-Based Asynchronous Reset Synchronizer
Combinatorial Logic

In the combinatorial logic simplified example presented in Figure 2-39, a logic function represented by the LUT3 is placed between the CDC from clk_a to clk_b synchronizers.

This structure is traditionally not recommended due the potential occurrence of glitches on the output of the combinatorial logic, which is captured by the synchronizer and propagated downward to the rest of the design.
### Fanout

In the simplified Fanout example shown in Figure 2-40, the source flip-flop drives a net that is synchronized three times in the `clk_b` domain highlighted in red. This structure is not recommended as it can lead to data coherency issues in the destination clock domain because the latency through the synchronizers is bounded but not cycle-accurate.

**Figure 2-40: Simplified Fanout Example**
### Multi-Clock Fanin

In the Multi-Clock Fanin example shown in Figure 2-41, both clk_a and clk_x are transferring data through combinatorial logic (LUT2) to the synchronizer circuit in the clk_b domain. It is recommended to first synchronize the source data from clk_a and clk_x individually before combining them via some glue logic. This improves the MTBF characteristics of the overall CDC structure, and it prevents glitches to propagate to the destination clock domain.

**Figure 2-41: Multi-Clock Fanin Example**
Non-FD Primitive

In the Non-FD Primitive example presented in Figure 2-42, a CDC is occurring between a FDRE and a RAMB while no synchronization logic exists inside the RAMB primitive. Even if a single stage flip-flop connected to $\text{clk}_b$ is inserted in front of the RAMB, it is still considered an inadequate synchronizer due to the routing distance between the FDRE and RAMB cells.

Figure 2-42: Non-FD Primitive Example
CE-controlled CDC

In the CE-controlled CDC example shown in Figure 2-43, the clock enable signal is synchronized in the destination \( \text{clk}_b \) domain before being used to control the crossing flip-flops.

The CDC engine only checks that the signal connected to FF3/CE is also launched by \( \text{clk}_b \). There is no restriction on how the clock enable signal is synchronized, as long as it is separately reported as a safe CDC path. Also, you are responsible for constraining the latency from the \( \text{clk}_a \) domain to FF3, which is usually done by a `set_max_delay -datapath_only` constraint.
**Mux-Controlled CDC**

In the Mux-controlled CDC example shown in Figure 2-44, the multiplexer select signal is synchronized to the destination clock domain, \( clk_b \).

*Figure 2-44: Mux-Controlled CDC Example*

Similar to CE-controlled CDC, there is no restriction on how the select signal is synchronized as long as it is reported as safe individually and the user is responsible for constraining the crossing delay on \( FF2_c \).
**Mux Data Hold CDC**

In the Mux Data Hold CDC example presented in Figure 2-45, the multiplexer select signal is synchronized to the destination clock domain \( \text{clk}_b \) and the \( \text{data\_out} \) is fed back to the multiplexer.

![Diagram of Mux Data Hold CDC Example](image)

**Figure 2-45:  Mux Data Hold CDC Example**

Similar to CE-controlled CDC, there is no restriction on how the multiplexer select signal is synchronized as long as it is reported as safe individually and the user is responsible for constraining the crossing delay on \( \text{FF2\_c} \).
Chapter 3

Implementation Results Analysis Features

This chapter discusses techniques for reviewing a design after implementation to understand behavior inside the device, including:

- Reviewing placement for hierarchical blocks
- I/Os
- Looking at connectivity
- Cross probing between views
- Reviewing detailed routing

Using the Design Runs Window

The Design Runs window displays the state of the current runs.

For more information, see this link in the Vivado Design Suite User Guide: Implementation (UG904) [Ref 7].

If the run is running, finished cleanly, or finished with errors, the Design Runs window appears when a run is done.

**TIP:** If the run is not up to date, you can select Force Up-to-Date from the pop-up menu.

![Design Runs Window](figure3-1.png)

*Figure 3-1: Design Runs Window*
The Design Runs Window columns show:

- The name of the run
- The target part
- The constraints set associated with a run
- The run strategy
- The status of the last completed step of a run
- The progress of a run
- The start time of a run
- The elapsed time of a run during execution or the final runtime of a completed run
- The timing score of a run: WNS, TNS, WHS, THS and TPWS (see Report Timing Summary for more information on these numbers). This is where you can quickly verify that a run meets timing. If it does not meet timing, you must start the analysis with the Timing Summary Report.
- The number of nets that were not successfully routed
- A brief description of the run strategy

If you are using the Vivado IDE project flow, review the Messages tab for your active synthesis and implementation runs. Messages are grouped by run steps in the flow. All the information saved in the run log files, and the main Vivado session log file, appear in this consolidated and filtered view.

Some messages crossprobe back to a source file that can always be opened by clicking on the file name, or in some cases to a design object related to the message. Depending on which step of the flow you are analyzing, you must open either the synthesized design or the implemented design in order to be able use the object crossprobing from the message.
Placement Analysis

This section discusses Placement Analysis and includes:

- Highlighting Placement
- Showing Connectivity
- Viewing Metrics

Highlighting Placement

Another way to review design placement is to analyze cell placement. The Highlight Leaf Cells command helps in this analysis.

- In the Netlist Window, select the levels of hierarchy to analyze.
- From the popup menu, select Highlight Leaf Cells > Select a color.
- If you select multiple levels of hierarchy, select Cycle Colors.

The leaf cells that make up the hierarchical cells are color coded in the Device window.

![Highlight Hierarchy](image)

*Figure 3-3: Highlight Hierarchy*
The color coding readily shows that \texttt{UsbEngine0} (in yellow):

- Uses a number of Block RAM and DSP48 cells.
- Is in the top clock region of the chip except where the DSPs bleed out.
- Is not highly intermingled with other logic (cells) in the design.

It is easy to see that the \texttt{fftEngine} (in red) and the \texttt{cpuEngine} (in brown) are intermingled. The two blocks primarily use different resources (DSP48 as opposed to slices). Intermingling makes best use of the device.

**Showing Connectivity**

It can be useful to analyze a design based on connectivity. Run \texttt{Show Connectivity} to review the placement of all logic driven by an input, a Block RAM, or a bank of DSPs.

\texttt{Show Connectivty} takes a set of cells or nets as a seed, and selects objects of the other type.

\textbf{TIP: Use this technique to build up and see cones of logic inside the design.}

![Figure 3-4: Show Connectivity](image)

\textbf{Figure 3-4} shows a Block RAM driving logic inside the device including OBUFs. A synthesis pragma stops synthesis from placing the output flop in the Block RAM during memory inferencing.
Fixed and Unfixed Logic

The Vivado tools track two different types of placement:

- Elements placed by the user (shown in orange) are **Fixed**.
  - **Fixed** logic is stored in the XDC.
  - **Fixed** logic normally has a LOC constraint and might have a BEL constraint.
- Elements placed by the tool (shown in blue) are **Unfixed**.

In Figure 3-5, the I/O and Block RAM placement is **Fixed**. The slice logic is **Unfixed**.
Cross Probing

For designs synthesized with Vivado Synthesis, it is possible to cross probe back to the source files once the netlist design is in memory.

To cross probe:

1. Select the gate.
2. Select Go to Instantiation from the popup menu.

*Figure 3-6: Xprobe Back To Source*

Use crossprobing to determine which source is involved in netlist gates. Due to the nature of synthesis transforms, it is not possible to cross probe back to source for every gate in the design.
Viewing Metrics

After implementation finishes, you may want to analyze the design to see how it interacts with the device. The Vivado IDE has a number of metrics to help you determine logic and routing usage inside the device. The Metrics color code the device window based on a specified rule. To view a metric, right-click in the device view, select **Metric**, and then select the metric you would like to view.

![Figure 3-7: Metrics](image)
Metrics Requiring a Placed Design

Four metrics require a placed design in order to be accurate. They do not require a fully routed design.

- **LUT Utilization per CLB**: Color codes slices based on placed LUT utilization.
- **FF Utilization per CLB**: Color codes slices based on placed FF utilization.
- **Vertical Routing Congestion per CLB**: Color codes the fabric based on a best case estimate of vertical routing usage.
- **Horizontal Routing Congestion per CLB**: Color codes the fabric based on a best case estimate of horizontal routing usage.

Metrics in a Netlist Design with No Placement

Two metrics are applicable if there are Pblocks. They do not depend on placement.

- **LUT Utilization per Pblock**: Color codes the Pblock based on an estimate of how the LUTs will be placed into the slices contained in the Pblock.
- **FF Utilization per Pblock**: Color codes the Pblock based on an estimate of how the FFs will be packed into the slices contained in the Pblock.

More than one rule can be used at a time as shown in Figure 3-7, page 88. Both LUT Utilization per CLB and FF Utilization per CLB are on.

**TIP:** If there are sections of the design with high utilization or high estimates of routing congestion, consider tweaking the RTL or placement constraints to reduce logic and routing utilization in that area.
Routing Analysis

Turn on Routing Resources in the Device View to view the exact routing resources.

Displaying Routing and Placement

Routing and placement display in two different ways depending on the zoom level:

- When zoomed out
- At closer zoom levels

**TIP:** The two visualizations of the Device view minimize runtime and memory usage while showing the details of designs of all sizes.

**Displaying Routing and Placement when Zoomed Out**

When zoomed out, an abstract view is shown. The abstract view:

- Condenses the routes through the device.
- Shows lines of different thicknesses depending on the number of routes through a particular region.
Placement similarly displays a block for each tile with logic placed in it. The more logic in a tile, the larger the block representing that tile will be.

![Abstract View](image)

**Figure 3-9: Abstract View**

**Displaying Routing and Placement at Closer Zoom Levels**

At closer zoom levels, the actual logic cells and routes show.

![Detailed View](image)

**Figure 3-10: Detailed View**
Viewing Options

The Device View is customizable to show the device, and design, in a variety of ways. Most of these are controlled through the Device View Options slideout.

![Device View Layers](image)

**Figure 3-11: Device View Layers**

You can enable or disable the graphics for different design and device resources, as well as modify the display colors.
Navigating in the Device View

Use the following tools to navigate in the Device View.

- **Zoom Controls**: Standard Zoom In, Zoom Out, and Zoom Full tools.
- **Autofit Selection**: Automatically zoom and pan to an object selected in any view outside of the device. Autofit Selection is particularly useful for cross probing.
- **World View**: The World View shows where the currently visible portion of the device is on the overall device. You can move and resize the World View, as well as drag and resize the yellow box to zoom and pan.
- **Control Hotkey**: Press Ctrl while clicking and dragging to pan the view.
Chapter 4

Viewing Reports and Messages

Introduction to Reports and Messages

The Xilinx® Vivado® Integrated Design Environment (IDE) generates reports and messages to inform you of the state of the design or design processes during various tool interactions. Reports are generated by you (or by the tool) at key steps in the design flow. The reports summarize specific information about the design.

The tool generates messages automatically at each step of the design process, and for many user actions.

Messages and reports are stored in the Messages and Reports windows in the Results window area.

When you run any of the following commands, the tool starts a new process:

- Run Synthesis
- Run Implementation
- launch_runs (Tcl)

For more information on Tcl commands, see the Vivado Design Suite Tcl Command Reference Guide (UG835) [Ref 3], or type <command> -help.

The process generates messages and reports that persist on disk until you reset the run. Messages that relate to a run appear when a project is open. The tool displays only the messages for the active run in the Messages window.

Reports result from a variety of actions in the Vivado IDE:

- When you load a design, many different reporting commands are available through the Tools menu.
- Running Synthesis or Implementation creates reports as part of the run.
Chapter 4: Viewing Reports and Messages

Viewing and Managing Messages in the IDE

Messages provide brief status notes about specific elements of the design, or about errors that occurred in tool processes.

TIP: Review the messages to determine whether the Vivado tools are having difficulty, or are encountering errors in any sections of the design.

Using the Reports Window

The reports for the active Synthesis and Implementation runs appear in the Reports window. Double click a report to view it in the text viewer. Select the Reports tab of the Run Properties window to view reports of the run selected in the Design Runs window.

Using the Messages Window

There are two types of messages:

- Messages stored on disk
- Messages stored in memory

The Vivado Integrated Design Environment (IDE) groups messages in the Messages window by the action that created the message.

Use the command buttons on the toolbar menu to group the messages by message ID or file.

Figure 4-1: Reports Window

Figure 4-2: Messages Window
Some messages include hyperlinks to a file or a design element to help in debugging. Click the link to view the source.

**TIP:** *Use the popup menu to copy messages to paste into another window or document.*

Each message is labeled with a message ID and a message severity.

- **Message ID**

  The message ID identifies different messages, allowing them to be grouped and sorted.

- **Message Severity**

  The message severity describes the nature of the information presented.

Some messages require your attention and resolution before the design can be elaborated, synthesized, or implemented. Some messages are informational only. Informational messages provide details about the design or process, but require no user action.

**Table 4-1: Message Severities**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Severity</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="." alt="Status" /></td>
<td>Status</td>
<td>Communicates general status of the design processing.</td>
</tr>
<tr>
<td><img src="." alt="Info" /></td>
<td>Info</td>
<td>General status of the process and feedback regarding design processing.</td>
</tr>
<tr>
<td><img src="." alt="Warning" /></td>
<td>Warning</td>
<td>Design results may be sub-optimal because constraints or specifications may not be applied as intended.</td>
</tr>
<tr>
<td><img src="." alt="Critical" /></td>
<td>Critical Warning</td>
<td>Certain user input or constraints will not be applied, or are outside the best practices, which usually leads to an error later on in the flow. Examine their sources and constraints. Changes are highly recommended.</td>
</tr>
<tr>
<td><img src="." alt="Error" /></td>
<td>Error</td>
<td>An issue that renders design results unusable and cannot be resolved without user intervention. The design flow stops.</td>
</tr>
</tbody>
</table>

**RECOMMENDED:** Carefully review all errors and critical warnings issued by the tools when loading a design in memory, or from your active synthesis and implementation run. The messages provide information about problems that require your attention. Many messages include a longer description, along with resolution advice that can be displayed by clicking on the message ID.
For an example, see Figure 4-3. In this example, a primary clock constraint refers to a port that cannot be found in the design (first warning), so the clock is not created (first critical warning) and any other constraints that refer to this clock fail as well.

Filtering Messages

You can filter messages by severity.

To enable or disable the display of a specific message type:

1. Go to the Messages window.
2. Select (to enable) or deselect (to disable) the check box next to a message severity in the window header.

You can change the severity of a specific message ID. For example, you can decrease the severity of a message you do not believe is critical, or increase the severity of a message you think demands more attention.

To increase or decrease the severity of a message, use the `set_msg_config` Tcl command. For example:

```
set_msg_config -id "[Common 17-81]" -new_severity "CRITICAL WARNING"
```

For more information on the `set_msg_config` Tcl command, see this link in the Vivado Design Suite Tcl Command Reference Guide (UG835) [Ref 3].
Chapter 4: Viewing Reports and Messages

Vivado Generated Reports and Messages

This section discusses Vivado Generated Reports and Messages and includes:

- Synthesis Report and Messages
- Implementation Log
- WebTalk Report

Synthesis Report and Messages

The Vivado Synthesis Report is the primary output from the Vivado Synthesis tool including:

- The files processed, which are:
  - VHDL
  - Verilog
  - System Verilog
  - XDC
- Parameter settings per cell
- Nets with Multiple Drivers
- Undriven hierarchical pins
- Optimization information
- Black boxes
- Final Primitive count
- Cell usage by Hierarchy
- Runtime and memory usage

IMPORTANT: Review this report or the messages tab for Errors, Critical Warnings and Warnings. The Synthesis tool can issue Critical Warnings and Warnings that become more serious later in the flow.
**Implementation Log**

The Vivado Implementation Log includes:

- Information about the location, netlist, and constraints used.
- Logic optimization task. The tool runs logic optimization routines by default to generate a smaller and faster netlist.
- The placement phases, plus a post-placement timing estimate (WNS and TNS only).
- The router phases, plus several timing estimates and an estimated post-routing timing summary (WNS, TNS, WHS and THS only).
- Elapsed time and memory for each implementation command and phases.

Review this report or the proper section of the messages tab for Errors, Critical Warnings and Warnings. The Placer generates warnings that may be elevated to Errors later in the flow. If using Stepwise runs, the log contains only the results for the last step.

**IMPORTANT:** Review the Timing Summary Report to view: (1) the Pulse Width timing summary, and (2) additional information about timing violations or missing constraints.

**WebTalk Report**

The WebTalk Report is generated during Bitstream. The report collects information about how you use Xilinx parts. This helps Xilinx provide you with better software. No proprietary information is collected. For more information, go to:

http://www.xilinx.com/webtalk/

**Creating Design Related Reports**

This section discusses Creating Design Related Reports and includes:

- Report Utilization
- Report I/O
- Report Clock Utilization
- Report Control Sets
- Report DRC
- Report Route Status
- Report Noise
- Report Power
Chapter 4: Viewing Reports and Messages

Report Utilization

The Utilization Report is generated during various steps in the flow by `report_utilization`. The report includes the device used for the run and utilization for:

- **Slice Logic**
  - LUT
  - MuxFx
  - Register

- **Memory**
  - BlockRam
  - FIFO

- **DSP48E1**

- **I/O Resources**

- **Clocking Resources**
  - BUFGCTRL
  - BUFR
  - BUFHCE
  - MMCME2_ADV
  - PLL2_ADV

- **Specific Device Resources**
  - STARTUPE2
  - XADC

- **Primitive type count sorted by usage**

- **Black Boxes**

- **Instantiated Netlists**

When run from the Tcl Console, the report can include usage of a particular hierarchical cell when using the `-cells` option. When run from the Vivado IDE graphical user interface, this information appears in an interactive table.

The numbers may change at various points in the flow, when logic optimization commands change the netlist.
Chapter 4: Viewing Reports and Messages

Report I/O

The I/O Report replaces the Xilinx® ISE® Design Suite PAD file. The I/O Report lists:

• **Pin Number**: All the pins in the device
• **Signal Name**: The name of the user I/O assigned to the pin
• **Pin Usage**: The type of pad or buffer used by the pin
• **Pin Name**: Name of the pin
• **Direction**: Whether the pin is an input, output, inout, or unused
• **I/O Standard**: The I/O standard for the User I/O

An asterisk (*) indicates that it is the default. This differs from the I/O Ports window of the Vivado IDE.

• **I/O Bank Number**: The I/O Bank where the pin is located
• **Drive (mA)**: The drive strength in milliamps
• **Slew Rate**: The Slew Rate configuration of the buffer: Fast or Slow
• **Termination**: The off chip termination settings
• **IOB Delay**: Delay value set for this pin
• **Voltage**: The values for various pins, including VCCO, VCCAUX, and related pins
• **Constraint**: Displays Fixed if the pin has been constrained by the user
• **IOB Sequential Element**: The flip flops packed into the I/O Bank next to the given port
• **Signal Integrity**: The Signal Integrity of the pin

Report Clock Utilization

The Clock Utilization Report helps you analyze the utilization of clock resources inside the device. It can be useful for debugging clock placement issues. The Clock Utilization Report displays:

• The number of clocking primitives available, occupied, and constrained
• Loading and skew per BUFG
  Look for nets with large maxdelay and skew.
• Loading and skew per MMCM
  Look for nets with unexpected loading, large maxdelay, and skew.
Regional Clocks

Regional clock networks are clock networks independent of the global clock network. Unlike global clocks, the span of a regional clock signal (BUFR) is limited to one clock region. One I/O clock signal drives a single bank.

These networks are especially useful for source-synchronous interface designs. The I/O banks in Xilinx 7 series FPGA devices are the same size as a clock region.

Local Clocks

Local clocks are clock networks routed onto general routing resources.

**RECOMMENDED:** Avoid local clocks where possible. They can experience very large clock skew, and are more susceptible to PVT variations. The tools may route the clock differently each time you rerun implementation.

The Locked column for the clocking resources shows whether you placed the clock, or whether the tools are free to place the clocking resource.

If there are too many global clocks, consider moving low fanout global clocks to other clocking resources, such as BUFH or BUFR.

Report Control Sets

A control set is the unique combination of a clock signal, a clock enable signal, and a set/reset signal. Each slice supports at most one control set which any flip flop located in it can use. Flip flops with different control sets cannot be placed in the same slice.

The Control Sets Report lists the number of unique control sets in the design. Based on the placement of the designs, the tool displays the minimum number of register sites lost to the control set packing.

- **Clock Signal:** The logical clock signal name
- **Enable Signal:** The logical clock enable signal name
- **Set/Reset Signal:** The logical set/reset signal name
- **Slice Load Count:** The number of unique slices that contain cells connected to the control set
- **BEL Load Count:** The number of cells connected to the control set
Chapter 4: Viewing Reports and Messages

Report DRC

The DRC Report is generated by the router. Before the router runs, the tool checks for a common set of design issues. The report lists the checks used in the run.

**IMPORTANT:** Review the Critical Warnings. The severity of a particular check may be increased later in the flow.

Report DRC runs common Design Rule checks to look for common design issues and errors.

Elaborated Design

The tool checks for DRCs related to I/O, Clock Placement, potential coding issues with your HDL, and XDC constraints. The RTL netlist typically does not have all the I/O Buffers, Clock Buffers, and other primitives the post synthesis designs have. Elaborated Design DRCs do not check for as many errors as later DRCs.

Synthesized Design and Implemented Design

- Checks for DRCs related to the post synthesis netlist.
- Checks for I/O, BUFG, and other placement.
- Basic checks on the attributes wiring on MGTs, IODELAYs, and other primitives.
- The same DRCs run taking into account any available placement and routing.
- DRCs have four severities: Info, Warning, Critical Warning, and Error. Critical Warnings and Errors do not block the design flow at this point.

Steps of the implementation flow also run the DRCs, which can stop the flow at critical points. The placer and router check for issues that block placement. Certain messages have a lower severity depending on the stage. These are DRCs flagging conditions that do not stop `opt_design`, `place_design`, or `route_design` from completing, but which can lead to issues on the board.

For example, some DRCs check that the user has manually constrained the package pin location and the I/O standard for all design ports. If some of these constraints are missing, `place_design` and `route_design` issue critical warnings. However, these DRCs appear as an ERROR in `write_bitstream`. The tools will not program a part without these constraints.

The decreased severity earlier in the flow allows you to run the design through implementation iterations before the final pinout has been determined. You must run bitstream generation for a comprehensive DRC signoff.
Figure 4-4 shows the Vivado IDE graphical user interface form of Report DRC.

Click a DRC to open the properties for a detailed version of the message. Look in the Properties window to view the details. Most messages have a hyperlink for nets, cells, and ports referenced in the DRC.

The DRC report is static. You must rerun Report DRC for the report to reflect design changes. The tool determines that the links are stale after certain design operations (such as deleting objects and moving objects), and invalidates the links.

Selecting an object from the hyperlink selects the object, but does not refresh the Properties window. To display the properties for the object, unselect and reselect it.

To create a DRC report in Tcl, run the command `report_drc`.

To write the results to a file, run the command `report_drc -file myDRCs.txt`.

**TIP:** For more information on `report_drc`, run `report_drc -help`. 
### Report Route Status

The Route Status Report is generated during the implementation flow and is available by using the `report_route_status` Tcl command.

The Route Status Report displays a breakdown of the nets in the design as follows:

- The total number of logical nets in the design
  - The number of nets that do not need routing resources
    - The number of nets that do not use routing resources outside of a tile. Examples include nets inside of a CLB, BlockRam, or I/O Pad.
    - The number of Nets without loads, if any exist
  - The number of routable nets that require routing resources
    - The number of unrouted nets, if any exist
    - The number of fully routed nets
  - The number of nets with routing errors
    - The number of nets with some unrouted pins, if any exist
    - The number of nets with antennas/islands, if any exist
    - The number of nets with resource conflicts, if any exist

The following is an example of the Report Route Status for a fully routed design:

```
Design Route Status
------------------------------------------- : ----------- :
# of logical nets......................... : 6137 :
  # of nets not needing routing......... : 993 :
    # of internally routed nets...... : 993 :
  # of routable nets................... : 5144 :
    # of fully routed nets.......... : 5144 :
    # of nets with routing errors... : 0 :
```

Send Feedback
Report Noise

The Report Noise command performs the Simultaneous Switching Noise (SSN) calculation for Xilinx 7 series FPGA devices. By default, the SSN report opens in a new tab in the Noise window area of the Vivado IDE. You can export the results to a CSV or HTML file.

The Noise Report has four sections:

- Noise Report Summary Section
- Noise Report Messages Section
- Noise Report I/O Bank Details Section
- Noise Report Links Section

Noise Report Summary Section

The Summary section of the Noise Report includes:

- When the report ran
- Number and percentage of applicable ports analyzed
- Status, including whether it passed
- Number of Critical Warnings, Warnings, and Info messages

Noise Report Messages Section

The Messages section of the Noise Report includes a detailed list of the messages generated during the report.
Noise Report I/O Bank Details Section

The I/O Bank Details section of the Noise Report includes a list of Pins, Standards, and Remaining Margin.

Noise Report Links Section

The Links section of the Noise Report contains links to documentation located online at www.xilinx.com/support.

To create an HTML version of the report, select the option or run the following Tcl command:

```
report_ssn -format html -file myImplementedDesignSSN.html
```

Report Power

The Power Report is generated after routing to report details of power consumption based on the current operating conditions of the device, and the switching rates of the design. Power analysis requires a synthesized netlist, or a placed and routed design.

- Use the `set_operating_conditions` command to set operating conditions.
- Use the `set_default_switching_activity` command to define switching activity.

The Report Power command is available when a Synthesized Design or an Implemented Design is open.
The Power Report estimates power consumption based on design inputs, including:

- Thermal statistics, such as junction and ambient temperature values.

  **Note:** You can set the junction temperature using the `-junction_temp` option of the `set_operating_condition` command. If you do not specify the temperature, the software computes it for you based on your design inputs.

- Data on board selection, including number of board layers and board temperature.
- Data on the selection of airflow and the head sink profile used by the design.
- Reporting the FPGA device current requirements from the different power supply sources.
- Allowing detailed power distribution analysis to guide power saving strategies and to reduce dynamic, thermal or off-chip power.
- Simulation activity files can be used to make power estimation more accurate.
Chapter 4: Viewing Reports and Messages

Analyzing the Power Report

Use the Report Power dialog box (Figure 4-8, page 108) to analyze power based on:

- Settings
- Power total
- Hierarchy
- Voltage rail
- Block type

For more information on the power report and analyzing the results, see the Vivado Design Suite User Guide: Power Analysis and Optimization (UG907) [Ref 8].

A text version of the power report is generated by default after route during the implementation process.

Reporting Power in a Non-Project Flow

In the non-project flow, report_power is available after link_design or synth_design. The report generated uses the available placement and routing to give more accurate power numbers. To generate this report from the Tcl Console or a script, run report_power.
Chapter 4: Viewing Reports and Messages

Report Design Analysis

The Design Analysis report provides information on timing path characteristics, design interconnect complexity, and congestion. You can use this information to make design or constraint changes that will improve QoR and possibly alleviate routing congestion.

Running Report Design Analysis

You can only run Report Design Analysis from the Tcl Console using the `report_design_analysis` Tcl command. Report Design Analysis generates three categories of reports:

- **Timing Path Characteristics**: Reports timing and physical characteristics of timing paths
- **Complexity**: Analyzes the design for routing complexity and LUT distribution
- **Congestion**: Analyzes the design for routing congestion

By default, only the timing paths reports are generated. When specifying only options related to one category, only the reports of this category are generated. You can generate multiple categories of reports at once by specifying options that affect each desired category or by directly specifying the category switches `-timing/-complexity/-congestion`.

Timing Path Characteristics Reports

The Tcl Options for running Report Design Analysis in Timing Mode to generate the Timing Path Characteristics reports are as follows:

- `-timing`: Specifies to run `report_design_analysis` in timing mode. This is the default analysis mode when no other option is used.
- `-setup/-hold`: Limits the analysis to setup or hold paths only. This option can be used with `-max_paths` to increase the scope of the report.
- `-max_paths <arg>`: Specifies the number of worst paths to report. The default is 1. This option cannot be used with `-of_timing_paths`.
- `-of_timing_paths <args>`: Performs the analysis on the specified list of timing path objects. Timing path objects must be queried using the `get_timing_paths` command, which provides more filtering capability. For more information about `get_timing_paths`, refer to the *Vivado Design Suite Tcl Command Reference Guide* (UG835) [Ref 3].
- `-extend`: Performs an extended analysis for each path of interest by also reporting the worst path to the startpoint and the worst path from the endpoint.
Analyzing the Worst Timing Path

Figure 4-10 shows an example of how to run the Report Design Analysis in Timing Mode to show the Path Characteristics of only the Single Worst Setup path in the design.

Tcl Command:

```
report_design_analysis
```

Report Design Analysis also provides a Logic Level Distribution table for the worst 5000 timing paths on a per-endpoint clock basis when the `-of_timing_paths` option is not used. An example of the Logic Level Distribution table is shown in Figure 4-11.
Analyzing a Specific Path using the -of_timing_paths Option

Figure 4-12 shows an example report from Report Design Analysis in Timing Mode using the -of_timing_paths option. In this case, the Path Characteristics and the Logic Level Distribution tables are limited to the specified path.

Note: You can report N paths by changing the options of the get_timing_paths command.

Tcl Command:

```
report_design_analysis -of_timing_paths [get_timing_paths \
  -from [get_pins usbEngine1/u4/inta_reg/C] \n  -to [get_pins cpuEngine/or1200_cpu/or1200_except/ex_exceptflags_reg[1]/D]]
```
Chapter 4: Viewing Reports and Messages

Analyzing the Worst Path along with Preceding and Following Worst Paths

Figure 4-13, page 114 and Figure 4-14, page 115 show an example report from Report Design Analysis in Timing Mode using the \texttt{-extend} option for respectively setup and hold analysis. The Path Characteristics are reported on the worst setup path along with the worst setup path to the startpoint cell ("WorstPath to Src") and the worst setup path from the endpoint cell ("WorstPath from Dst"). By default, the same report is also generated for the worst hold path. The \texttt{-extend} option incurs higher runtime as several timing analyses are required to collect the characteristics of all reported paths.

Tcl Command: \texttt{report\_design\_analysis \texttt{-extend}}
**Chapter 4: Viewing Reports and Messages**

**Figure 4-13:** Extended Path Characteristics of the Worst Setup Path

<table>
<thead>
<tr>
<th>Characteristics</th>
<th>WorstPath to Ref</th>
<th>Path #1</th>
<th>WorstPath from Ref</th>
</tr>
</thead>
<tbody>
<tr>
<td>PATH_TYPE</td>
<td>SETUP</td>
<td>SETUP</td>
<td>SETUP</td>
</tr>
<tr>
<td>REQUIREMENT</td>
<td>10.000</td>
<td>16.000</td>
<td>16.000</td>
</tr>
<tr>
<td>PATH_DELAY</td>
<td>1.308</td>
<td>1.985</td>
<td>1.943</td>
</tr>
<tr>
<td>LOGIC_DELAY</td>
<td>0.559(49%)</td>
<td>9.223(35%)</td>
<td>1.600(35%)</td>
</tr>
<tr>
<td>NET_DELAY</td>
<td>0.740(75%)</td>
<td>8.682(75%)</td>
<td>1.315(75%)</td>
</tr>
<tr>
<td>CLOCK skew</td>
<td>-1.520</td>
<td>-6.300</td>
<td>-0.122</td>
</tr>
<tr>
<td>SLACK</td>
<td>9.970</td>
<td>6.178</td>
<td>7.895</td>
</tr>
<tr>
<td>CLOCK RELATIONSHIP</td>
<td>Safely Timed</td>
<td>Safely Timed</td>
<td>Safely Timed</td>
</tr>
<tr>
<td>TIMING EXCEPTION</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LOGIC LEVELS</td>
<td>1</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>LOCAL PATH</td>
<td>DROP WRE</td>
<td>FREE JKE</td>
<td>FREE IUEC LUCO RNP</td>
</tr>
<tr>
<td>STARTPOINT CLOCK</td>
<td>async</td>
<td>async 4</td>
<td>async 4</td>
</tr>
<tr>
<td>ENDPOINT CLOCK</td>
<td>async 0</td>
<td>async 0</td>
<td>async 0</td>
</tr>
<tr>
<td>STARTPOINT_PIN</td>
<td>reset</td>
<td>PMGC</td>
<td>PMGC</td>
</tr>
<tr>
<td>ENDPOINT_PIN</td>
<td>FMCQ/D</td>
<td>FMCQ/JFR</td>
<td>FMCQ/FDR</td>
</tr>
<tr>
<td>COND_DSP</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>DGA_RES</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>DSP_RES</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>MRES</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>PLLS</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>GND CROSSINGS</td>
<td>0</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>DSP CROSSINGS</td>
<td>0</td>
<td>3</td>
<td>0</td>
</tr>
<tr>
<td>IO CROSSINGS</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>CONFIG CROSSINGS</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>SLIC CROSSINGS</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>BUFFERING BOX SIZE</td>
<td>0% x 1%</td>
<td>25% x 29%</td>
<td>0% x 2%</td>
</tr>
<tr>
<td>CLOCK REGION DISTANCE</td>
<td>(0, 0)</td>
<td>(0, 2)</td>
<td>(0, 1)</td>
</tr>
<tr>
<td>PLLS</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>HIGH PAMUT</td>
<td>146</td>
<td>10259</td>
<td>2</td>
</tr>
<tr>
<td>CONCURRENT PAMUT</td>
<td>146</td>
<td>10259</td>
<td>5</td>
</tr>
<tr>
<td>DONT TOUCH</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>MASK_DEBUG</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>FIXED_LOC</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>FIXED_ROUTE</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>MOLD_FIXPLICATE</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>COMPLETED_LUT_PAIRS</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
Chapter 4: Viewing Reports and Messages

Analyzing Multiple Paths Simultaneously

Report Design Analysis provides the ability to analyze multiple timing paths simultaneously. This capability can be extremely useful when used in conjunction with the \texttt{get\_timing\_paths} command to limit the scope of \texttt{report\_design\_analysis} to specific paths. Figure 4-15, page 116 shows an example of reporting the five worst setup paths launched by clock \texttt{wbClk} and captured by clock \texttt{fftClk\_0}. The report lists each of the five timing paths in a row, and the path characteristics are listed across the columns.

\textbf{Tcl Command:}

\begin{verbatim}
\end{verbatim}
Chapter 4: Viewing Reports and Messages

Reading and Interpreting Timing Path Characteristics Reports

The path characteristics fall into four main categories. You can find the definition of each characteristics in the command long help.

Tcl Command: report_design_analysis -help

Alternatively, you can find the same information in the Vivado Design Suite Tcl Command Reference Guide (UG835) [Ref 3].

1. Timing Category

- **Timing Analysis**: The PATH_TYPE and REQUIREMENT detail the timing analysis type (setup or hold) along with the timing path requirement. The SLACK indicates whether or not the timing path requirement is met based on the timing analysis as dictated by the timing constraints. The TIMING_EXCEPTION indicates if any timing exceptions such as multicycle path or max delay have been applied to the timing path.

Checking the path requirement is often the first step in debugging missing or incorrect timing constraints:

- Paths with setup requirement under 4ns must be reviewed to verify their validity in the design, especially for clock domain crossing paths.
- Paths with setup requirement under 2ns are difficult to meet and must be avoided in general, especially for the older architectures.
- In general, when small setup requirements are present, check for missing timing exception constraints and also check the source and destination clock edges. The timing analysis always assumes the smallest positive difference between source and destination clock edges unless overridden by a timing exception constraint.
- Positive hold path requirements need to be reviewed as they are not common and are difficult to meet. When positive hold path requirements are present, check for missing multicycle path constraints for hold analysis that might have only been applied to the path for setup analysis. Also check the relationship between source and destination clocks for correctness.

![Figure 4-15: Path Characteristics of 5 Worst Setup Paths from wbClk_4 to fftClk_0](image-url)
Chapter 4: Viewing Reports and Messages

- **Datapath**: The `PATH_DELAY`, `LOGIC_DELAY`, and `NET_DELAY` detail the total datapath delay along with its breakdown into delay contribution by logic cells and nets.
  - If the `LOGIC_DELAY` makes up an unusually high proportion of the total datapath delay, for example 50% or higher, it is advised to examine the datapath logic depth and types of cells on the logic path, and possibly modify the RTL or synthesis options to reduce the path depth or use cells with faster delays.
  - If the `NET_DELAY` dominates the total path delay for a setup path where the `REQUIREMENT` is reasonable, it is advised to analyze some of the physical characteristics and property characteristics of the path listed in this section. Specific items to look at include the `HIGH_FANOUT` and `CUMULATIVE_FANOUT` characteristics to understand if some nets of the path have a high fanout that could potentially be causing a placement problem. Also check the `HOLD_FIX_DETOUR` characteristic to understand if hold fixing has occurred on the path (this characteristic is only updated when `report_design_analysis` is run in the same session as `route_design`, and not after loading a post-route checkpoint).

**IMPORTANT**: The LUT input pins have different delay characteristics. The physical pins (or site pins) of higher index are faster than the pins of lower index. Be aware of the difference in 7 Series and UltraScale device LUT delay reporting. In 7 Series devices, the variable portion of LUT delay is reported as part of the net delay in front of the LUT. In UltraScale devices, the variable portion of LUT delay is reported as logic delay. Therefore, the 7 Series device `NET_DELAY/LOGIC_DELAY` ratio will be larger than the ratio for UltraScale devices.

- **Clocks**: The `STARTPOINT_CLOCK`, `ENDPOINT_CLOCK`, `CLOCK_RELATIONSHIP`, and `CLOCK_SKEW` detail information regarding the timing path clocks. The `STARTPOINT_CLOCK` and `ENDPOINT_CLOCK` list the respective source clock and destination clock for the timing path.
  - Check that the `CLOCK_RELATIONSHIP` is correct and expected. For intra-clock paths or synchronous clock domain crossing paths, the relationship is labelled as "Safely Timed." You must verify that the `REQUIREMENT` and `CLOCK_SKEW` are reasonable. For asynchronous clocks, the relationship is labelled as "No Common Primary Clock" or "No Common Period." Asynchronous clock domain crossing paths must be covered by timing exceptions (check the `TIMING_EXCEPTION` value).
  - Check that the `CLOCK_SKEW` is reasonable. When analyzing clock skew, check the clock tree structure for cascaded clock buffers. In 7 Series devices, check for different clock buffer types for the source and destination clocks. In UltraScale devices, it might be necessary to examine the placement and routing of the clock nets because it depends on logic loads placement. The crossing of a Clock Region boundary or an I/O Column can result in higher clock skew; this is expected.

Note that almost all of the Timing Characteristics provided by `report_design_analysis` are available in a timing report.
Chapter 4: Viewing Reports and Messages

2. Logic Category

- **Path:** The STARTPOINT_PIN, ENDPOINT_PIN, LOGIC_LEVELS, LOGICAL_PATH, and COMB_DSP logic characteristics provide some basic information about the timing path.
  - The STARTPOINT_PIN and ENDPOINT_PIN are the reference pin names of the timing path startpoint and endpoint. Check that the STARTPOINT_PIN and ENDPOINT_PIN are expected timing path startpoint and endpoints.
  
  Check for endpoint pins such as CLR, PRE, RST, and CE that could potentially be part of high-fanout nets for control signals such as asynchronous resets and clock enable signals. Also check the type of cell, because some primitives like block RAMs and DSPs have larger Clock-to-Q delay and setup/hold requirements than other cells. Their presence in the path can potentially consume a significant portion of the path timing budget.
  
  - The LOGIC_LEVELS and LOGICAL_PATH detail the number of logic levels and the types of primitives in the datapath. You can use this information to quickly check if a high number of logic levels is mostly due to LUTs or to a mix of LUT/CARRY/MUXF cells. CARRY and MUXF cells are usually connected to nets with dedicated routes that have null or very small delays, while LUT inputs always need to be routed through the fabric.
  
  When the path mostly contains LUTs, it is also important to check their size. Try to understand why there are several smaller LUTs (non-LUT6) that are chained and what prevents synthesis from targeting LUT6 only, which can reduce the logic levels. There can be properties like KEEP/DONT_TOUCH/MARK_DEBUG or mid-to-high fanout nets in the path that also impact mapping efficiency.
  
  Based on the outcome of your analysis, you can either modify the RTL source, add/modify attributes in the RTL, or use different synthesis settings to reduce the number of LUTs on the path. Also, you can use the option -remap of the opt_design command to re-optimize LUT mapping and possibly eliminate some smaller LUTs.
  
  - The COMB_DSP details the number of DSPs used as combinatorial logic that are part of the datapath.

- **Cells:** DOA_REG, DOB_REG, MREG, PREG correspond to Block RAMs and DSPs optional register properties. Timing is more difficult to meet on paths from RAMBs or DSPs with no output registers and with several logic levels. You should consider modifying your design to use the RAMB or DSP output registers if these paths are having difficulty meeting the timing requirements.
3. Physical Category

- **Architectural Boundary Crossings**: The `BRAM_CROSSINGS`, `DSP_CROSSINGS`, `IO_CROSSINGS`, `CONFIG_CROSSINGS`, and `SLR_CROSSINGS` identify whether the path is crossing architectural resources such as BRAM columns, DSP columns, IO Columns, CONFIG Block Columns, or SLR boundaries.

The crossing of many architectural columns does not always represent a problem. Check for high net delay or large skew in conjunction with the crossing of many architectural columns. If many architectural column crossings appear to be the cause of timing issues across multiple implementation runs for a particular module, consider minimal floorplanning using Pblocks to reduce the crossings of the architectural column(s) or SLR boundary.

- **Path Placement Restrictions**: PBLOCKS. Excessive floorplanning can sometimes prevent the tool from achieving the optimal results. Paths that cross multiple Pblocks can sometimes experience timing issues.
  - If the path crosses multiple Pblocks, examine the location of the Pblocks and the impact on the timing path placement.
  - If the Pblocks are adjacent, consider creating a single Pblock that is a super-set of each individual Pblock. This could potentially improve timing by being less restrictive on the placer.

If physical requirements dictate that the Pblocks are placed far apart, consider pipelining between the Pblocks to help meet timing requirements.

- **Placement Box**: `BOUNDING_BOX_SIZE`, `CLOCK_REGION_DISTANCE`, `COMBINED_LUT_PAIRS`
  - If the `BOUNDING_BOX_SIZE` or `CLOCK_REGION_DISTANCE` of the timing path is too large, try using directives in `place_design`. In UltraScale devices, be especially aware of the `CLOCK_REGION_DISTANCE` and its possible impact on timing path `CLOCK_SKEW`.

- **Net Fanout and Detour**:
  - `HIGH_FANOUT` shows the highest fanout of all nets in the datapath, and `CUMULATIVE_FANOUT` corresponds to the sum of all datapath net fanouts.

If `HIGH_FANOUT` and `CUMULATIVE_FANOUT` are large, the timing violations are very likely due to the fanout impact on routing and net delay.

If physical optimization was run and did not reduce the fanout, check for `MARK_DEBUG` and `DONT_TOUCH` constraints preventing replication.

If replication is desired on the net prior to implementation, you can use the `MAX_FANOUT` constraint in synthesis, either inside the RTL or in an XDC file. Due to reliance on placement for good timing for high fanout nets, it is usually not...
recommended to have synthesis perform replication and it is best to rely on post-placement physical optimization (`phys_opt_design`) for replication. You can also increase the physical optimization effort to also optimize paths with a small positive slack by using different directives such as `Explore`, `AggressiveExplore`, or `AggressiveFanoutOpt`.

If fanout reduction is desired on a specific net during implementation, you can force the replication using the command `phy_opt_design -force_replication_on_nets <netName>`.

- When the `HOLD_FIX_DETOUR` is asserted, the routing on the datapath was delayed in order to meet the path hold time requirement. If the path is failing setup, check for excessive skew between the Source and Destination clocks. Also check for proper timing constraints between the Source and Destination clocks in case the hold path requirement is positive (it should be zero or negative in most common cases).

Note that `HOLD_FIX_DETOUR` is only available when the router was run in the same session; otherwise, the `HOLD_FIX_DETOUR` always reports 0.

4.Property Category:

- **Lut Combining:** `COMB_LUT_PAIRS` indicates that there are combined LUT pairs present in the path. While combining LUT pairs can improve Timing QoR, it can also restrict the placement solutions and can create congestion due to high pin density. If LUT combining appears to be an issue in the design, it is recommended to disable LUT combining in synthesis by using the `-no_lc` option.

- **Optimization Blocking:** `MARK_DEBUG` and `DONT_TOUCH` can quickly identify whether there are any nets or cells in the path that the tool is not allowed optimize.
  - The default behavior of setting `MARK_DEBUG` is to also set `DONT_TOUCH`. Consider setting `DONT_TOUCH` to `FALSE` to allow for optimization.
  - `DONT_TOUCH` disables optimizations such as cell or net replication. Evaluate the need for `DONT_TOUCH` constraints and remove them if possible. When a net enters a hierarchical cell with `DONT_TOUCH`, the portion of the net inside the hierarchical cell cannot be replicated. If `DONT_TOUCH` is used to prevent logic trimming, check the design for correctness. One simple example would be logic removed due to unconnected outputs.

- **Fixed Placement and Routing:** The `FIXED_LOC`, `FIXED_ROUTE` can quickly identify whether there are any fixed placement or fixed routing constraints that might be impacting the timing path slack.
  - Using cell location constraints can help stabilizing QoR for a difficult design. If timing can no longer be met after modifying the design, you can try removing the placement constraints to give more flexibility to the placer.
- Having fixed routes prevents the router from optimizing the net delays to meet timing. A timing path with locked routing usually shares nets with other paths that can be negatively impacted by this constraint. Use fixed routes only when necessary and when it does not affect interacting paths.

- Always be aware that changes to other physical constraints such as Pblocks might require the fixed cell locations or fixed routes to also be updated.

**Complexity Report**

The complexity report shows the Rent Exponent, Average Fanout, and distribution of the types of leaf cells of the top-level design and/or of hierarchical cells that contain more than 1000 leaf cells. The Rent exponent is the relationship between the number of ports and the number of cells of a netlist partition when recursively partitioning the design with a min-cut algorithm. It is computed with similar algorithms as the ones used by the placer during global placement. Therefore it can provide a good indication of the challenges seen by the placer, especially when the hierarchy of the design matches well the physical partitions found during global placement.

The Rent Exponent is defined by the Rent’s rule:

\[
\begin{align*}
\text{ports} &= \text{constant} \times \text{cells}^\text{Rent} \\
\log(\text{ports}) &= \text{Rent} \times \log(\text{cells}) + \text{constant}
\end{align*}
\]

A design with higher Rent exponent corresponds to a design where the groups of highly connected logic also have strong connectivity with other groups. This usually translates into a higher utilization of global routing resources and an increased routing complexity. The Rent exponent provided in this report is computed on the unplaced and unrouted netlist.

After placement, the Rent exponent of the same design can differ as it is based on physical partitions instead of logical partitions. The post-placement Rent exponent is not reported by the Report Design Analysis command as it is recommended to analyze the congestion reports once the design is placed instead.

Report Design Analysis is run in Complexity Mode as soon as one of the following options is used:

- `-complexity`: Must be specified to run the report design analysis in Complexity Mode,
- `-cells <arg>`: Specifies the hierarchical cells to use when analyzing the complexity,
- `-hierarchical_depth <arg>`: The levels of hierarchy to examine at the top level by default or at the level of the cells specified by the `-cells` option.
Analyzing the Design Complexity at the Top Level

Figure 4-16 shows an example report from Report Design Analysis in Complexity Mode that reports up to one level of hierarchy from the top module.

Tcl Command:

```
report_design_analysis -complexity -hierarchical_depth 1
```

Reading and Interpreting a Complexity Report

The Complexity Characteristics table from the previous example shows the Rent exponent and average fanout for each level of hierarchy below the top level. The typical ranges to consider when reviewing these metrics are the following:

- **Rent exponent**:
  - Between 0.0 and 0.65: The complexity is considered low to normal and does not highlight any potential problems.
  - Between 0.65 and 0.85: The complexity is considered high, especially when the total number of instances is above 100k.
  - Above 0.85: The complexity is very high, and if the number of instances is also high, the design can potentially fail during implementation.

- **Average fanout**:
  - Below 4: It is considered normal.
  - Between 4 and 5: The implementation tools can show difficulty to place the design without congestion. In the case of a SSI device, if the total number of instances is above 100k, the placer can have problems finding a placement solution that fits in 1 SLR or that is spread over 2 SLRs.
  - Above 5: The design can potentially fail during implementation.
Chapter 4: Viewing Reports and Messages

You must treat high Rent exponents and/or high average fanouts for larger modules with higher importance. Smaller modules, especially under 10k total instances, can have higher Rent exponent and average fanout, and yet be simple to place and route successfully. For this reason, the Total Instances column must always be reviewed along with the Rent exponent and average fanout.

The complexity characteristics might not always predict routing congestion. Other factors such as I/O location constraints, floorplanning, and macro primitive location in the target device can limit the placement solution space and introduce congestion. The effect of such constraints is better analyzed by the congestion reports available after placement.

Other items to consider when interpreting the Complexity Characteristics table:

- A higher percentage of LUT6s in a module usually increases the average fanout and potentially the Rent exponent.
- A high number of RAMB and DSPs can increase the Rent exponent because these primitives have a large amount of connectivity.
- The hierarchical instances with higher Rent exponents or higher average fanouts are not always a problem because the placer operates on a flat netlist and can break these instances into easier groups of logic to place. This report provides an indication of where a netlist problem can possibly exist if a module stands out clearly.

When a large module is exhibiting a high Rent exponent and/or average fanout that is causing congestion and timing issues, consider the following actions:

- Reduce the connectivity of the module. Preserving the hierarchy to prevent cross-boundary optimization in synthesis can reduce the use of LUT6s and consequently reduce the netlist density.
- Try to disable LUT combining in synthesis.
- Use a Congestion Strategy during Implementation or SpreadLogic placement directive that can potentially help to relieve congestion. If the design is targeting an SSI Device, consider trying several SSI placement directives.
- Use simple floorplanning at the SLR level for SSI devices, or at the clock region level in general, to keep congested groups of logic separate, or to guide global placement towards a solution similar to a previously found good placement.

Congestion Reports

The Congestion reports show the congested areas of the device and the name of design modules present in these areas. Congestion can potentially lead to timing closure issues if the critical paths are placed inside or next to a congested area.
Analyzing the Design Congestion

In order to run Report Design Analysis in Congestion Mode, the `-congestion` option must be specified on the command line and the design must be placed and/or routed. Running Report Design Analysis with Congestion Mode on an unplaced design results in nothing being reported.

**IMPORTANT:** It is important to note that the Placed Maximum Level Congestion Reporting and Routed Maximum Level Congestion Reporting must be performed in the same Vivado session where their respective `place_design` and `route_design` have been run. Restoring a design from an already placed and/or routed checkpoint will not report this information.

Report Design Analysis produces five congestion tables:

1. Placed Maximum Level Congestion Reporting

   Figure 4-17 shows an example of the Placed Maximum Level Congestion Reporting table. Using this report, you can examine areas of the device defined by the Congestion Window along with the modules residing in that window. The resource usage percentages gives an indication of the types of resources located in the congested area.

   ![Example Placed Maximum Level Congestion Reporting Table](image)

   **Figure 4-17:** Example Placed Maximum Level Congestion Reporting Table

   This table is only available when the placer has been run in the same Vivado session. It reports all the windows with the same maximum congestion level (window size) seen in a particular direction. The various columns are defined as follows:

   - **Direction:** The direction of the congested routing resources (North, South, West, or East)
   - **Window Size:** The Window Size of the congestion in CLB tiles.
   - **Congestion in Window (%):** Indicates the estimated routing resource utilization in the defined window. This value can be greater than 100%.
   - **Congestion Window:** Indicates the bounding CLB tiles where the congestion for the identified Direction is present. The CLB coordinates correspond to the lower left and upper right corners of the window.
Chapter 4: Viewing Reports and Messages

- **Module Names**: Indicates the parent instance that contains the hierarchical cells involved in the Congestion Window, up to the three largest contributors along with their contribution percentage.

- **LUT usage %**: The percentage of LUT utilization in the Window.

- **Flop usage %**: The percentage of FD (including LD) utilization in the Window.

- **RAMB18 usage %**: The percentage of RAMB18 utilization in the Window.

- **RAMB36 usage %**: The percentage of RAMB36 utilization in the Window.

- **DSP usage %**: The percentage of DSP utilization in the Window.

When analyzing the Placed Maximum Level Congestion Reporting Table of your design for Congestion and Timing QoR, look for the following:

- If a high level of LUT usage exists, examine the instances that have a high percentage of LUT6s in the Complexity report.

- In case of high RAMB or DSP utilization in the congested area, check for Pblock constraints that might be limiting the available placement area of the reported modules. Use various targeted placement directives to relieve congestion such as the BlockPlacement or SpreadLogic directives. In some cases, it might be beneficial to reuse the RAMB or DSP placement from a previous run that showed low congestion and resulted in good Timing QoR.

2. **SLR Net Crossing Reporting**

The SLR Net Crossing Reporting is only applicable to SSI Devices and reports the number of nets contained in a module that cross the SLR boundaries. For each module, the table provides further details of which SLRs are crossed by the nets. **Figure 4-18, page 125** shows an example of the SLR Net Crossing Reporting table.
When analyzing the SLR Net Crossing Reporting Table of your design for Congestion and Timing QoR, look for the following:

- When using SSI Devices, the SSI placement directives can be beneficial for both timing and congestion.
- If a particular module that is crossing SLRs is consistently experiencing timing issues across multiple implementation runs using various placement directives, attempt light Pblocking to constrain the module to a single SLR.

3. and 4. Placed Tile Based Congestion Metric (Vertical and Horizontal, respectively)

The Placed Tile Based Congestion Metric reports the 10 CLB tiles with highest congestion, along with the modules that have cells located in the CLB tile. Figure 4-19 and Figure 4-20, page 127 show examples of the Placed Tile Based Congestion Metric for both Vertical and Horizontal routing. Unlike the other Congestion Metrics, generation of this data is not required to be in the same Vivado Session. You can also view this data graphically by selecting Window > Metrics and showing "Vertical/Horizontal routing congestion per CLB" beneath CLB Metrics.
Chapter 4: Viewing Reports and Messages

5. Router Maximum Level Congestion Reporting

The Router Maximum Level Congestion Reporting is only available when the router has been run in the same session and is similar to the Congestion Report in the `route_design` log file.

Figure 4-20: Placed Tile Based Congestion Metric (Horizontal)

- **Tile Name**: The CLB tile where the congestion is occurring.
- **RPMX/RPMY**: The RPM location of the CLB tile in the device.
- **Congestion in Window (%)**: Indicates the percentage of estimated routing resource utilization through the CLB tile. This value can be greater than 100%.
- **Module Names**: Indicates the parent instance that contains the cells involved in the Congestion Window for up to three largest contributors along with their contribution percentage.

Figure 4-21: Example of Router Maximum Level Congestion Reporting Table
Chapter 4: Viewing Reports and Messages

- **Direction**: The Direction of the congestion.

- **Window Size**: The Window Size of the congestion in interconnect tiles. In the Vivado IDE, the interconnect tiles can only be seen in when the routing resources are displayed in the device view.

- **Congestion in Window (%)**: Indicates the percentage of utilized routing resources in the defined window. This value can not exceed 100% on a routed design.

- **Congestion Window (BB)**: Indicates the bounding interconnect tiles of the congestion window.

When analyzing the Router Maximum Level Congestion Reporting table, you should look for the following:

- If the Window Size is greater than 64x64, the design is unlikely to meet timing and might have failed during routing.

- If the Window Size is 16x16 or 32x32 and the congestion reported by the router matches the congestion reported by the placer, you must review the Placed Maximum Level Congestion Reporting table to identify which modules are located in the congested area(s). Then you can apply a congestion alleviation technique on these modules or rerun the placer with different directives, such as SpreadLogic*.

- If the Window Size is 8x8 or smaller, the congestion is probably not a concern unless your design has a very tight timing budget.
Performing Timing Analysis

Introduction to Timing Analysis

The Xilinx® Vivado® Integrated Design Environment (IDE) provides several reporting commands to verify that your design meets all timing constraints and is ready to be loaded on the application board. Report Timing Summary is the timing signoff report, equivalent to TRCE in the ISE® Design Suite. Report Timing Summary provides a comprehensive overview of all the timing checks, and shows enough information to allow you to start analyzing and debugging any timing issue. For more information, see Chapter 1, Logic Analysis Within the IDE.

You can generate this report in a window, write it to a file, or print it in your log file. Whenever Report Timing Summary shows that your design does not meet timing, or is missing some constraints, you can explore the details provided in the various sections of the summary and run more specific analysis. The other timing reports provide more details on a particular situation or to scope the analysis to some logic by using filters.

Before adding timing constraints to your design, you must understand the fundamentals of timing analysis, and the terminology associated with it. This chapter discusses some of key concepts used by the Xilinx® Vivado® Integrated Design Environment (IDE) timing engine.

Terminology

- The launch edge is the active edge of the source clock that launches the data.
- The capture edge is the active edge on the destination clock that captures the data.
- The source clock is also referred to as the launch clock.
- The destination clock is also referred to as the capture clock.
- The setup requirement is the relationship between the launch edge and the capture edge that defines the most restrictive setup constraint.
- The setup relationship is the setup check verified by the timing analysis tool.
- The hold requirement is the relationship between the launch edge and capture edge that defines the most restrictive hold constraint.
- The hold relationship is the hold check verified by the timing analysis tool.
Timing Paths

Timing paths are defined by the connectivity between the instances of the design. In digital designs, timing paths are formed by a pair of sequential elements controlled by the same clock, or by two different clocks.

Common Timing Paths

The most common paths in any design are:

- Path from Input Port to Internal Sequential Cell
- Internal Path from Sequential Cell to Sequential Cell
- Path from Internal Sequential Cell to Output Port
- Path from Input Port to Output Port

Path from Input Port to Internal Sequential Cell

In a path from an input port to a sequential cell, the data:

- Is launched outside the device by a clock on the board.
- Reaches the device port after a delay called the input delay [Synopsys Design Constraints (SDC) definition].
- Propagates through the device internal logic before reaching a sequential cell clocked by the destination clock.

Internal Path from Sequential Cell to Sequential Cell

In an internal path from sequential cell to sequential cell, the data:

- Is launched inside the device by a sequential cell, which is clocked by the source clock.
- Propagates through some internal logic before reaching a sequential cell clocked by the destination clock.

Path from Internal Sequential Cell to Output Port

In a path from an internal sequential cell to an output port the data:

- Is launched inside the device by a sequential cell, which is clocked by the source clock.
- Propagates through some internal logic before reaching the output port.
- Is captured by a clock on the board after an additional delay called the output delay (SDC definition).
Path from Input Port to Output Port

In a path from an input port to output port, the data traverses the device without being latched. This type of path is also commonly called an in-to-out path. The input and output delays reference clock can be a virtual clock or a design clock.

Timing Paths Example

Figure 5-1, Timing Paths Example, shows the paths described above. In this example, the design clock CLK0 can be used as the board clock for both DIN and DOUT delay constraints.

Figure 5-1: Timing Paths Example

Timing Path Sections

Each timing path is composed of three sections:

- Source Clock Path
- Data Path
- Destination Clock Path

Source Clock Path

The source clock path is the path followed by the source clock from its source point (typically an input port) to the clock pin of the launching sequential cell. For a timing path starting from an input port, there is no source clock path.

Data Path

The data path is the section of the timing path where the data propagates, between the path startpoint and the path endpoint. The following definitions apply: (1) A path startpoint is a sequential cell clock pin or a data input port; and (2) A path endpoint is a sequential cell data input pin or a data output port.
Destination Clock Path

The destination clock path is the path followed by the destination clock from its source point, typically an input port, to the clock pin of the capturing sequential cell. For a timing path ending at an output port, there is no destination clock path. Figure 5-2 shows the three sections of a typical timing path.

Launch and Capture Edges

When transferring between sequential cells or ports, the data is:

- Launched by one of the edges of the source clock, which is called the launch edge.
- Captured by one of the edges of the destination clock, which is called the capture edge.

In a typical timing path, the data is transferred between two sequential cells within one clock period. In that case: (1) the launch edge occurs at 0ns; and (2) the capture edge occurs one period after.

The following section explains how the launch and capture edges define the setup and hold relationships used for timing analysis.
Understanding the Basics of Timing Analysis

Max and Min Delay Analysis

Timing analysis is the static verification that a design timing behavior will be predictable once loaded and run on hardware. It considers a range of manufacturing and environmental variations that are combined into delay models that are grouped by timing corners and corner variations. It is sufficient to analyze timing against all the recommended corners, and for each corner, to perform all the checks under the most pessimistic conditions. For example, a design targeted to a Xilinx FPGA device must pass the four following analyses:

- Max delay analysis in Slow Corner
- Min delay analysis in Slow Corner
- Max delay analysis in Fast Corner
- Min delay analysis in Fast Corner

Depending on the check performed, the delays that represent the most pessimistic situation are used. This is the reason why the following checks and delay types are always associated:

- Max delay with setup and recovery checks
- Min delay with hold and removal checks

Max delay with setup and recovery checks

- The slowest delays of a given corner are used for the source clock path and data/reset path accumulated delay.
- The fastest delays of the same corner are used for the destination clock path accumulated delay.

Min delay with hold and removal checks

- The fastest delays of a given corner are used for the source clock path and data/reset path accumulated delay.
- The slowest delays of the same corner are used for the destination clock path accumulated delay.

When mapped to the various corners, these checks become:

- setup/recovery (max delay analysis)
- hold/removal (min delay analysis)
Chapter 5: Performing Timing Analysis

**setup/recovery** (max delay analysis)
- source clock (Slow_max), datapath (Slow_max), destination clock (Slow_min)
- source clock (Fast_max), datapath (Fast_max), destination clock (Fast_min)

**hold/removal** (min delay analysis)
- source clock (Slow_min), datapath (Slow_min), destination clock (Slow_max)
- source clock (Fast_min), datapath (Fast_min), destination clock (Fast_max)

Delays from different corners are never mixed on a same path for slack computation.

Most often, setup or recovery violations occur with Slow corner delays, and hold or removal violations occur with Fast corner delays. However, since this is not always true (especially for I/O timing) Xilinx recommends that you perform both analyses on both corners.

**Setup/Recovery Relationship**

The setup check is performed only on the most pessimistic setup relationship between two clocks. By default, this corresponds to the smallest positive delta between the launch and capture edges. For example, consider a path between two flip-flops that are sensitive to the rising edge of their respective clock. The launch and capture edges of this path are the clock rising edges only.

The clocks are defined as follows:
- clk0 has a period of 6ns with first rising @ 0ns and falling edge @ 3ns.
- clk1 has a period of 4ns with first rising @ 0ns and falling edge @ 2ns.

As Figure 5-3, Setup Relationships, shows, there are two unique setup relationships: Setup(1) and Setup(2).

![Figure 5-3: Setup Relationships](image-url)
The smallest positive delta from $clk_0$ to $clk_1$ is 2 ns, which corresponds to Setup(2). The Common Period is 12 ns, which corresponds to the time between two simultaneous alignments of the two clocks.

**TIP:** The relationships are established when considering the ideal clock waveforms, that is, before applying the insertion delay from the clock root to the flip-flop clock pin.

**IMPORTANT:** If the common period cannot be found over 1000 cycles of both clocks, the worst setup relationship over these 1000 cycles is used for timing analysis. For such case, the two clocks are called unexpandable, or clocks with no common period. The analysis will likely not correspond to the most pessimistic scenario. You must review the paths between these clocks to assess their validity and determine if they can be treated as asynchronous paths instead.

Once the path requirement is known, the path delays, the clocks uncertainty and the setup time are introduced to compute the slack. The typical slack equation is:

\[
\text{Data Required Time (setup)} = \text{capture edge time} + \text{destination clock path delay} - \text{clock uncertainty} - \text{setup time}
\]

\[
\text{Data Arrival Time (setup)} = \text{launch edge time} + \text{source clock path delay} + \text{datapath delay}
\]

\[
\text{Slack (setup)} = \text{Data Required Time - Data Arrival Time}
\]

As the equation shows, a positive setup slack occurs when the data arrives before the required time.

The recovery check is similar to the setup check, except that it applies to asynchronous pins such as preset or clear. The relationships are established the same way as for setup, and the slack equation is the same except that the recovery time is used instead of the setup time.

**Hold/Removal Relationship**

The hold check (also called hold relationship) is directly connected to the setup relationship. While the setup analysis ensures that data can safely be captured under the most pessimistic scenario, the hold relationship ensures that:

- The data sent by the setup launch edge cannot be captured by the active edge before the setup capture edge (H1a and H2a corresponding to setup edges S1 and S2 respectively in Figure 5-4, Hold Relationships per Setup Relationship).
- The data sent by the next active source clock edge after the setup launch edge cannot be captured by the setup capture edge (H2a and H2b corresponding to setup edges S1 and S2 respectively in Figure 5-4, Hold Relationships per Setup Relationship).
During hold analysis, the timing engine reports only the most pessimistic hold relationship between any two clocks. The most pessimistic hold relationship is not always associated with the worst setup relationship. The timing engine must review all possible setup relationships and their corresponding hold relationships to identify the most pessimistic hold relationship.

For example, consider the same path as in the setup relationship example. Two unique setup relationships exist.

Figure 5-4, Hold Relationships per Setup Relationship, illustrates the two hold relationships per setup relationship.

![Figure 5-4: Hold Relationships per Setup Relationship](image)

The greatest hold requirement is 0ns, which corresponds to the first rising edge of both source and destination clocks.

Once the path requirement is known, the path delays, the clocks’ uncertainty, and the hold time are introduced to compute the slack. The typical slack equation is:

\[
\text{Data Required Time (hold)} = \text{capture edge time} + \text{destination clock path delay} - \text{clock uncertainty} + \text{hold time}
\]

\[
\text{Data Arrival Time (hold)} = \text{launch edge time} + \text{source clock path delay} + \text{datapath delay}
\]

\[
\text{Slack (hold)} = \text{Data Arrival Time} - \text{Data Required Time}
\]

As the equation shows, the hold slack is positive when the new data arrives after the required time.

The removal check is similar to the hold check, except that it applies to asynchronous pins such as preset or clear. The relationships are established the same way as for hold, and the slack equation is the same except that the removal time is used instead of the hold time.
**Path Requirement**

The path requirement represents the difference in time between the *capture edge* and the *launch edge* of a timing path.

For example, when considering the same path and clocks as in the previous section, the following path requirements exist:

\[
\text{Setup Path Requirement (S1)} = 1 \cdot T(\text{clk1}) - 0 \cdot T(\text{clk0}) = 4\text{ns}
\]
\[
\text{Setup Path Requirement (S2)} = 2 \cdot T(\text{clk1}) - 1 \cdot T(\text{clk0}) = 2\text{ns}
\]

The corresponding hold relationships are:

- **Corresponding to setup S1**
  
  \[
  \text{Hold Path Requirement (H1a)} = (1-1) \cdot T(\text{clk1}) - 0 \cdot T(\text{clk0}) = 0\text{ns}
  \]
  \[
  \text{Hold Path Requirement (H1b)} = 1 \cdot T(\text{clk1}) - (0+1) \cdot T(\text{clk0}) = -2\text{ns}
  \]

- **Corresponding to setup S2**
  
  \[
  \text{Hold Path Requirement (H2a)} = (2-1) \cdot T(\text{clk1}) - 1 \cdot T(\text{clk0}) = -2\text{ns}
  \]
  \[
  \text{Hold Path Requirement (H2b)} = 2 \cdot T(\text{clk1}) - (1+1) \cdot T(\text{clk0}) = -4\text{ns}
  \]

The timing analysis is performed only with the two most pessimistic requirements. In the example above, these are:

- The setup requirement S2
- The hold requirement H1a

**Clock Skew and Uncertainty**

Skew and uncertainty both impact setup and hold computations and slack.

**Skew Definition**

Clock skew is the insertion delay difference between the destination clock path and the source clock path: (1) from their common point in the design; (2) to, respectively, the endpoint and startpoint sequential cell clock pins.

In the equation below:

- \(T_{cj}\) is the delay from the common node to the endpoint clock pin.
- \(T_{ci}\) is the delay from the common node to the startpoint clock pin:

\[
T_{skew,i,j} = T_{ci} - T_{cj}
\]
Clock Pessimism Removal

A typical timing path report shows the delay details of both source and destination clock paths, from their root to the sequential cell clock pins. As explained in Min and Max Delay Analyses, the source and destination clocks are analyzed with a different delay, even on their common circuitry.

Clock Pessimism Removal (CPR) = common clock circuitry (max delay - min delay)

The CPR is added or subtracted to the skew depending on the type of analysis performed:

- **Max Delay Analysis (Setup/Recovery)**
  
  CPR is *added to* the destination clock path delay.

- **Min Delay Analysis (Hold/Removal)**
  
  CPR is *subtracted from* the destination clock path delay.

The Vivado Design Suite timing reports clock skew for each timing path as shown below (hold analysis in this case):

- DCD - Destination Clock Delay
- SCD - Source Clock Delay
- CPR - Clock Pessimism Removal

Clock Path Skew: 0.301ns (DCD - SCD - CPR)
Destination Clock Delay (DCD): 2.581ns
Source Clock Delay (SCD): 2.133ns
Clock Pessimism Removal (CPR): 0.147ns
In many cases, the CPR accuracy changes before and after routing. For example, let’s consider a timing path where the source and destination clocks are the same clock, and the startpoint and endpoint clock pins are driven by the same clock buffer.

Before routing, the common point is the clock net driver, that is, the clock buffer output pin. CPR compensates only for the pessimism from the clock root to the clock buffer output pin.

After routing, the common point is the last routing resource shared by the source and destination clock paths in the device architecture. This common point is not represented in the netlist, so the corresponding CPR cannot be directly retrieved by subtracting common clock circuitry delay difference from the timing report. The timing engine computes the CPR value based on device information not directly exposed to the user.

**Optimistic Skew**

Xilinx FPGA devices provide advanced clocking resources such as dedicated clock routing trees and Clock Modifying Blocks (CMB). Some of the CMBs have the capability to compensate the clock tree insertion delay by using a Phase Lock Loop circuit (present in PLL or MMCM primitives). The amount of compensation is based on the insertion delay present on the feedback loop of the PLL. In many cases, a PLL (or MMCM) drives several clock trees with the same type of buffer, including on the feedback loop. As the device can be large, the insertion delay on all these clock tree branches does not always match the feedback loop delay. The clocks driven by a PLL become over-compensated when the feedback loop delay is bigger than the source or destination clock delay. In this case, the sign of the CPR changes and it effectively removes skew optimism from the slack value. This is needed in order to ensure that there is no artificial skew at the common node of any timing path clocks during the analysis.

**RECOMMENDED:** Always use the CPR compensation during timing analysis to preserve the slack accuracy and the overall timing signoff quality.

**Clock Uncertainty**

Clock uncertainty is the total amount of possible time variation between any pair of clock edges. The uncertainty consists of the computed clock jitter (system, input, and discrete); the phase error introduced by certain hardware primitives; and any clock uncertainty specified by the user in the design constraints (`set_clock_uncertainty`).

For primary clocks, the jitter is defined by `set_input_jitter` and `set_system_jitter`. For clock generators such as MMCM and PLL, the tool computes the jitter based on user-specified jitter on its source clock and its configuration. For other generated clocks (such as flop based clock dividers), the jitter is the same as that of its source clock.
The user-specified clock uncertainty is added to the uncertainty computed by the Vivado Design Suite timing engine. For generated clocks (such as from MMCM, PLL, and flop-based clock dividers), uncertainty specified by the user on source clock does not propagate through the clock generators.

For more information on jitter and phase error definitions, see the *Vivado Design Suite User Guide: Using Constraints* (UG903) [Ref 6].

The clock uncertainty has two purposes:

- Reserve some amount of margin in the slack numbers for representing any noise on the clock that could affect the hardware functionality. Because the delay and jitter numbers are conservative, Xilinx does not recommend adding extra uncertainty to ensure proper hardware functionality.
- Over-constrain the paths related to a clock or a clock pair during one or several implementation steps. This increases the QoR margin that can be used to help the next steps to close timing on these paths. By using clock uncertainty, the clock waveforms and their relationships are not modified, so the rest of the timing constraints can still apply properly.

**Pulse Width Checks**

The pulse width checks are some rule checks on the signal waveforms when they reach the hardware primitives after propagation through the device. They usually correspond to functional limits dictated by the circuitry inside the primitive. For example, the minimum period check on a DSP clock pin ensures that the clock driving a DSP instance does not run at higher frequency than what is tolerated by the internal DSP.

The pulse width checks do not affect synthesis or implementation. Their analysis must be performed once before the bitstream generation like any other design rule check provided by the Vivado Design Suite.

When a pulse width violation occurs, it is due to an inappropriate clock definition (pulse width and period checks) or an inappropriate clock topology that induces too much skew (max_skew check). You must review the Xilinx FPGA data sheet of the target device to understand the operation range of the primitive where the violation occurs. In the case of a skew violation, you must simplify the clock tree or place the clock resources closer to the violating pins.
Verifying Timing Signoff

Before going into the details of timing analysis, it is important to understand which part of the timing reports indicates that your design is ready to run in hardware.

**IMPORTANT:** Timing signoff is a mandatory step in the analysis of the implementation results, once your design is fully placed and routed.

By default, when using projects in the Vivado Design Suite, the runs automatically generate the text version of Report Timing Summary. You can also generate this report interactively after loading the post-implementation design checkpoint in memory.

Timing Signoff Criteria

Timing signoff is a combination of two criteria:

- Your design is fully constrained.
- Your design meets timing.

Your Design Is Fully Constrained

Review the Check Timing section to verify that your design is fully constrained. Check Timing must show that:

- All non-constant clock pins are reached by a defined clock (no_clock check).
- All internal path endpoints are timed (unconstrained_internal_endpoint check).
- All input and output ports are fully constrained (no_input_delay, no_output_delay, partial_input_delay, partial_output_delay checks).

The problems reported by the two following checks must be thoroughly reviewed and addressed:

- All generated clocks are not properly timed (generated_clock check). This occurs when there is no logical or active timing path between a generated clock and its master clock. It impacts skew computation and potentially slack violations.
- There are some combinatorial loops in the design (loops checks). The timing engine breaks combinatorial loops at random points which will reduce the coverage of the analysis.
Chapter 5: Performing Timing Analysis

The two last checks are informational and usually highlight overly-pessimistic timing situations:

- There are some combinatorial loops that propagate through a latch (latch_loops check). The Vivado IDE timing engine does not break latch_loops, but considers maximum time borrowing, which can lead to over-pessimistic latch timing analysis.
- The clocks present on any clock pin are not all exclusive (multiple_clocks check). This check does not need to be clean, because it usually highlights unrealistic timing paths that are timed while the rest of the design is still properly timed. In some cases, unrealistic timing paths can make it harder for the implementation tools to close timing.

**TIP:** You can waive some of the missing constraints, at the risk of lowering the signoff quality of your design.

Your Design Meets Timing

- Total Negative Slack (TNS) is 0\(\text{ns}\). Covers max delay analysis (setup/recovery).
- Total Hold Slack (THS) is 0\(\text{ns}\). Covers min delay analysis (hold/removal).
- Total Pulse Width Slack (TPWS) is 0\(\text{ns}\). Equivalent to Component Pin Switching Limit in ISE. It is performed with both min and max delays.

The sum of TNS, THS, and TPWS is equivalent to the ISE final Timing Score.

Verifying Clean Timing Signoff

Figure 5-6, Report Timing Summary Signoff in Vivado IDE, highlights in green the information you must examine in order to verify that the timing signoff is clean.
Figure 5-7 shows the Check Timing information to verify in the text report.

<table>
<thead>
<tr>
<th>Checking 'no_clock',</th>
</tr>
</thead>
<tbody>
<tr>
<td>There are 0 register/latch pins with no clock.</td>
</tr>
<tr>
<td>There are 0 register/latch pins with constant_clock.</td>
</tr>
<tr>
<td>Checking 'unconstrained_internal_endpoints'.</td>
</tr>
<tr>
<td>There are 0 pins that are not constrained for maximum delay.</td>
</tr>
<tr>
<td>There are 42 pins that are not constrained for maximum delay due to constant clock.</td>
</tr>
<tr>
<td>Checking 'no_input_delay'.</td>
</tr>
<tr>
<td>There are 0 input ports with no input delay specified.</td>
</tr>
<tr>
<td>Checking 'no_output_delay'.</td>
</tr>
<tr>
<td>There are 0 output ports with no output delay specified.</td>
</tr>
<tr>
<td>Checking 'multiple_clock'.</td>
</tr>
<tr>
<td>There are 0 register/latch pins with related clocks.</td>
</tr>
<tr>
<td>There are 0 register/latch pins with exclusive clocks.</td>
</tr>
<tr>
<td>Checking 'generated_clocks'.</td>
</tr>
<tr>
<td>There are 0 generated clocks that are not connected to a clock source.</td>
</tr>
<tr>
<td>Checking 'loops'.</td>
</tr>
<tr>
<td>There are 0 combinational loops in the design.</td>
</tr>
<tr>
<td>Checking 'partial_input_delay'.</td>
</tr>
<tr>
<td>There are 0 input ports with partial input delay specified.</td>
</tr>
<tr>
<td>Checking 'partial_output_delay'.</td>
</tr>
<tr>
<td>There are 0 output ports with partial output delay specified.</td>
</tr>
<tr>
<td>Checking 'unexpandable_clocks'.</td>
</tr>
<tr>
<td>There are 0 related clock pairs.</td>
</tr>
<tr>
<td>There are 0 user ignored clock pairs.</td>
</tr>
<tr>
<td>Checking 'latch_loops'.</td>
</tr>
<tr>
<td>There are 0 combinational latch loops in the design through latch input</td>
</tr>
</tbody>
</table>

**Figure 5-7:** Check Timing Signoff in Text Report
Figure 5-8 shows the Design Timing Summary information to verify in the text report.

![Design Timing Summary](image)

**Figure 5-8:** Design Timing Summary Signoff in Text Report

**Investigating Timing Violations**

In the Vivado IDE, slack violations are reported in red. Missing constraints are not highlighted with a particular color.

To investigate timing violations, review the following sections:

- The Intra-Clock Paths, Inter-Clock Paths and Path Groups (**async_default**) sections provide information on setup, recovery, hold, and removal violations.
- Intra-Clock Paths provides details on Pulse Width check violations.

For more information on the report windows, see Report Timing Summary, page 20, in Chapter 2, Timing Analysis Features.

**TIP:** To display violations only, click the **Show only failing checks** button.

If you used the default options, the Timing Summary report includes the details of the N-worst paths for each clock pair and for each type of analysis.

- The GUI default for N is 10 (ten).
- The `report_timing_summary` command default for N is 1 (one).

To directly review the timing path details without running another report, double click the path. If not enough paths are reported, either (1) rerun Report Timing Summary with more paths (Tcl equivalent: `report_timing_summary -max_paths N`), or (2) run Report Timing on a particular clock pair or a particular timing path.

For more information on Tcl commands, see the Vivado Design Suite Tcl Command Reference Guide (UG835) [Ref 3], or type `<command> -help`. 
Chapter 5: Performing Timing Analysis

Reading a Timing Path Report

The timing path report provides the information needed to understand what causes a timing violation. The following sections describe the Timing Path Report.

The Timing Path Summary displays the important information from the timing path details. You can review it to find out about the cause of a violation without having to analyze the details of the timing path. It includes slack, path requirement, datapath delay, cell delay, route delay, clock skew, and clock uncertainty. It does not provide any information about cell placement.

For more information about the terminology used for timing constraints and timing analysis, as well as learn how slack and path requirement are determined, see this link in the Vivado Design Suite User Guide: Using Constraints (UG903) [Ref 6].

Timing Path Summary Header Examples

Figure 5-9 shows an example of the Timing Path Summary Header in a text report.

```
Slack (NET) : 1.439ns  (required time - arrival time)
Source: ingressPifoIqEn_reg/C
       (rising edge-triggered cell FDEK clocked by vbClk  [rise@0.000ns fall@0.000ns period@10.000ns])
Destination: ingressLoop(2).ingressPifoIqbuffer_fifoInter_fifo.next_rd_add_reg[4]/CE
           (rising edge-triggered cell FDEK clocked by bfoclk  [rise@0.000ns fall@2.50ns period@6.000ns])
Path Group: bfoClk
Path Type: Setup (Max at Slow Process Corner)
Requirement: 5.0000ns
Data Path Delay: 2.0150ns  (logic 0.3020s (10.359%) route 2.610ns (89.641%))
Logic Levels: 1  (LU7203)
Clock Path Skew: -0.4140ns  (DCD - SCD + CPR)
Destination Clock Delay (DCD): 3.7920ns  (0.7920 - 0.0000)
Source Clock Delay (SCD): 4.2160ns
Clock Frequency Variability (CFV): 0.006ns
Clock Uncertainty: 0.0350ns  ((T50%+2+T15%)/4 - D0) / 2 + HE
Total System Jitter (TJS): 0.071ns
Total Input Jitter (TIJ): 0.000ns
Discrete Jitter (D): 0.000ns
Phase Error (PE): 0.000ns
Clock Domain Crossing: Inter clock paths are considered valid unless explicitly excluded by timing constraints such as set_
```

Figure 5-9: Timing Path Summary Header in Text Report

Figure 5-10 shows an example of the Timing Path Summary header in the Vivado IDE.

```
Summary

<table>
<thead>
<tr>
<th>Path</th>
<th>1.439ns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slack</td>
<td></td>
</tr>
<tr>
<td>Source</td>
<td>ingressPifoIqEn_reg/C</td>
</tr>
<tr>
<td>Destination</td>
<td>ingressLoop(2).ingressPifoIqbuffer_fifoInter_fifo.next_rd_add_reg[4]/CE</td>
</tr>
<tr>
<td>Path Group</td>
<td>bfoClk</td>
</tr>
<tr>
<td>Path Type</td>
<td>Setup (Max at Slow Process Corner)</td>
</tr>
<tr>
<td>Requirement</td>
<td>5.0000ns</td>
</tr>
<tr>
<td>Data Path Delay</td>
<td>2.0150ns  (logic 0.3020s (10.359%) route 2.610ns (89.641%))</td>
</tr>
<tr>
<td>Logic Levels</td>
<td>1  (LU7203)</td>
</tr>
<tr>
<td>Clock Path Skew</td>
<td>-0.4140ns  (DCD - SCD + CPR)</td>
</tr>
</tbody>
</table>
```

Figure 5-10: Timing Path Summary Header in Vivado IDE
Timing Path Summary Header Information

The Timing Path Summary header includes the following information:

- **Slack**
  
  A positive slack indicates that the path meets the path requirement, which is derived from the timing constraints. The Slack equation depends on the analysis performed.

- **Max delay analysis (setup/recovery)**
  
  \[ \text{slack} = \text{data required time} - \text{data arrival time} \]

- **Min delay analysis (hold/removal)**
  
  \[ \text{slack} = \text{data arrival time} - \text{data required time} \]

  Data required and arrival times are calculated and reported in the other sub-sections of the timing path report.

- **Source**
  
  The path startpoint and the source clock that launches the data. The startpoint is usually the clock pin of a sequential cell or an input port.

  When applicable, the second line displays the primitive and the edge sensitivity of the clock pin. It also provides the clock name and the clock edges definition (waveform and period).

- **Destination**
  
  The path endpoint and the destination clock that captures the data. The endpoint is usually the input data pin of the destination sequential cell or an output port. Whenever applicable, the second line displays the primitive and the edge sensitivity of the clock pin. It also provides the clock name and the clock edges definition (waveform and period).

- **Path Group**
  
  The timing group that the path endpoint belongs to. This is usually the group defined by the destination clock, except for asynchronous timing checks (recovery/removal) which are grouped in the **async_default** timing group. User-defined groups can also appear here. They are convenient for reporting purpose.

- **Path Type**
  
  The type of analysis performed on this path.

  - **Max** indicates that the maximum delay values are used to calculate the data path delay, which corresponds to setup and recovery analysis.

  - **Min** indicates that the minimum delay values are used to calculate the data path delay, which corresponds to hold and removal analysis.

  This line also shows which corner was used for the report: **Slow** or **Fast**.
• **Requirement**

The timing path requirement, which is typically:

- One clock period for setup/recovery analysis.
- 0ns for hold/removal analysis, when the startpoint and endpoint are controlled by the same clock, or by clocks with no phase-shift.

When the path is between two different clocks, the requirement corresponds to the smallest positive difference between any source and destination clock edges. This value is overridden by timing exception constraints such as multicycle path, max delay and min delay.

For more information on how timing path requirement is derived from the timing constraints, see this link in the *Vivado Design Suite User Guide: Using Constraints* (UG903) [Ref 6].

• **Data Path Delay**

Accumulated delay through the logic section of the path. The clock delay is excluded unless the clock is used as a data. The type of delay corresponds to what the **Path Type** line describes.

• **Logic Levels**

The number of each type of primitives included in the data section of the path, excluding the startpoint and the endpoint cells.

• **Clock Path Skew**

The insertion delay difference between the launch edge of the source clock and the capture edge of the destination clock, plus clock pessimism correction (if any).

• **Destination Clock Delay (DCD)**

The accumulated delay from the destination clock source point to the endpoint of the path.

- For max delay analysis (setup/recovery), the minimum cell and net delay values are used
- For min delay analysis (hold/removal), the maximum delay values are used.
• **Source Clock Delay (SCD)**
  
  The accumulated delay from the clock source point to the startpoint of the path.
  
  - For max delay analysis (setup/recovery), the maximum cell and net delay values are used.
  - For min delay analysis (hold/removal), the minimum delay values are used.

• **Clock Pessimism Removal (CPR)**

  The absolute amount of extra clock skew introduced by the fact that source and destination clocks are reported with different types of delay even on their common circuitry.

  After removing this extra pessimism, the source and destination clocks do not have any skew on their common circuitry.

  For a routed design, the last common clock tree node is usually located in the routing resources used by the clock nets and is not reported in the path details.

• **Clock Uncertainty**

  The total amount of possible time variation between any pair of clock edges.

  The uncertainty comprises the computed clock jitter (system and discrete), the phase error introduced by certain hardware primitives and any clock uncertainty specified by the user in the design constraints (`set_clock_uncertainty`).

  The user clock uncertainty is additive to the uncertainty computed by the Vivado IDE timing engine.

• **Total System Jitter (TSJ)**

  The combined system jitter applied to both source and destination clocks. To modify the system jitter globally, use the `set_system_jitter` constraint. The virtual clocks are ideal and therefore do not have any system jitter.

• **Total Input Jitter (TIJ)**

  The combined input jitter of both source and destination clocks.

  To define the input jitter for each primary clock individually, use the `set_input_jitter` constraint. The Vivado IDE timing engine computes the generated clocks input jitter based on their master clock jitter and the clocking resources traversed. By default, the virtual clocks are ideal and therefore do not have any jitter.

  For more information on clock uncertainty and jitter, see [this link](#) in the *Vivado Design Suite User Guide: Using Constraints* (UG903) [Ref 6].
Chapter 5: Performing Timing Analysis

- **Discrete Jitter (DJ)**
  
The amount of jitter introduced by hardware primitives such as MMCM or PLL.
  
The Vivado IDE timing engine computes this value based on the configuration of these cells.

- **Phase Error (PE)**
  
The amount of phase variation between two clock signals introduced by hardware primitives such as MMCM or PLL.
  
The Vivado IDE timing engine automatically provides this value and adds it to the clock uncertainty.

- **User Uncertainty (UU)**
  
The additional uncertainty specified by the `set_clock_uncertainty` constraint.
  
  For more information on how to use this command, see [this link](#) in the *Vivado Design Suite Tcl Command Reference Guide* (UG835) [Ref 3].

Additional lines can appear in the Timing Path Summary depending on the timing constraints, the reported path, and the target device:

- **Inter-SLR Compensation**
  
The additional margin required for safely reporting paths that cross SLR boundaries in Xilinx 7 series SSI devices only.

- **Input Delay**
  
The input delay value specified by the `set_input_delay` constraint on the input port. This line does not show for paths that do not start from an input port.

- **Output Delay**
  
The output delay value specified by the `set_output_delay` constraint on the output port. This line does not show for paths that do not end to an output port.

- **Timing Exception**
  
The timing exception that covers the path. Only the exception with the highest precedence is displayed, as it is the only one affecting the timing path requirement.
  
  For more information on timing exceptions and their precedence rules, see [this link](#) in the *Vivado Design Suite User Guide: Using Constraints* (UG903) [Ref 6].
Timing Path Details

The second half of the report provides more details on the cells, pins, ports and nets traversed by the path. It is separated into three sections:

- **Source Clock Path**
  
The circuitry traversed by the source clock from its source point to the startpoint of the datapath. This section does not exist for a path starting from an input port.

- **Data Path**
  
The circuitry traversed by the data from the startpoint to the endpoint.

- **Destination Clock Path**
  
The circuitry traversed by the destination clock from its source point to the datapath endpoint clock pin.

The Source Clock Path and Data Path sections work together. They are always reported with the same type of delay:

- max delay for setup/recovery analysis
- min delay for hold/removal analysis

They share the accumulated delay which starts at the data launch edge time, and accumulates delay through both source clock and data paths. The final accumulated delay value is called the *data arrival time*.

The destination clock path is always reported with the opposite delay to the source clock and data paths. Its initial accumulated delay value is the time when the data capture edge is launched on the destination clock source point. The final accumulated delay value is called the *data required time*.

The final lines of the report summarize how the slack is computed.

- For max delay analysis (setup/recovery)
  \[ \text{slack} = \text{data required time} - \text{data arrival time} \]

- For min delay analysis (hold/removal)
  \[ \text{slack} = \text{data arrival time} - \text{data required time} \]
## Timing Path Details In Text Report

Figure 5-11, Timing Path Details in Text Report, shows an example of the Source Clock, Data and Destination Clock Paths in the text report. Because the path is covered by a simple period constraint of 5ns, the source clock launch edge starts at 0ns and the destination clock capture edge starts at 5ns.

<table>
<thead>
<tr>
<th>Location</th>
<th>Delay type</th>
<th>InC (ns)</th>
<th>Path (ns)</th>
<th>Netlist Resource(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>V20</td>
<td>(clock wBCKl clk edge)</td>
<td>0.000</td>
<td>0.000</td>
<td>wBCKl</td>
</tr>
<tr>
<td>net (f0=0)</td>
<td></td>
<td>0.000</td>
<td>0.000</td>
<td>wBCKl</td>
</tr>
<tr>
<td>net (f0=1, routed)</td>
<td></td>
<td>0.764</td>
<td>0.764</td>
<td>wBCKl_IBUF, IBUF</td>
</tr>
<tr>
<td>BDFCTRL_X01</td>
<td>IBUF (Prop_body_f_0)</td>
<td>0.093</td>
<td>2.755</td>
<td>wBCKl_IBUF_IBUF_IBUF</td>
</tr>
<tr>
<td>net (f0=704, routed)</td>
<td></td>
<td>1.482</td>
<td>6.210</td>
<td>wBCKl_IBUF_IBUF</td>
</tr>
<tr>
<td>SLICE_X0133</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SLICE_X0133</td>
<td>Prop_f0_clk edge</td>
<td>0.289</td>
<td>4.449</td>
<td>ingressFifoEn_reg/Q</td>
</tr>
<tr>
<td>net (f0=25, routed)</td>
<td></td>
<td>2.286</td>
<td>6.706</td>
<td>ingressFifo/kiffer_fifo/I1</td>
</tr>
<tr>
<td>SLICE_X0176</td>
<td>Prop_f0_clk edge</td>
<td>0.083</td>
<td>4.679</td>
<td>ingressFifo/kiffer_fifo/kiffer_fifoῖ/ne_f10/prop_f0_clk_prop_f0_prop_f0_cl</td>
</tr>
<tr>
<td>net (f0=30, routed)</td>
<td></td>
<td>0.327</td>
<td>7.126</td>
<td>ingressFifo/kiffer_fifo/do_read</td>
</tr>
<tr>
<td>SLICE_X0176</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(clock wBCKl clk edge)</td>
<td></td>
<td>5.000</td>
<td>5.000</td>
<td>wBCKl</td>
</tr>
<tr>
<td>net (f0=0)</td>
<td></td>
<td>0.000</td>
<td>0.000</td>
<td>wBCKl</td>
</tr>
</tbody>
</table>
Timing Path Details in Vivado IDE

The Timing Path Details in the Vivado IDE, as shown in Figure 5-12, Timing Path Details in Text Report, page 151, shows the same information as is shown in the text report, seen in Figure 5-11, Timing Path Details in Text Report.
Chapter 5: Performing Timing Analysis

The information on the path is displayed in five columns:

- **Location**
  Where the cell or port is placed on the device.

- **Delay Type**
  The unisim primitive and the particular timing arc followed by the path. In case of a net, it shows the fanout (\(F_o\)) and its status. A net can be:
  - **Unplaced**: The driver and the load are not placed.
  - **Estimated**: The driver or the load or both are placed. A partially routed net is also reported as estimated.
  - **Routed**: The driver and the load are both placed, plus the net is fully routed.

- **Incr(ns) (text report) / Delay (IDE report)**
  The value of the incremental delay associated to a unisim primitive timing arc or a net. It can also show of a constraint such as input/output delay or clock uncertainty.

- **Path(ns) (text report) / Cumulative (IDE report)**
  The accumulated delay after each segment of the path. On a given line, its value is the accumulated value from the previous + the incremental delay of the current line.

- **Netlist Resource(s) (text report) / Logical Resource (IDE report)**
  The name of the netlist object traversed.

Each incremental delay is associated to one of the following edge senses:

- \(r\) (rising)
- \(f\) (falling)

The initial sense of the edge is determined by the launch or capture edge used for the analysis. It can be inverted by any cell along the path, depending on the nature of the timing arc. For example, a rising edge at the input of an inverter becomes a falling edge on the output.

The edge sense can be helpful in identifying that an overly-tight timing path requirement comes from a clock edge inversion along the source or destination clock tree.
Chapter 6

Design Closure Techniques

Introduction to Design Closure Techniques

This chapter discusses techniques for timing closure in the Xilinx® Vivado® Integrated Design Environment (IDE) including:

- Checking Constraints and Sources
- Increasing Tool Effort
- Floorplanning
- Modifying Routing

Checking Constraints and Sources

Ensure that design and timing constraints are reasonable.

- Be sure that you have a good netlist.

  If you are using Vivado Synthesis, add synthesis-specific timing constraints to a synthesis XDC file. Synthesis is timing-driven, and optimizes the logic to meet timing.

- Manually review the clock trees in the Schematic window or the Clock Networks report.

  Be sure that the clock trees are reasonable. Designs can have a large clock skew when one BUFG drives a second BUFG or a LUT. The extra clock skew can lead to small to no design margin for meeting setup checks, or to a large amount of hold fixing, which will increase the routing resource utilization and potentially the congestion level. The placer DRCs issue warnings for some clock tree issues.

- Consider the clocking resources when laying out the pinout and floorplanning the design.

  The clock regions in Xilinx® 7 series FPGA devices support twelve global clocks per region. There are additional limitations on the placement of clock trees. For more information, see 7 Series Clocking Resources Guide (UG472) [Ref 9].
• Be sure that the clock periods are the ones the design needs to meet.

If you are overconstraining the design, the tools attempt to meet artificially tight timing constraints at the cost of runtime. Overconstraining can lead to timing failures and higher power consumption.

If the design is failing to meet artificially tight constraints, try the real constraints. You can modify timing constraints in the Vivado IDE without changing the placement and routing. Rerun `report_timing_summary` with the real clock periods.

• Determine if the failing paths are multicycle paths or paths not functionally active.

The Vivado IDE times all logical paths of your design, including the ones between asynchronous clocks unless you add appropriate timing exceptions. This is a change from ISE® Design Suite and UCF. Some paths may never be active due to the structure of the control logic. You can use the `set_false_path` constraint to ignore slack computation on them.

Other control structures (for example, a clock enable driven by a state machine) generate multicycle paths. If data has multiple clock periods to get from the source to the destination, enter Multicycle Timing constraints. In XDC, setup and hold multicycle delays are entered separately.

• Rerun timing after Implementation with the improved timing constraints. You do not need to rerun implementation to view how changing the timing graph changes design timing. Review the next set of timing paths and continue to refine the timing constraints as needed.

• If you are still not meeting timing after modifying the timing constraints, rerun implementation. Implementation is timing-driven and can now focus on the real problem areas. If the original design had high Total Hold Slack (THS) in the router, you must rerun implementation.

**TIP:** Use `Save Constraints As` to create a new constraint set, preserving your original constraints.

• Review the timing path.

Ensure that clock skew and jitter are reasonable.

• Review the logic.

What is the logic delay compared to the period? If logic delay is a high percentage of the period you must resynthesize the design to reduce logic delay.
• Review the Route Delay

If the route delay is a high percentage of the period, try reducing route delay. Two ways to try to reduce route delay are:

° Rewrite the RTL.

If you see high fanout nets, consider replicating the drivers. Take logic placement into consideration when re-factoring the high fanout net. Each driver should communicate with localized loads rather than loads spread out across the device.

Apply synthesis attributes such as `DONT_TOUCH` or `KEEP` to prevent register pruning on replicated registers.

° Floorplan.

Consider floorplanning if route delay is a high percentage of the timing path. The goal is to improve the timing of the critical paths by reducing route delay. Floorplanning does not change the logic that makes up the critical path. Review how the blocks in the design interconnect while floorplanning.

You may want to restructure the RTL to better work inside the device. The synthesis tools do not know about placement. When they replicate high fanout nets, they generally do not take placement into account.

Manually replicating and rewiring can lead to a better design. For example, if you have two memory interfaces that go on opposite corners of the chip, you might want to replicate the control signals in the RTL source. You might need to use synthesis attributes to stop optimization of logically equivalent registers.
Increasing Tool Effort

Ask the tools to work harder. Sometimes you can close timing on a design merely by assigning more CPU cycles to implementation.

The **Vivado Implementation Defaults** strategy balances run time and performance. Some run time expensive algorithms are not used. To turn on these algorithms, and physical synthesis, use the **Performance_Explore** strategy. For the largest parts (using SSI technology) consider **Performance_ExploreSLLs**.

There are other strategies to help with faster run time or congestion. The strategies with a SLL suffix are tuned for the parts using SSI technology.

Run the **Flow > Create Runs** command to create and launch multiple runs using the different strategies.

![Multiple Runs](image)

**Figure 6-1: Multiple Runs**

Review the implementation results to find the strategy that works best for the design. Re-use the strategy for later runs.

**TIP:** The optimal strategy can change between designs and software releases.
Floorplanning

This section discusses Floorplanning and includes:

- About Floorplanning
- Understanding Floorplanning Basics
- Using Pblock-Based Floorplanning
- Locking Specific Logic to Device Sites
- Floorplanning With Stacked Silicon Interconnect (SSI) Devices

About Floorplanning

Floorplanning can help a design meet timing. Xilinx recommends that you floorplan when a design does not meet timing consistently, or has never met timing.

Floorplanning is also helpful when you are working with design teams, and consistency is most important.

Floorplanning can improve the setup slack (TNS, WNS) by reducing the average route delay. During implementation, the timing engine works on resolving the worst setup violations and all the hold violations. Floorplanning can only improve setup slack.

Manual floorplanning is easiest when the netlist has hierarchy. Design analysis is much slower when synthesis flattens the entire netlist. Set up synthesis to generate a hierarchical netlist. For Vivado synthesis use:

- `synth_design -flatten_hierarchy rebuilt`

  or

- The **Vivado Synthesis Defaults** strategy

Large hierarchical blocks with intertwined logical paths can be difficult to analyze. It is easier to analyze a design in which separate logical structures are in lower sub-hierarchies. Consider registering all the outputs of a hierarchical module. It is difficult to analyze the placement of paths that trace through multiple hierarchical blocks.
Chapter 6: Design Closure Techniques

Understanding Floorplanning Basics

Not every design will always meet timing. You may have to guide the tools to a solution. Floorplanning allows you to guide the tools, either through high-level hierarchy layout, or through detailed gate placement.

You will achieve the greatest improvements by fixing the worst problems or the most common problems. For example if there are outlier paths that have significantly worse slack, or high levels of logic, fix those paths first. The Tools > Timing > Create Slack Histogram command can provide a view of outlier paths. Alternatively, if the same timing endpoint appears in several negative slack paths, improving one of the paths might result in similar improvements for the other paths on that endpoint.

Consider floorplanning to increase performance by reducing route delay or increasing logic density on a non-critical block. Logic density is a measure of how tightly the logic is packed onto the chip.

Floorplanning can help you meet a higher clock frequency and improve consistency in the results.

There are multiple approaches to floorplanning, each with its advantages and disadvantages.

Detailed Gate-Level Floorplanning

Detailed gate-level floorplanning involves placing individual leaf cells in specific sites on the device.

Advantages of Detailed Gate-Level Floorplanning

• Detailed gate-level floorplanning works with hand routing nets.
• Detailed gate-level floorplanning can extract the most performance out of the device.

Disadvantages of Detailed Gate-Level Floorplanning

• Detailed gate-level floorplanning is time consuming.
• Detailed gate-level floorplanning requires extensive knowledge of the device and design.
• Detailed gate-level floorplanning may need to be redone if the netlist changes.

RECOMMENDED: Use detailed gate-level floorplanning as a last resort.
Information Re-Use

Re-use information from a design that met timing. Use this flow if the design does not consistently meet timing. To re-use information:

1. Open two implementation runs:
   a. One for a run that is meeting timing.
   b. One for a run that is not meeting timing.

   **TIP:** On a computer with multiple monitors, select **Open Implementation in New Window** to open a design in a new window.

2. Look for the differences between the two designs.
   a. Identify some failing timing paths from **report_timing_summary**.
   b. On the design that is meeting timing, run **report_timing** in **min_max** mode to time those same paths on the design that meets timing.

3. Compare the timing results:
   a. Clock skew
   b. Datapath delay
   c. Placement
   d. Route delays

4. If there are differences in the amount of logic delay between path end points, revisit the synthesis runs.

Review I/O and Cell Placement

Review the placement of the cells in the design. Compare two I/O reports to review the I/O placement and I/O standards. Make sure all the I/Os are placed. A simple search finds all
I/Os without fixed placement as shown in Figure 6-2.

If clock skew has changed between the runs, consider re-using the clock primitive placement from the run that met timing. The Clock Utilization Report lists the placement of the clock tree drivers, as shown in Figure 6-3.
The LOC constraints can easily be copied into your XDC constraints file.

Many designs have met timing by reusing the placement of the Block RAMs and DSPs. Select **Edit > Find** to list the instances.

![Image of the Find dialog box](image.png)

*Figure 6-4: DSP or RAM*
Adding Placement Constraints

Fix the logic to add the placement constraints to your XDC.

1. Select the macros from the find results.
2. Right click and select **Fix Cells**.

**RECOMMENDED:** Analyze the placement based on hierarchy name and highlight before fixing the placement.

Re-Using Placement

It is fairly easy to re-use the placement of I/Os, Global Clock Resources, BlockRam macros, and DSP macros.

Re-using this placement helps to reduce the variability in results from one netlist revision to the next. These primitives generally have stable names. The placement is usually easy to maintain.

**TIP:** Do not reuse the placement of general slice logic. Do not re-use the placement for sections of the design that are likely to change.
Floorplanning Techniques

Consider gate-level floorplanning for a design that has never met timing, and in which changing the netlist or the constraints are not good options.

RECOMMENDED: Try hierarchical floorplanning before considering gate level floorplanning.

Hierarchical Floorplanning

Hierarchical floorplanning allows you to place one or more levels of hierarchy in a region on the chip. This region provides guidance to the placer at a global level, and the placer does the detailed placement. Hierarchical floorplanning has the following advantages over gate-level floorplanning:

- Hierarchical floorplan creation is fast compared to gate-level floorplanning. A good floorplan can improve timing. The floorplan is resistant to design change.
- The level of hierarchy acts as a container for all the gates. It will generally work if the netlist changes.

In hierarchical floorplanning:

- Identify the lower levels of hierarchy that contain the critical path.
- Use the top level floorplan to identify where to place them.
- Implementation places individual cells.
- Has comprehensive knowledge of the cells and timing paths.
- Generally does a good job of fine grain placement.

Manual Cell Placement

Manual cell placement can obtain the best performance from a device. When using this technique, designers generally use it only on a small block of the design. They may hand place a small amount of logic around a high speed I/O interface, or hand place Block RAMs and DSPs. Manual placement can be slow.

All floorplanning techniques can require significant engineering time. They might require floorplan iterations. If any of the cell names change, the floorplan constraints must be updated.

When floorplanning, you should have an idea of final pinout. It is useful to have the I/Os fixed. The I/Os can provide anchor points for starting the floorplan. Logic that communicates to I/Os migrates towards the fixed pins.

TIP: Place blocks that communicate with I/Os near their I/Os. If the pinout is pulling a block apart, consider pinout or RTL modification.
The floorplan shown in Figure 6-6 might not help timing. Consider splitting the block apart, changing the source code, or constraining only the Block RAMs and DSPs. Also consider unplacing I/O registers if external timing requirements allow.
The Pblock mentioned in this section is represented by the XDC constraints:

```plaintext
create_pblock Pblock_usbEngine
add_cells_to_pblock [get_pblocks Pblock_usbEngine] [get_cells -quiet [list usbEngine1]]
resize_pblock [get_pblocks Pblock_usbEngine] -add {SLICE_X8Y105:SLICE_X23Y149}
resize_pblock [get_pblocks Pblock_usbEngine] -add {DSP48_X0Y42:DSP48_X1Y59}
resize_pblock [get_pblocks Pblock_usbEngine] -add {RAMB18_X0Y42:RAMB18_X1Y59}
resize_pblock [get_pblocks Pblock_usbEngine] -add {RAMB36_X0Y21:RAMB36_X1Y29}
```

The first line creates the Pblock. The second line (`add_cells_to_pblock`) assigns the level of hierarchy to the Pblock. There are four resource types (SLICE, DSP48, RAMB18, RAMB36) each with its own grid. Logic that is not constrained by a grid can go anywhere in the device. To constrain just the Block RAMs in the level of hierarchy, disable the other Pblock grids.

The resulting XDC commands define the simplified Pblock:

```plaintext
create_pblock Pblock_usbEngine
add_cells_to_pblock [get_pblocks Pblock_usbEngine] [get_cells -quiet [list usbEngine1]]
resize_pblock [get_pblocks Pblock_usbEngine] -add {RAMB18_X0Y42:RAMB18_X1Y59}
resize_pblock [get_pblocks Pblock_usbEngine] -add {RAMB36_X0Y21:RAMB36_X1Y29}
```

The Block RAMs are constrained in the device, but the slice logic is free to be placed anywhere on the device.

![Figure 6-7: Pblock Grids](image)
**TIP:** When placing Pblocks, be careful not to floorplan hierarchy in such a manner that it crosses the central config block.

*Figure 6-8: Avoiding the Config Block*
Using Pblock-Based Floorplanning

When you integrate RTL into a design, it helps to visualize the design inside the device. Graphically seeing how the blocks interconnect between themselves and the I/O pinout after synthesis helps you to understand your design.

To view the interconnect, generate a top level floorplan using Pblocks on upper levels of hierarchy. To break apart the top level RTL into Pblocks, select **Tools > Floorplanning > Auto Create Pblocks**.

To place the blocks in the device, select **Tools > Floorplanning > Place Pblocks**. The tool sizes the Pblocks based on the slice count and target utilization.

Pblocks can be more than one hundred percent full during analysis, but not during implementation. Overfilling the Pblock makes them smaller on the device. This is a useful technique for getting an overview of the relative size of your design top-level blocks, and how they will occupy the device.

![Place Pblocks Utilization](image)

*Figure 6-9: Place Pblocks Utilization*
Top-Level Floorplan

The top-level floorplan shows which blocks communicate with I/Os (green lines). Nets connecting two Pblocks are bundled together. The bundles change size and color based on the number of shared nets. Two top-level floorplans are shown in Figure 6-10 and Figure 6-11, page 170.

The Data Path Top Level Floorplan shows how the data flows between the top-level blocks of the design. Each block communicates only with two neighbors. The green lines show well-placed I/Os that communicate with a single block.

Figure 6-10: Data Path Top Level Floorplan
The Control Path Floorplan displays a design in which all the blocks communicate with a central block. The largest connection is between the central block and the block in the bottom right. The central block must spread out around the design to communicate with all the other loads.

Reviewing the Floorplan

Consider device resources when reviewing the floorplan. The Pblock sizing does not take into account specialized device resources such as:

- Block RAM
- DSP48s
- MGTs
- ClockBuffers

**TIP:** Review the blocks with the floorplan and utilization in mind.
Locking Specific Logic to Device Sites

You can place cells on specific locations on the FPGA device, such as placing all the I/O ports on a Xilinx 7 series FPGA design. Xilinx recommends that you place the I/Os before attempting to close timing.

The I/O placement can impact the cell placement in the FPGA fabric. Hand placing other cells in the fabric can help provide some consistency to clock logic and macro placement, with the goal of more consistent implementation runs.

Table 6-1: Constraints Used to Place Logic

<table>
<thead>
<tr>
<th>Constraint</th>
<th>Use</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOC</td>
<td>Places a gate or macro at a specific site.</td>
<td>SLICE sites have subsites called BEL sites.</td>
</tr>
<tr>
<td>BEL</td>
<td>Specifies the subsite in the slice to use for a basic element.</td>
<td></td>
</tr>
</tbody>
</table>

Fixed and Unfixed Cells

Fixed and Unfixed apply to placed cells. They describe the way in which the Vivado tools view placed cells in the design.

For more information about Fixed and Unfixed Cells, refer to this link in the Vivado Design Suite User Guide: Implementation (UG904) [Ref 7].

RECOMMENDED: After the I/Os are placed, use a hierarchical Pblock floorplan as a starting point for user-controlled placement. Hand placing logic should be used when Pblocks have been found not to work.
Floorplanning With Stacked Silicon Interconnect (SSI) Devices

There are extra considerations for Stacked Silicon Interconnect (SSI) parts. The SSI parts are made of multiple Super Logic Regions (SLRs), joined by an interposer. The interposer connections are called Super Long Lines (SLLs). There is some delay penalty when crossing from one SLR to another.

Keep the SLRs in mind when structuring the design, generating a pinout, and floorplanning. Minimize SLL crossings by keeping logic cells of critical timing paths inside a single SLR.

The I/Os must be placed in the same SLR as the relevant I/O interface circuitry. You must also carefully consider clock placement when laying out logic for SSI parts.

RECOMMENDED: Let the placer try an automatic placement of the logic into the SSI parts before doing extensive partitioning. Analyzing the automatic placement may suggest floorplanning approaches you were not considering.

Modifying Routing

You might occasionally want to modify routing. Most often, this involves a design with a few small timing failures, and in which other, easier approaches to timing closure have failed. The Vivado Design Suite allows you to modify and fix routes.

For more information, see this link in the Vivado Design Suite User Guide: Implementation (UG904) [Ref 7].
Chapter 7

Design Analysis Techniques

Using the report_design_analysis Command

When timing closure is difficult to achieve or when you are trying to improve the overall performance of your application, you must review the main characteristics of your design after running synthesis and after any step of the implementation flow. It is relatively easy to gather the high-level metrics such as timing summary numbers (WNS/TNS/WHS/THS) (report_timing_summary) or various resource utilization numbers (report_utilization, report_clock_utilization, report_high_fanout_nets and report_control_sets). But it is more difficult to analyze and identify which particular aspect of your design is impacting a specific timing path and consequently the overall Quality of Result (QoR). The QoR analysis usually requires you to look at several global and local characteristics at the same time to figure out what is suboptimal in the design and the constraints, or which logic structure is not suitable for the target device architecture and implementation tools. The report_design_analysis command gathers logical, timing and physical characteristics in a few tables that can simplify the QoR root cause analysis.

Note: The report_design_analysis command does not report on the completeness and correctness of timing constraints. To verify your timing constraints, you must use the check_timing and report_exceptions commands, as well as the XDC and TIMING methodology DRCs. See the corresponding sections in this guide for more information on how to run these commands.

Two main categories of QoR problems are usually encountered:

- **Timing Violations**
- **Congestion**
### Timing Violations

While analyzing and fixing the worst timing violation usually helps the overall QoR improvement, you must also review the other critical paths as they often contribute to the timing closure challenge. You can use the following command to report the 50 worst setup timing paths:

```
report_design_analysis –max_paths 50 –setup
```

Figure 7-1 shows an example of the Setup Path Characteristics table generated by this command.

<table>
<thead>
<tr>
<th>Fault</th>
<th>LOGIC_DELAY</th>
<th>LOGIC_LEVELS</th>
<th>NET_DELAY</th>
<th>CLOCK_REGION_DISTANCE</th>
<th>NET_BLOCK</th>
<th>LOGIC_PATH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path #1</td>
<td>1.207</td>
<td>1.207</td>
<td>1.207</td>
<td>1.207</td>
<td>1.207</td>
<td>1.207</td>
</tr>
<tr>
<td>Path #2</td>
<td>1.208</td>
<td>1.208</td>
<td>1.208</td>
<td>1.208</td>
<td>1.208</td>
<td>1.208</td>
</tr>
<tr>
<td>Path #3</td>
<td>1.209</td>
<td>1.209</td>
<td>1.209</td>
<td>1.209</td>
<td>1.209</td>
<td>1.209</td>
</tr>
<tr>
<td>Path #5</td>
<td>1.211</td>
<td>1.211</td>
<td>1.211</td>
<td>1.211</td>
<td>1.211</td>
<td>1.211</td>
</tr>
<tr>
<td>Path #6</td>
<td>1.212</td>
<td>1.212</td>
<td>1.212</td>
<td>1.212</td>
<td>1.212</td>
<td>1.212</td>
</tr>
<tr>
<td>Path #7</td>
<td>1.213</td>
<td>1.213</td>
<td>1.213</td>
<td>1.213</td>
<td>1.213</td>
<td>1.213</td>
</tr>
<tr>
<td>Path #8</td>
<td>1.214</td>
<td>1.214</td>
<td>1.214</td>
<td>1.214</td>
<td>1.214</td>
<td>1.214</td>
</tr>
<tr>
<td>Path #9</td>
<td>1.215</td>
<td>1.215</td>
<td>1.215</td>
<td>1.215</td>
<td>1.215</td>
<td>1.215</td>
</tr>
</tbody>
</table>

**Figure 7-1:** Setup Path Characteristics

From the table, you can isolate which characteristics are introducing the timing violation for each path:

- **High logic delay percentage** (LOGIC_DELAY)
  - Are there many levels of logic? (LOGIC_LEVELS)
  - Are there any constraints or attributes that prevent logic optimization? (DONT_TOUCH, MARK_DEBUG)
  - Does the path include a cell with high logic delay such as RAMB or DSP?
  - Is the path requirement too tight for the current path topology? (REQUIREMENT)

- **High net delay percentage** (NET_DELAY)
  - Are there any high fanout nets in the path? (HIGH_FANOUT, CUMULATIVE_FANOUT)
  - Are the cells assigned to several pbblocks that can be placed far apart? (PBLOCKS)
  - Are the cells placed far apart? (BOUNDING_BOX_SIZE, CLOCK_REGION_DISTANCE)
  - For SSI devices, are there nets crossing SLR boundaries? (SLR_CROSSINGS)
  - Are one or several net delay values a lot higher than expected while the placement seems correct? See the congestion section below.
Chapter 7: Design Analysis Techniques

- Missing pipeline register in a RAMB or DSP cell (when present in the path)
  - See the COMB_DSP, MREG, PREG, DOA_REG and DOA_REG values
- High skew (<-0.5ns for setup and >0.5ns for hold) (SKEW)
  - Is it a clock domain crossing path? (STARTPOINT_CLOCK and ENDPOINT_CLOCK)
  - Are the clocks synchronous or asynchronous? (CLOCK_RELATIONSHIP)
  - Is the path crossing IO columns? (IO_CROSSINGS)

For visualizing the details of the timing paths and their placement/routing in the Vivado IDE, you must use the following command:

```
report_timing -max_paths 50 -setup -input_pins -name worstSetupPaths
```

The paths are sorted by slack and appear in the same order as in the Setup Path Characteristics table (Figure 7-1, page 174).

The `report_design_analysis` command also generates a Logic Level Distribution table for the worst 5000 paths that you can use to identify the presence of longer paths in the design. The longest paths are usually optimized first by the placer in order to meet timing, which will potentially degrade the placement quality of shorter paths. You must always try to eliminate the longer paths to improve the overall QoR. Figure 7-2 shows an example of the Logic Level Distribution for a design with only one clock.

2. Logic Level Distribution

```
| End Point Clock | 0 | 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8 | 9 | 10 | 11-15 | 16-20 | 21-25 | 26-30 | 31-
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>clk_out1_core_mfr_a</td>
<td>4144</td>
<td>535</td>
<td>353</td>
<td>25</td>
<td>11</td>
<td>24</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>
```

* Columns represent the logic levels per end point clock

** Distribution is for top worst 5000 paths

*Figure 7-2: Logic Level Distribution Table*

Based on what you find, you can improve the netlist by changing the RTL or using different synthesis options, or you can modify the timing and physical constraints.
Chapter 7: Design Analysis Techniques

3. Placed Tile Based Congestion Metric (Vertical)

<table>
<thead>
<tr>
<th>Tile Name</th>
<th>RPMX</th>
<th>RPHY</th>
<th>Congestion in Window (%)</th>
<th>Modules Names</th>
</tr>
</thead>
<tbody>
<tr>
<td>CLEL_L_X50Y350</td>
<td>298</td>
<td>569</td>
<td>52</td>
<td>sched_top_gen[3], sched_top_inst[100%],</td>
</tr>
<tr>
<td>CLEL_R_X59Y205</td>
<td>335</td>
<td>720</td>
<td>51</td>
<td>sched_top_gen[2], sched_top_inst[100%],</td>
</tr>
<tr>
<td>CLEL_R_X59Y206</td>
<td>335</td>
<td>719</td>
<td>51</td>
<td>sched_top_gen[2], sched_top_inst[100%],</td>
</tr>
<tr>
<td>CLEL_L_X50Y361</td>
<td>298</td>
<td>568</td>
<td>50</td>
<td>sched_top_gen[3], sched_top_inst[100%],</td>
</tr>
<tr>
<td>CLEL_L_X50Y363</td>
<td>298</td>
<td>566</td>
<td>49</td>
<td>sched_top_gen[3], sched_top_inst[100%],</td>
</tr>
<tr>
<td>CLEL_R_X59Y204</td>
<td>335</td>
<td>721</td>
<td>49</td>
<td>sched_top_gen[2], sched_top_inst[100%],</td>
</tr>
<tr>
<td>CLEL_L_X60Y206</td>
<td>336</td>
<td>719</td>
<td>48</td>
<td>sched_top_gen[2], sched_top_inst[100%],</td>
</tr>
<tr>
<td>CLEL_R_X67Y070</td>
<td>322</td>
<td>199</td>
<td>48</td>
<td>sched_top_gen[5], sched_top_inst[100%],</td>
</tr>
<tr>
<td>CLEL_R_X66Y090</td>
<td>322</td>
<td>197</td>
<td>48</td>
<td>sched_top_gen[5], sched_top_inst[100%],</td>
</tr>
<tr>
<td>CLEL_L_X50Y362</td>
<td>298</td>
<td>567</td>
<td>47</td>
<td>sched_top_gen[2], sched_top_inst[100%],</td>
</tr>
</tbody>
</table>

4. Placed Tile Based Congestion Metric (Horizontal)

<table>
<thead>
<tr>
<th>Tile Name</th>
<th>RPMX</th>
<th>RPHY</th>
<th>Congestion in Window (%)</th>
<th>Modules Names</th>
</tr>
</thead>
<tbody>
<tr>
<td>CLEL_R_X0Y800</td>
<td>297</td>
<td>103</td>
<td>60</td>
<td>sched_top_gen[4], sched_top_inst[100%],</td>
</tr>
<tr>
<td>CLEL_R_X0Y210</td>
<td>338</td>
<td>714</td>
<td>58</td>
<td>sched_top_gen[2], sched_top_inst[100%],</td>
</tr>
<tr>
<td>CLEL_R_X5Y800</td>
<td>313</td>
<td>103</td>
<td>53</td>
<td>sched_top_gen[4], sched_top_inst[100%],</td>
</tr>
<tr>
<td>CLEL_L_X50Y200</td>
<td>298</td>
<td>103</td>
<td>52</td>
<td>sched_top_gen[2], sched_top_inst[100%],</td>
</tr>
<tr>
<td>CLEL_L_X0Y210</td>
<td>298</td>
<td>714</td>
<td>50</td>
<td>sched_top_gen[2], sched_top_inst[100%],</td>
</tr>
<tr>
<td>CLEL_R_X1Y250</td>
<td>347</td>
<td>714</td>
<td>49</td>
<td>sched_top_gen[2], sched_top_inst[100%],</td>
</tr>
<tr>
<td>CLEL_R_X0Y805</td>
<td>288</td>
<td>98</td>
<td>49</td>
<td>sched_top_gen[4], sched_top_inst[100%],</td>
</tr>
<tr>
<td>CLEL_R_X5Y905</td>
<td>335</td>
<td>719</td>
<td>48</td>
<td>sched_top_gen[2], sched_top_inst[100%],</td>
</tr>
<tr>
<td>CLEL_R_X59Y206</td>
<td>335</td>
<td>720</td>
<td>48</td>
<td>sched_top_gen[2], sched_top_inst[100%],</td>
</tr>
<tr>
<td>CLEL_R_X47Y805</td>
<td>286</td>
<td>98</td>
<td>48</td>
<td>sched_top_gen[4], sched_top_inst[100%],</td>
</tr>
</tbody>
</table>

Figure 7-3: Estimated Congestion Tables

The names provided for the Module Names correspond to the hierarchical cells present in each reported Tile. You can retrieve the complete name using the following command:

```
get_cells –hier <moduleName>
```

Once the hierarchical cells present in the congested area are identified, you can use congestion alleviating techniques to try reducing the overall design congestion.
Using the Elaborated View to Optimize the RTL

When analyzing the timing results after any implementation step with `report_timing`, `report_timing_summary` or `report_design_analysis`, you must review the structure of critical paths to understand if they can be mapped to logic primitives more efficiently by modifying the RTL, using synthesis attributes, or using different synthesis options. This is especially important for paths with high number of logic levels, which stress the implementation tools and limit the overall design performance.

Whenever you find a critical path with a high number of logic levels, you must question whether the functionality of the path requires so many logic levels or not. It is usually not easy to determine the optimal number of logic levels because it depends on your knowledge of the design and your knowledge of RTL optimization in general. It is a complex task to look at the post-synthesis optimized netlist and identify where the problem comes from in the RTL and how to improve it.

In project mode, the Vivado IDE helps simplifying the analysis by providing a powerful cross-probing mechanism between the synthesized or implemented design and the elaborated design. Do the following to cross-probe the synthesized/implemented design and the elaborated design:

1. Open both the synthesized/implemented design and the elaborated design in memory.
2. Select the timing path in the synthesized/implemented design view and show its schematics by pressing the F4 key.
3. Select the Elaborated Design in the Flow Navigator pane. The RTL cells that correspond to the timing path are also selected, so that you can open the RTL schematics (by pressing the F4 key) to view the same path in the elaborated view or trace from the endpoint pin back to the startpoint cell.
4. Review the RTL logic traversed by the path, especially the size of the operators or vectors.
Example

Let's take a small example where the user has written a counter as follows:

```vhdl
signal cnt : integer := 0;

process (clk)
begin
  if(clk'event and clk = '1') then
    if(cnt = 16) then
      cnt <= 0;
    else
      cnt <= cnt + 1;
    end if;
    if(cnt = 8) then
      dout <= din0;
    else
      dout <= din1;
    end if;
  end if;
end process;
```

The signal `cnt` counts from 0 to 16, which requires a 5-bit vector to encode. The post-route critical schematics is shown in Figure 7-5. The endpoint is the bit 30 of the `cnt` signal.

![Simple Counter VHDL Example](X-Ref Target - Figure 7-4)

![cnt Counter Post-Route Critical Path Schematic](X-Ref Target - Figure 7-5)
After selecting the startpoint and endpoint cells of the critical path, you can visualize the equivalent path in the elaborated view by opening a schematics of the selected cells and expanding the logic from the endpoint pin back to the startpoint, as shown in Figure 7-6.

The elaborated view shows that the adder-input has been sized to 32 bit, because the signal `cnt` is declared as an integer. In this particular example, the 32-bit operator is retained throughout the synthesis optimizations. The elaborated view gives a good hint of what is happening and you can change the RTL as follows in order to get a better optimized netlist and timing QoR. As the counter increments from 0 to 16, you can define a range for the signal `cnt` which forces the adder-inputs to be 5-bit wide instead of 32-bit wide.

```vhdl
signal cnt : integer range 0 to 16 := 0;

process (clk)
begin
  if(clk'event and clk = '1') then
    if(cnt = 16) then
      cnt <= 0;
    else
      cnt <= cnt + 1;
    end if;
    if(cnt = 8) then
dout <= din0;
else
dout <= din1;
end if;
end if;
end process;
```

Figure 7-7: Simple Counter VHDL example with Integer Range
The change made to the RTL code will subsequently impact the synthesis optimization, which you can verify using the elaborated view instead of going through the entire compilation flow:

![Diagram of cnt Counter in the Elaborated View after RTL improvement](image)

**Figure 7-8: cnt Counter in the Elaborated View after RTL improvement**

## Identifying the Longest Logic Delay Paths in the Design

Timing paths correspond to logical paths in the design. Their delay is the accumulation of cell delays and net delays. The Vivado synthesis and implementation tools are timing-driven and work on optimizing the worst violating paths of your design throughout the compilation flow. If accumulated cell delay for a path is equal to or higher than the timing requirement (for example, usually the clock period of the path), the design is unlikely to meet timing after implementation. Analyzing the logic delay is better than simply counting logic levels, because it shows what the worst paths are before estimated or routed net delays become a factor. The result of this analysis is a list of the worst timing paths before placement and routing, and without net delay.

It is important to identify the paths that are the worst in terms of timing and not necessarily levels of logic. For example, unregistered block RAM have very large clock to out delay, while a series of carry chains may have multiple levels of levels of logic, each with a small delay.

You must analyze these paths carefully before implementation. There are three typical categories for these long delay paths:

- block RAMs that do not take advantage of the embedded output register
- DSP48s that are not pipelined
- Long logic paths
Chapter 7: Design Analysis Techniques

The most efficient method of identifying these long paths is to run a timing report post synthesis with the routing estimates set to none. This can be done by changing the Interconnect model to none in the Timer Settings tab of the Vivado IDE Timing Report dialog box, or by using the following Tcl command in the Tcl console or shell:

```
set_delay_model -interconnect none
```

Review the timing results to identify any failing paths. If there are paths that fail to meet timing without any routing delay, these paths will be impossible to meet timing with actual routing. These paths MUST be addressed immediately. Typically, these would have to be fixed in RTL, but the violations could also be due to missing synthesis attributes, or incorrect timing constraints. After implementing the changes, the design will have sufficient slack as shown in Figure 7-9.

Identifying High Fanout Net Drivers

High fanout nets often lead to implementation issues. As die sizes increase with each FPGA family, fanout problems also increase. It is often difficult to meet timing on nets that have many thousands of endpoints, especially if there is additional logic on the paths, or if they are driven from non-sequential cells, such as LUTs or distributed RAMs.

Many times, designers address the high fanout nets in RTL and synthesis, but, if not, `phys_opt_design` also can help alleviate timing issues caused by fanout. It is important to look at the list of high fanout signals post synthesis as well as post physical optimization (`phys_opt_design`). The command to identify these nets is `report_high_fanout_nets`.

Once the report has been generated, the timing through the high fanout nets and corresponding schematic can be reviewed. This report does not list clocks as the high fanout driver. If a BUFG is in the Driver Type column, this BUFG is driving logic and not clock pins.
### Report the high fanout net
```
report_high_fanout_nets -load_types -max_nets 100
```
### Report timing through specific high fanout net
```
report_timing -through [get_nets I_GLOBAL_RST_N_i] -name high_fanout_1
```

Following is an example of a design in which `phys_opt_design` was able to reduce the fanout:

Post Place Checkpoint: `report_high_fanout_nets`

<table>
<thead>
<tr>
<th>Fanout</th>
<th>Driver Type</th>
<th>Net Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>2945</td>
<td>FOUT</td>
<td>u_WR_RRH_4x4_BO_OXu_DD/G/doc_4x80mhz_8ch_tie_10_x0/ch_filt_d96363fa22/ch_filt/fp_cmplr_v0.v.2.15</td>
</tr>
</tbody>
</table>

**TIP:** Use of `-timing` and `-load_types` option with the `report_high_fanout_nets` command also shows the delay and the various types of loads for the high-fanout nets.

The Timing Report for that net post physical optimization is:

![Timing Report Example](image)

**Figure 7-10: Timing Report Example**

The fanout on that particular net was reduced from 2945 down to 464. More importantly, the reduction in fanout improved the timing (on this particular path the improvement was over 1 ns).

The FLAT_PIN_COUNT property of each net indicates the number of leaf cells connected to this net throughout the design hierarchy. Use the `get_property` command to extract the FLAT_PIN_COUNT property:
```
get_property FLAT_PIN_COUNT [get_nets my_hfn]
```

**TIP:** You can use Tcl scripting to create additional reports for the paths that propagate through any particular high fanout net.
Determining if Hold-Fixing is Negatively Impacting the Design

The Vivado Design Suite router prioritizes fixing hold over setup. This is because your design may work in the lab if you are failing setup by a small amount. There is always the option of lowering the clock frequency. If you have hold violations, the design will most likely not work.

In most cases, the router can meet the hold timing without affecting the setup. In some cases (mostly due to errors in the design or the constraints), the setup time will be significantly affected. Improper hold checks are often caused by improper set_multicycle_path constraints in which the -hold was not specified. In other cases, large hold requirements are due to excessive clock skew. In this case, Xilinx recommends that you review the clocking architecture for that particular circuit. For more information, see this link in the UltraFast Design Methodology Guide for the Vivado Design Suite (UG949) [Ref 5].

This may occur if your design meets setup timing post placement, but fails setup post route.

**TIP:** Analyze the estimated hold timing post place and identify any unusually large hold violations (over 500ps).

If you suspect that hold fixing is affecting timing closure, you can use one of the following to determine if this is the case:

- **Method 1: Routing without hold fixing**
- **Method 2: Run report_timing -min on Worst Failing Setup Path**

**Method 1: Routing without hold fixing**

1. Read the post-placed checkpoint into Vivado Design Suite.
2. Add a constraint to disable all hold checking:
   
   ```
   set_false_path -hold -to [all_clocks]
   ```

   **CAUTION!** This constraint is for test purposes only. Never do this for designs that will be put into production or delivered to another designer. You must remove this constraint before the production design.

3. Run `route_design` and `report_timing_summary`.

If there is a significant difference between the WNS with and without the hold checks, the hold violations might be too large, and the setup paths are being affected.
Method 2: Run `report_timing -min` on Worst Failing Setup Path

To determine whether the worst failing setup path is due to hold fixing, review the hold timing of that path. In the Vivado IDE, right click and report timing on source to destination. As opposed to doing the setup timing analysis, it is important to look at the hold timing. Once you have the hold report, verify the requirement and ensure that additional delay was not added on the path to be able to meet hold.

![Running Timing Report on Specific Paths](image)

*Figure 7-11: Running Timing Report on Specific Paths*
Quickly Analyzing All Failing Paths

The `report_timing_summary` command is a powerful tool for determining all the timing information for your design. Sometimes it is beneficial to simply look at all of the failing paths in a single report. The command below works from the command line or from within the IDE.

```
report_timing -max_paths 100 -slack_less_than 0 -name worse_100_setup
```

**TIP:** When using the IDE, you can export the timing results to a spreadsheet to do more comprehensive analysis of the failing paths.

The command above reports the top 100 failing paths. If there are less than 100 failing paths, only the failing paths are reported because of the `-slack_less_than 0` option. Reviewing the failing paths in a single list helps to quickly identify the order of magnitude differences among the failing paths.

For example, the WNS could be -3ns, which affects a few paths, but then the next WNS in the list could be at -300ps or better.

By default, when you analyze timing failures, you see the single worst timing path per endpoint. There are generally many similar paths for the common failing endpoint.

To review all worst paths for a single endpoint, use the `-nworst` option with the `report_timing` command. For example, run the following command to see all paths leading to the worst case failing endpoint (assuming there are less than 100):

```
report_timing -max_paths 100 -nworst 100
```

Reviewing all the worst paths may yield considerable data. To minimize the amount of data to analyze, you can review only the unique portions of paths by using the `-unique_pins` option with the `report_timing` command. This provides a single path for each unique combination of pins through the timing path. For example:

```
report_timing -max_paths 100 -nworst 100 -unique_pins
```
Appendix A

Additional Resources and Legal Notices

Xilinx Resources

For support resources such as Answers, Documentation, Downloads, and Forums, see Xilinx Support.

Solution Centers

See the Xilinx Solution Centers for support on devices, software tools, and intellectual property at all stages of the design cycle. Topics include design assistance, advisories, and troubleshooting tips.

References

The following Vivado® Design Suite documents provide supplemental material useful with this guide.

9. *7 Series Clocking Resources Guide* (UG472)
10. *All Vivado Design Suite Documentation*
Training Resources

Xilinx provides a variety of training courses and QuickTake videos to help you learn more about the concepts presented in this document. Use these links to explore related training resources:

• [Vivado Design Suite QuickTake Video: UltraFast Vivado Design Methodology for Timing Closure](#)
• [Vivado Design Suite QuickTake Video: Using the Vivado Timing Constraint Wizard](#)
• [Vivado Design Suite QuickTake Video: Advanced Clock Constraints and Analysis](#)
• [Vivado Design Suite QuickTake Video: Analyzing Implementation Results](#)
• [Vivado Design Suite QuickTake Video: Running Design Rule Checks (DRCs) in Vivado](#)
• [Vivado Design Suite QuickTake Video: Timing Analysis Controls](#)
• [Vivado Design Suite QuickTake Video: Vivado Timing Closure Techniques - Physical Optimization](#)
• [Vivado Design Suite QuickTake Video: Cross Clock Domain Checking - CDC Analysis](#)
• [Vivado Design Suite QuickTake Video: Design Analysis and Floorplanning with Vivado](#)
• [Vivado Design Suite QuickTake Video Tutorials](#)

Please Read: Important Legal Notices

The information disclosed to you hereunder (the “Materials”) is provided solely for the selection and use of Xilinx products. To the maximum extent permitted by applicable law: (1) Materials are made available “AS IS” and with all faults, Xilinx hereby DISCLAIMS ALL WARRANTIES AND CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether in contract or tort, including negligence, or under any other theory of liability) for any loss or damage of any kind or nature related to, arising under, or in connection with, the Materials (including your use of the Materials), including for any direct, indirect, special, incidental, or consequential loss or damage (including loss of data, profits, goodwill, or any type of loss or damage suffered as a result of any action brought by a third party) even if such damage or loss was reasonably foreseeable or Xilinx had been advised of the possibility of the same. Xilinx assumes no obligation to correct any errors contained in the Materials or to notify you of updates to the Materials or to product specifications. You may not reproduce, modify, distribute, or publicly display the Materials without prior written consent. Certain products are subject to the terms and conditions of Xilinx’s limited warranty, please refer to Xilinx’s Terms of Sale which can be viewed at [http://www.xilinx.com/legal.htm#tos](http://www.xilinx.com/legal.htm#tos); IP cores may be subject to warranty and support terms contained in a license issued to you by Xilinx. Xilinx products are not designed or intended to be fail-safe or for use in any application requiring fail-safe performance; you assume sole risk and liability for use of Xilinx products in such critical applications, please refer to Xilinx’s Terms of Sale which can be viewed at [http://www.xilinx.com/legal.htm#tos](http://www.xilinx.com/legal.htm#tos).

© Copyright 2012-2015 Xilinx, Inc. Xilinx, the Xilinx logo, Artix, ISE, Kintex, Spartan, Virtex, Vivado, Zynq, and other designated brands included herein are trademarks of Xilinx in the United States and other countries. All other trademarks are the property of their respective owners.